
P. 1

Table of Contents
Team Collaboration Guide ................................................................................................................................................. 2

01 Part I : Introduction to Team Collaboration ..............................................................................................................  2
01. Introduction to Team Collaboration ...................................................................................................................... 3

02 Part II : Visual Paradigm Online ...............................................................................................................................  5
01. Introducing Visual Paradigm Online ..................................................................................................................... 6
02. Subscribing to VP Online ..................................................................................................................................... 8
03. Administration .....................................................................................................................................................  13

03 Part III: Teamwork Server Guide (on-premises) configuration ...............................................................................  71
01. Introducing Teamwork Server ............................................................................................................................  72
02. Installation and Uninstallation ............................................................................................................................  75
03. Server administration .........................................................................................................................................  79
04. Starting and stopping server ............................................................................................................................  135
05. Installing Windows service ...............................................................................................................................  138
06. Upgrading to new version ................................................................................................................................  143

04 Part IV: Client operations .....................................................................................................................................  146
01. Client operations ..............................................................................................................................................  147

05 Part V: PostMania ................................................................................................................................................. 164
01. PostMania Overview and Setup ....................................................................................................................... 165
02. PostMania - Member Guide .............................................................................................................................  169
03. PostMania - Viewer Guide ...............................................................................................................................  186

06 Part VI: Tasifier ..................................................................................................................................................... 198
01. Introducing Tasifier ........................................................................................................................................... 199
02. Account and Profile ..........................................................................................................................................  204
03. Project ..............................................................................................................................................................  209
04. Task Pool .........................................................................................................................................................  214
05. Task .................................................................................................................................................................. 228
06. My Tasks ..........................................................................................................................................................  260
07. Inbox ................................................................................................................................................................. 265
08. Due date and overdue .....................................................................................................................................  268
09. Tag ...................................................................................................................................................................  276
10. Tools ................................................................................................................................................................. 286
11. Tasifier in Visual Paradigm ..............................................................................................................................  289



Introduction to Team Collaboration P. 2

Introduction to Team Collaboration
 

Visual Paradigm Team Collaboration Guide trademark disclaimer

A list of trademarks to use in the Visual Paradigm Team Collaboration Guide, as well as their owners. This list is subject to change without notice.

 

Overview of Visual Paradigm's team collaboration support

Visual Paradigm allows you to keep your work in a central repository. It also supports the sharing of design and task management. You will learn more
in this article.
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Visual Paradigm Team Collaboration Guide trademark disclaimer
Product names, logos, brands and other trademarks refer to within Visual Paradigm's products and services and within visual-paradigm.com are the
property of their respective trademark holders. These trademark holders are not affiliated with Visual Paradigm International, our products, or our
website. They do not sponsor or endorse our materials. Below is a partial listing of these trademarks and their owners. This list is subject to change
without notice.

• ActionScript is a trademark of Adobe Systems Inc.

• Android is a trademark of Google Inc.

• ArchiMate is a trademark of The Open Group.

• BPMN, CORBA and UML are trademarks of the Object Management Group

• C#, C++, MS SQL Server, Microsoft Windows, Microsoft Visio, VB.NET and Visual Studio are trademarks of Microsoft Corporation.

• Cache is a trademark of InterSystems Corporation.

• Cloudscape, DB2, Informix and Rhapsody are trademarks of International Business Machines Corporation.

• Derby is a trademark of the Apache Software Foundation.

• Eclipse is a trademark of Eclipse Foundation, Inc.

• Erwin is a trademark of CA Inc.

• Firebird is a trademark of Firebird Foundation Inc.

• FrontBase is a trademark of FrontBase Inc.

• H2 is a trademark of H2, Inc.

• Hibernate is a trademark of Red Hat, Inc.

• HSQL is a trademark of the hsql Development Group.

• IntelliJ IDEA is a trademark of JetBrains.

• Ingres is a trademark of Actian Corporation.

• iPad and iPhone are trademarks of Apple Inc.

• Java, MySQL and Oracle are trademarks of Oracle Corporation.

• NetBeans is a trademark of Sun Microsystems, Inc.

• Objective-C is a trademark of Stepstone Corporation

• OpenEdge is a trademark of Progress Software Corporation.

• Perl is a trademark of The Perl Foundation.

• PHP is a trademark of The PHP Group.

• PostgreSQL is a trademark of the PostgreSQL Global Development Group.

• Python is a trademark of the Python Software Foundation

• SQLite is a trademark of Hipp, Wyrick & Company, Inc.

• Sybase ASE are Sybase SQL Anywhere are trademarks of Sybase Inc.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Overview of Visual Paradigm's team collaboration support

Key features

Central repository of design
Keep and manage your projects as well as the related reference files (known as Teamwork Files) in a central repository.

Keep revisions for your work
Whenever a team member has performed a 'commit', a new 'revision' is created and stored in the repository. You can easily browse or restore from
your work done earlier.

Work collaboratively and concurrently
When several team members need to work on the same project, version control is always a major concern. The time and effort spent on merging
the works of each team member is very expensive, and is very risky that the previous works may be overwritten by the new changes. Our teamwork
mechanism helps merge changes made by team members. Whenever contradicted changes are made by two members, you will be prompted for a
resolution.

Share your design with business stakeholders
The PostMania feature allows you to share diagram online. You can share your business design with business stakeholder, or to put your database
design online so that developers can read it as a reference in system development.

Tasifier
Create tasks and keep track of the progress of project with Tasifier, a task management tool.

Cloud base vs Self-hosted (On premise)
Visual Paradigm's team collaboration support comes with two options - cloud and self-hosted. They differ in the way how your work is stored. By
connecting to Visual Paradigm Online, your work will be stored securely in our cloud repository. You can access your work any time and anywhere that
has an active Internet connection. The self-hosted solution allows you to host our server and repository at your site locally. This option is welcomed by
many enterprise.

In this guide there are separate parts and chapters for VPository and Teamwork Server.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Introducing Visual Paradigm Online
Visual Paradigm Online ("VP Online") is a cloud-based collaboration platform for you to store your Visual Paradigm projects online. Learn more about
Visual Paradigm Online in this chapter.

 

Introducing Team Collaboration with VP Online

Visual Paradigm Online - Cloud-based collaboration platform for you to store your software designs online. Learn what VPository is.
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Introducing Team Collaboration with VP Online
The Visual Paradigm product family has two main products: Visual Paradigm and Visual Paradigm Online ("VP Online"). Visual Paradigm is a
traditional desktop application that can be downloaded and run in your operating system, while Visual Paradigm Online is a modern zero-configuration
service that runs on a web browser.

Although the two products are fundamentally different, VP Desktop relies on the web technologies provided by VP Online in order for the team
collaboration features to function. In this article we will have a quick look at these features.

Team collaboration features

Online cloud repository of members and projects
By signing up an VP Online account, your team will be given a cloud-based repository where members and projects are organized and accessible.
Team members can keep their projects and related artifacts in the cloud, and have them accessible any time and from anywhere.

Work collaboratively and concurrently
Team members simply open a project from the cloud repository, start working in Visual Paradigm, and then commit the changes back to the repository,
and that's it. Changes are then accessible to all the other team members. You don't have to maintain any server or remote drive or perform any manual
actions to get works shared among the team. Just have your team focus on their work and let us do everything else for you.

Access globally
Let everyone work on the same project concurrently without overwriting each other works. Access to the most up-to-date design regardless of the team
members' geographic locations.

Share
Get immediate response from clients about the design - your client just need a web browser to post comments and be notified for any updates of the
design.

Safe
Your works are kept in the cloud on revision base. It is easy to recover deleted model elements from an old revisions. We will also backup all your
projects daily to prevent permanent data loss.

Secure
Communications between Visual Paradigm and VP Online are protected by SSL data encryption (same technology as online banks).

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Subscribing to VP Online
Start collaborate and share with your team and client with 1 GB free storage. Learn more about VP Online subscription in this chapter.

 

Signing up an VP Online account from VP Desktop

Sign up Visual Paradigm Online and start team collaboration today. Sign up Free online.

 

Changing Visual Paradigm Online Subscription Plan

Upgrade your current Visual Paradigm Online subscription plan for more storage. VP Online offers three subscription plans, with different amount of
storage available.
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Signing up an VP Online account from VP Desktop
The team collaboration features are supported partly by Visual Paradigm Online ("VP Online"). In order to use the collaboration features, you and your
teammates have to be a member of Visual Paradigm Online.

Read this page to learn how to sign-up VP Online for free.

1. Select Team > Select Repository from the application toolbar.

Teamwork Client login screen

2. Click on Sign up.

3. In the Sign up Visual Paradigm Online window, enter your email address and password. Fill-in the subdomain to complete the Cloud
entry point. Cloud entry point is the URL where you and your teammates can visit to log in to your account. It is unique to your team, so we
recommend you fill in your company or team name here.

Signing up Visual Paradigm Online

4. Read both the terms of service and privacy policy carefully. If you accept, check I agree to Visual Paradigm Online's Terms of Service and
Privacy Policy and click Sign Up.

5. A confirmation email is sent to you and it should arrive within 10 minutes. If you haven't received the email after a good while, please check the
junk folder of your email client. Click on the confirmation link in the email.

Confirm VP Online subscription
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6. A web page is opened, telling you that your account is activated. Enter the name of the repository, which is preferably the name of your
company. Then, enter your name and password. From now on, you can create and manage members and project through the web interface of
Visual Paradigm Online. Project creation can also be done from within Visual Paradigm Desktop.

VP Online account activated

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Changing Visual Paradigm Online Subscription Plan
Visual Paradigm Online comes with 1 GB storage size by default. If you find your account lacks storage space, consider to upgrade your current plan
for more storage space. Listed below are the available subscription plans.

Storage Size Price

Default 1 GB  Free

Value 30 GB  US $129 per month

Deluxe 100 GB  US $229 per month

The various Visual Paradigm Online subscription plans

(For even more storage size, feel free to  contact us  for a tailored option)

To upgrade your subscription plan, perform the steps below.

1. Visit the URL of your VP Online cloud entry point through web browser.

2. Log in your account.

3. Click on your profile image at top right and select Administration from the popup menu.

Open Administration page

4. Select System Tools from the menu on the left.

Opening System Tools page

5. Click on Change Subscription Plan....

Change subscription plan

6. This store page is opened. Click on the Subscribe button on the plan you want to subscribe to.

https://online.visual-paradigm.com/support/
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Subscribe to Value plan

7. This opens the shopping cart page. You may optionally change your name and email address for your customer account, i.e. your account in our
Customer Service Center. Note that you are not allowed to change your VP Online login and cloud entry point.

8. Review your billing information and order. If alright, click on any of the payment methods (2Checkoutout.com, PayPal) and click Check Out
near the bottom of the page. Follow the on-screen instruction to settle your payment. When you finish, your subscription plan will be upgraded
automatically. You do not need to do anything extra.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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VP Online Administration
Learn how to perform administration activities for your Visual Paradigm Online ("VP Online") account.

 

Inspecting storage space usage

Learn how to inspect storage space usage to ensure your team does not exceed the maximum allowed storage.

 

Deleting project

Learn how to delete project to free storage space.

 

Managing members

Learn how to invite members to VP Online.

 

LDAP Authentication

Login Visual Paradigm Online with LDAP credentials. Create users in LDAP and set permissions.

 

Active Directory Authentication

Login VP Onlinewith Active Directory credentials. Create users in Active Directory and set permissions.

 

Setting up  VP Online with Okta

Visual Paradigm Online supports Okta for Enterprise clients. In this article we will go into the details of setting up SAML authentication through Okta.

 

Setting up  VP Online with Microsoft Azure

Visual Paradigm Online supports Microsoft Azure for Enterprise clients. In this article we will go into the details of setting up SAML authentication
through Microsoft Azure.

 

Managing groups

Learn how to create group and add members to it.

 

LDAP Authentication (Groups)

Login Visual Paradigm Online with LDAP credentials. Create users and user groups in LDAP and set permissions.

 

Active Directory Authentication (Groups)

Login Visual Paradigm Online with Active Directory credentials. Create users and user groups in Active Directory and set permissions.

 

Managing projects

Learn how to create projects in VP Online.

 

Setting working days and holidays

Tasifier takes working days and holidays into account. The date picker can indicate those non-working days and holidays as colored cells. In this page
you will learn how to configure working days and holiday profile in VP Online.

 

Setting Default Visibility of Various Panes

Let team members share the same set of visibility of panes. This article shows you how to set default visibility of the four Visual Paradigm panes in VP
Online.
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Inspecting storage space usage
The manager of Visual Paradigm Online ("VP Online") can check the amount of used and remaining storage space to ensure that there is enough
space for a continued project development.

Inspect overall storage space usage
1. Visit the URL of your VP Online cloud entry point through web browser.

2. Log in your account.

3. Click on your profile image at top right and select Administration from the popup menu.

Open Administration page

4. Select System Tools from the menu on the left hand side.

Opening System Tools page

5. Open the Disk Usage tab to view the storage space usage.

Subscription information

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Deleting project
When your Visual Paradigm Online ("VP Online") account has run out of space, you can delete any unneeded project to free storage space. Follow the
instructions below for a deletion.

Note that project deletion is not irreversible. You may also consider upgrading your VP Online subscription plan for more storage.

To delete a project:

1. Visit the URL of your VP Online cloud entry point through web browser.

2. Log in your account.

3. Click on your profile image at top right and select Administration from the popup menu.

Open Administration page

4. Select Projects from the menu on the left.

Open Projects menu

5. Move your mouse pointer over the row of the project that you want to delete, and then click Edit.

To edit a project

6. Click on [Delete Project] at top right.

Delete project

7. You are prompted to answer a math question. Enter the answer and click Delete.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Managing members
A member is someone who has sufficient right to be the server administrator and/or be a general team member who works on a project file. A member
can be assigned to one or more projects, and can be granted the permissions to read and/or update them. Moreover, selected members can be
granted permission to administer (add/edit/remove) members or projects, so that the members can have all or part of the powers of a server manager.

Inviting member
You, as a manager of an Visual Paradigm Online ("VP Online") account, can add your friends or coworkers to VP Online through an 'invitation' process,
to let them create, read and/or modify the projects in your account. To invite member:

1. Visit the URL of your VP Online cloud entry point through web browser.

2. Log in your account.

3. Click on your profile image at top right and select Administration from the popup menu.

Open Administration page

4. Select Members from the menu on the left.

Open Members page

5. Under the Members tab, click on Invite Member.

Invite member

6. In the Invite Teammate screen, enter the name(s) and email address(es) of your teammates and click Send Invitation. Your teammates will
receive an invitation email that invites them to join VP Online. If they accept the invitation (by clicking the confirmation link in the email), they will
become the members of VP Online.
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Invite teammate

 

Editing member
You can edit a member to change his/her name, password and permissions.

1. Visit the URL of your VP Online cloud entry point through web browser.

2. Log in your account.

3. Click on your profile image at top right and select Administration from the popup menu.

4. Select Members from the menu on the left.

5. Move your mouse pointer over the row of member to edit and then click Edit.

Edit a member

6. You may now edit the name, email and password of the member.

7. Switch to the Permissions tab. You may adjust the various permissions granted to this member. This includes the administrator rights
for creating/updating/deleting member and/or project, and the right to perform certain action in Visual Paradigm. The following table lists
permissions you can set.

Option Description

Repository Create project - Project refers to a Visual Paradigm project that is available to be checked out by a
member from client side. The create right enables this member to add a new project into the server. He/she
can create project by creating a blank project, by importing an existing .vpp project file or by importing an
opening project when creating project at client side.
Update project - Enables this member to modify the description, member assignments and granted
permissions of projects.
Delete project - Enables this member to remove a project from server.
Create member - Member is someone who has sufficient right to be the server administrator and/or be a
general team member who works on a project file. The create right enables this member to create members
in server.
Update  member - Enables this member to modify the name, login ID, password, administrator permissions
and project assignments for all members in server.
Manage member groups - A group is a named group of members who who share the same read and/or
commit rights of project(s). By enabling this option, the member will have the right to create/edit/remove
group. Note that removing the group does not remove the member from server.
Manage Just-in-Time work items - The Just-in-Time Process Map of Visual Paradigm (Desktop) provides
users with a gallery of forms and work items to use in process construction. This page is for you to manage
the forms and work items to list in the gallery. By uploading a .dat of forms and/or work items, team
members will be able to access the forms and/or work items in the gallery in developing their Just-in-Time
processes. By enabling this option, the member will be able to add and remove Just-in-Time work items
through the "Just-in-Time Work Items" page on the left.

Access of features The functions member can/cannot perform in Visual Paradigm.
Override the locks applied to elements and diagrams  - When allowed, member can unlock a diagram
locked by anyone, even for diagrams with password protected.
Project options - When allowed, member can modify the configurable options set to projects.
Add and remove referenced projects - When allowed, member can add and remove referenced projects.

Project configuration The functions member can/cannot perform in Visual Paradigm.
Stereotypes (Project-based) - When allowed, member can add, edit and remove stereotypes in projects.
D efault tagged values - When allowed, member can define default tagged values for any type of model
elements.
Requirement types - When allowed, member can add, edit and remove requirement types.
Viewpoints - When checked, member can add, edit and remove viewpoints and stakeholders.
User story statuses  -  When allowed, member can add. edit and remove user story statuses. 

Project management lookups  - When allowed, member can modify the lookup values for project
management properties (e.g. phase, iteration, version, etc).
Business rule keywords - When allowed, member can add, edit and remove business rule keywords.
Design pattern - When allowed, member can synchronize with server the local changes made to design
patterns.
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Doc. Composer element templates - When allowed, member can duplicate and edit Doc Composer
element templates.
Task pool statuses - When allowed, member can configure task pool statuses in Tasifier.

Tag/Branch The functions member can/cannot perform in Visual Paradigm. 
Create tag  - When allowed, member can produce tags from teamwork project.
Create branch - When allowed, member can produce branches from teamwork project.
Merge branch - When allowed, member can merge changes made in branch to trunk, or the other way
round.
Delete branch - When allowed, member can delete any branch.

Options available when adding member

8. Click Save at the top right of page.

9. If you have already added project, you can assign this member to project(s), too. Open the Projects tab. Click Add Project and press + on the
project(s) that the member will involve. Click Close.

10. Decide whether he can read and/or commit changes made in the project. Read access enables opening the project from server and reading its
content. Commit enables uploading project changes from client to server. This step is optional and you can assign member to project in project
management page later on.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Visual Paradigm Online LDAP Authentication
Visual Paradigm Online ("VP Online") supports two ways of authentication - built-in authentication and directory server authentication. While the built-
in authentication allows you to easily set up and manage member accounts completely inside VP Online, active server authentication allows users to
login to VP Online with credentials stored in and managed by a directory server.

In order for directory server authentication to work, administrator has to install a utility called DS Connector, and have it configured to connect both VP
Online and the directory server. DS Connector acts as bridge between VP Online and directory server. It's capable to synchronize user listing from
directory server to VP Online, and to manage the authentication from Visual Paradigm to directory server, through VP Online.

In this page, you will learn how to work with LDAP authentication from creating users in Apache Directory Studio to installing and configuring DS
Connector. If you are interested in working with user group instead of user, please read Visual Paradigm Online LDAP Authentication (Groups). If you
are interested in Active Directory Authentication, please read Visual Paradigm Online Active Directory Authentication.

There are series of steps you need to take in order to make LDAP authentication works. Please read through all the steps below without skipping any
of them, even if you are familiar with LDAP and Apache Directory Studio.

Step 1 - Creating user account in ApacheDS
In this section you will learn how to create user account in ApacheDS using Apache Directory Studio. It's mainly written for people who are not
familiar with ApacheDS. However, even if you are familiar with ApacheDS, be sure to read through the steps as some of the settings will influence the
authentication process.

1. In LDAP Browser, navigate to the ou=users node under DIT > Root DSE > ou=system.

2. Right click on the ou=users node in and select New Entry... from the popup menu.

Adding a new entry via LDAP Browser

3. In the New Entry window, keep Create entry from scratch selected and click Next.

4. You are prompted to enter one structural object for creating the new user. Select inetOrgPerson as the object class

Selected inetOrgPerson

5. Click Add to add inetOrgPerson to the list of selected object classes. You will see a list the object classes from the inetOrgPerson object
hierarchy are being added automatically.
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inetOrgPerson added to the list of selected object classes

6. Click Next.

7. For RDN, enter uid=jdoe, where jdoe is a unique shortname of the user you want to add now.

RDN entered

8. Click Next.

9. Fill in the attributes for jdoe. Enter John Doe as cn.

10. Enter Doe as sn.

cn and sn specified

11. You can optionally add more attributes for this user. In particular, you may want to supply an email for this user. Doing so allows this
user to login to VP Online by entering his/her email address. Without supplying an email, he/she will need to login by entering string like
uid=jdoe,ou=users,ou=system as username. If you want to add the mail attribute, click New Attribute... on top of the table, on the right hand
side. Then, add and fill in the mail attribute. (note: Make sure you've selected the mail attribute, not email/ emailAddress)
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12. Create a password for this user. Click on New Attribute... as shown in the image below. By the way, be sure to set password for users who will
use Visual Paradigm. Users without password won't be able to access the VP Online.

Create an attribute

13. In the New Attribute window, select userPassword as Attribute Type.

Selected userPassword as attribute type

14. Click Finish.

15. Enter the password and click OK.

Password entered

16. Click Finish.

Step 2 - Downloading DS Connector from VP Online
DS Connector acts as a bridge between VP Online and directory server. In this section you will see how to download DS Connector from VP Online.

1. Open a web browser.

2. Visit and login your cloud entry point.

3. Select System Tools from the menu on the left hand side.

4. Open the tab Single Sign-On.

5. Click on Configure under the section Directory Service Connector.

To configure directory service connector

6. Choose the operating system for the machine where Active Directory is installed.
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Choosing the right operating system

7. Click Download. Keep the dialog box opened as you will need to copy the key presented in the dialog box when you configure DS Connector in
the next section.

Step 3 - Installing and configuring DS Connector
In this section you will install DS Connector, and configure it to make it connect to both VP Online and ApacheDS.

1. Copy the downloaded zip file to the machine where ApacheDS is installed.

2. Extract the zip file to a folder.

DS Connector (zip) extracted

3. Open an elevated command prompt.
For Windows Server 2008 users, click the Start button, type cmd, and then right-click Command Prompt and select Run as administrator
from the popup menu.
For Windows Server 2012 users, search cmd in the Apps screen, and then right-click Command Prompt and select Run as administrator at
the bottom of the screen.

Run elevated command prompt

4. Navigate to DS_Connector_12.1\service where DS_Connector_12.1 is the name of the folder extracted.

5. Type the following command to install DS Connector as service:
install_service.bat
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Installing DS Connector as system service

6. Run DS_Connector_12.1\DSConnectorUI.exe. Please run it as administrator to avoid any potential issues caused by insufficient write
permission.

7. When you run DS Connector the first time, you are prompted to configure the connection to VP Online/Teamwork Server. In the Configure
Server window, keep VPository selected.

Configure Server window

8. Fill in the cloud entry point.

9. Enter the key, which is the code you saw in the end of the previous section. If you have accidentally closed that dialog box, or if the key has
expired, don't worry, just click Configure again (step 4 of the previous section) to obtain another key.

Entering key for server configuration

10. Click Connect. If succeed, you should see the message Server configuration succeed.

11. DS Connector is now connected to VP Online. Now, you need to configure the connection to ApacheDS. On the left hand side of the DS
Connector Console, click Add Directory Server.

To add a directory server

12. Select ApacheDS as Directory Server.

Selecting ApacheDS

13. Enter a name for this configuration.
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14. Enter the host name and port of the ApacheDS. As we suggested you to install DS Connector on the machine where ApacheDS is installed,
your host name is pretty likely to be localhost or 127.0.0.1. Regarding the port, while the default port of ApacheDS is 10389, you may need to
confirm it with your administrator in case it has been changed.

15. Enter Bind DN or User. If you use Apache Directory Studio, you can obtain the required value by right clicking on the LDAP connection and
selecting Properties from the popup menu. The Bind DN or user can be found under the Authentication tab.

Obtaining the Bind DN or user from Apache Directory Studio

16. Enter the password for logging into ApacheDS.

Configuring ApacheDS connection

17. Click Test Connection. If succeed, you should see the message Test connection succeed.

18. Click Save in the Configure Directory Server window.

19. The newly configured directory server is listed on the left hand side of the DS Connector Console. If necessary you can add more directory
servers by repeating from step 11 until this step.

Directory server added

Step 4 - Synchronizing users to VP Online
In this section you will add users into DS Connector Console to let it synchronize the users to VP Online. When you finished this section, the chosen
users can login VP Online from Visual Paradigm, using the login details managed by ApacheDS.

1. Select the directory server in DS Connector Console.

Selecting a directory server
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2. On the right hand side, click Add.

3. In the Add users/group window, select the user(s) to be made available on VP Online. The selected users will become members of VP Online ,
and will have access to Visual Paradigm projects.

Select users to add to DS Connector Console

4. Click Add.

5. That's it. You can see the selected users listed on the right hand side of the DS Connector Console.

Users added to DS Connector Console

The name and login ID of the selected users will be synchronized to VP Online shortly (~1 minute). Once the synchronization has been
completed, you will see the users available in the Members page of the VP Online. Note that the synchronization will synchronize only the user
name and login ID. It will not synchronize nor to process any password of any users in ApacheDS. Whenever a user tries to login to VP Online
from Visual Paradigm, VP Online will communicate with ApacheDS for authentication.

Users synchronized from ApacheDS

So now, you assign the users to projects so that they can open the project from Visual Paradigm and start working. If necessary you can also
grant them admin permissions.
To login VP Online from Visual Paradigm, please enter the Email (Login ID) of member as Email (not the display name), and the password
stored in ApacheDS as Password.
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Login from Visual Paradigm

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Visual Paradigm Online Active Directory Authentication
Visual Paradigm Online ("VP Online") supports two ways of authentication - built-in authentication and directory server authentication. While the built-
in authentication allows you to easily set up and manage member accounts completely inside VP Online, active server authentication allows users to
login to VP Online with credentials stored in and managed by a directory server.

In order for directory server authentication to work, administrator has to install a utility called DS Connector, and have it configured to connect both VP
Online and the directory server. DS Connector acts as bridge between VP Online and directory server. It's capable to synchronize user listing from
directory server to VP Online, and to manage the authentication from Visual Paradigm to directory server, through VP Online.

In this page, you will learn how to work with Active Directory authentication from creating users in Apache Directory Studio to installing and configuring
DS Connector. If you are interested in working with user group instead of user, please read Visual Paradigm Online Active Directory Authentication
(Groups). If you are interested in LDAP Authentication, please read VP Online LDAP Authentication.

There are series of steps you need to take in order to make Active Directory authentication works. Please read through all the steps below without
skipping any of them, even if you are familiar with Active Directory.

Step 1 - Creating organization unit and user in Active Directory
1. Start the Server Manager in Windows Server.

2. Click on Tools at top right and select Active Directory Administrative Center from the popup menu.

Open Active Directory Administrative Center

3. Select your domain from the list on the left hand side.

Select domain

4. Create an Organizational Unit to house your corporate users. On the right navigation pane under Task > <domain name> click on New and
then select Organizational Unit.
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Create Organizational Unit

5. Organizational unit is like a company. Enter the mandatory details and click OK.

Filling in the Organizational Unit screen

6. This will immediately create the Organizational Unit in the designated location.  Double click on your newly created Organizational Unit.

Double click on an Organization Unit to edit it

7. On the right navigation pane, click on New, and then select User from the popup menu.
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Create user

8. Enter the mandatory details such as user&rsquo;s name.

Filling in the User screen

9. Enter the password for the user.

10. Change the Password options to Other password options. If you don't do this, you won't be able to login with this user account from Visual
Paradigm products.

Change to Other password options

11. Click OK. Repeat step 7 to step 10 to create all users in Active Directory.

Step 2 - Downloading DS Connector from VP Online
DS Connector acts as a bridge between VP Online and directory server. In this section you will see how to download DS Connector from VP Online.

1. Open a web browser.

2. Visit and login your cloud entry point.

3. Select System Tools from the menu on the left hand side.

4. Open the tab Single Sign-On.

5. Click on Configure under the section Directory Service Connector.
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To configure directory service connector

6. Choose the operating system for the machine where Active Directory is installed.

Choosing the right operating system

7. Click Download. Keep the dialog box opened as you will need to copy the key presented in the dialog box when you configure DS Connector in
the next section.

Step 3 - Installing and configuring DS Connector
In this section you will install DS Connector, and configure it to make it connect to both VP Online and Active Directory.

1. Copy the downloaded zip file to the machine where Active Directory is installed.

2. Extract the zip file to a folder.

DS Connector (zip) extracted

3. Open an elevated command prompt.
For Windows Server 2008 users, click the Start button, type cmd, and then right-click Command Prompt and select Run as administrator
from the popup menu.
For Windows Server 2012 users, search cmd in the Apps screen, and then right-click Command Prompt and select Run as administrator at
the bottom of the screen.

Run elevated command prompt
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4. Navigate to DS_Connector_12.1\service where DS_Connector_12.1 is the name of the folder extracted.

5. Type the following command to install DS Connector as service:
install_service.bat

Installing DS Connector as system service

6. Run DS_Connector_12.1\DSConnectorUI.exe. Please run it as administrator to avoid any potential issues caused by insufficient write
permission.

7. When you run DS Connector the first time, you are prompted to configure the connection to VP Online/Teamwork Server. In the Configure
Server window, keep VP Online selected.

To configure connection to VP Online

8. Fill in the cloud entry point.

9. Enter the key, which is the code you saw in the end of the previous section. If you have accidentally closed that dialog box, or if the key has
expired, don't worry, just click Configure again (step 4 of the previous section) to obtain another key.

Entering key for server configuration

10. Click Connect. If succeed, you should see the message Server configuration succeed.

11. DS Connector is now connected to VP Online. Now, you need to configure the connection to Active Directory. On the left hand side of the DS
Connector Console, click Add Directory Server.

To add a directory server

12. Select Active Directory as Directory Server.
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Selecting Active Directory

13. Enter a name for this configuration.

14. Enter the host name and port of the Active Directory. As we suggested you to install DS Connector on the machine where Active Directory is
installed, your host name is pretty likely to be localhost or 127.0.0.1. Regarding the port, while the default port of Active Directory is 389, you
may need to confirm it with your administrator in case it has been changed.

15. Enter Bind DN or User. You can check the required value from the Account details page of the administrator user. The value of User
SamAccountName is the value you need to enter now.

Obtaining the Bind DN or user

16. Enter the password for logging into Active Directory.

Configuring Active Directory connection

17. Click Test Connection. If succeed, you should see the message Test connection succeed.

18. Click Save in the Configure Directory Server window.

19. The newly configured directory server is listed on the left hand side of the DS Connector Console. If necessary you can add more directory
servers by repeating from step 11 until this step.
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Directory server added

Step 4 - Synchronizing users to VP Online
In this section you will add users into DS Connector Console to let it synchronize the users to VP Online. When you finished this section, the chosen
users can login VP Online from Visual Paradigm, using the login details managed by Active Directory.

1. Select the directory server in DS Connector Console.

Selecting a directory server

2. On the right hand side, click Add.

3. In the Add users/group window, select the user(s) to be made available on VP Online. The selected users will become members of VP Online,
and will have access to Visual Paradigm projects.

Select users to add to DS Connector Console

4. Click Add.

5. That's it. You can see the selected users listed on the right hand side of the DS Connector Console.

Users added to DS Connector Console

The name and login ID of the selected users will be synchronized VP Online shortly (~1 minute). Once the synchronization has been completed,
you will see the users available in the Members page of VP Online. Note that the synchronization will synchronize only the user name and login
ID. It will not synchronize nor to process any password of any users in Active Directory. Whenever a user tries to login to VP Online from Visual
Paradigm, VP Online will communicate with Active Directory for authentication.

Users synchronized from Active Directory
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So now, you assign the users to projects so that they can open the project from Visual Paradigm and start working. If necessary you can also
grant them admin permissions.
To login VP Online from Visual Paradigm, please enter the Email(Login ID) as shown in the image above as Email, and the password stored in
Active Directory as Password.

Login from Visual Paradigm

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/technicalsupport.jsp?product=vpts
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Setting up Visual Paradigm Online with Okta
Visual Paradigm Online ("VP Online") supports Okta for Enterprise clients. In this article we will go into the details of setting up SAML authentication
through Okta. Although this is specific to Okta the concepts could be adapted to any other SAML Identity Provider.

Step 1 - Setting up Okta
In this section you will learn how to create a new application integration in Okta.

1. Part of the setup of Okta requires providing details given by VP Online. So now, open a web browser and login VP Online as manager.

2. Click on your logo at the top right of the page and then select Administration from the drop down menu.

3. Select System Tools from the menu on the left hand side.

4. Open the Single Sign-On tab and keep it opened. We will come back later.

The Single Sign-On page of VP Online

5. Open another tab/window in the web browser and visit Okta.

6. Create a new application integration in Okta. Select SAML 2.0 as sign-on method.

Creating an application with SAML 2.0 as sign on method

7. Enter VPository as the name of application. Click Next.

Entering application name



Setting up VP Online with Okta P. 35

8. Fill-in the SAML settings. Copy the value of Single Sign-on (ASC) URL from VP Online to Okta as the Single sign on URL, and then copy the
value of Audience URI (SP Entity ID) from VP Online to Okta.

Filling in SAML settings

9. Click Next.

10. Select I'm an Okta customer adding an internal app and then click Finish.

Choosing identity

11. Download the Identity Provider metadata under the Sign On tab.
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Download Identity Provider metadata

12. Open the People tab.

13. Click Assign to People and then assign the application to people who will use VP Online. Doing so does not instantly grant those people the
accessibility to VP Online. You still have to go through the process of inviting them to VP Online, which will be mentioned in the next section.

Assigning VPository (application) to people

14. Click Done when finished.

Step 2 - Setting up VP Online
1. Go back to VP Online. You should be opening the Single Sign-On tab of the System Tools page. Now, enter Okta as the Identity Provider

(IDP) Name.
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IDP name entered

2. In the IDP metadata field, upload the Identity Provider metadata file downloaded in the previous section.

IDP metadata uploaded

3. Click Apply.

4. Click OK when you are prompted for confirmation. If sign-in success, you will be logged out automatically. If failed, please make sure the
VPository application has been assigned to you in Okta, and try again.

5. From now on, VP Online is integrated with Okta. You, as the manager can access VP Online with your Okta account and perform administration
and management tasks. Team members, once being invited and have accepted the invitations, can login VP Online from Visual Paradigm with
their Okta account.

Login with Okta

Step 3 - Member management
Since the integration with Okta, in order for someone to become a VP Online member, he/she has to:

1. Be a person who have been assigned the VP Online application in Okta and,

2. Have accepted the invitation sent from VP Online manager.

The first point has been covered in step 1 above. In this section we are going to show you how to invite a member.

1. Open a web browser and login VP Online as manager.
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2. Click on your logo at the top right of the page and then select Administration from the drop down menu.

3. Select Members from the menu on the left hand side.

4. Under the Members tab, click Invite Member.

Invite member

5. Enter the name and email of the members. Make sure you have already assigned the VPository application to them in Okta. If not, they won't be
able to access any projects. Click Send Invitation.

Send invitation

6. The invitee will receive an invitation shortly. Click on the activation link in the email.

To activate VP Online account

7. He/she will be redirected to a web page where he/she can fill in his name. Enter the name and click Activate with Okta.
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Activating VP Online account

If success, he will see the Congratulations screen. From now on, he/she can access VP Online from Visual Paradigm with his/her Okta
account.

Activation success

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• User's Guide: Setting up VP Online with Azure

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Setting up Visual Paradigm Online with Microsoft Azure
Visual Paradigm Online ("VP Online") supports Microsoft Azure for Enterprise clients. In this article we will go into the details of setting up SAML
authentication through Microsoft Azure. Although this is specific to Microsoft Azure the concepts could be adapted to any other SAML Identity Provider.

Step 1 - Setting up Microsoft Azure
In this section you will learn how to create a new application integration in Microsoft Azure.

1. Part of the setup of Microsoft Azure requires providing details given by VP Online. So now, open a web browser and login VP Online as
manager.

2. Click on your logo at the top right of the page and then select Administration from the drop down menu.

3. Select System Tools from the menu on the left hand side.

4. Open the Single Sign-On tab and keep it opened. We will come back later.

The Single Sign-On page of VP Online

5. Open another tab/window in the web browser and visit Microsoft Azure.

6. Create a new application in Azure. Name it VPository. Click Next.

Creating application VPository

7. Fill-in the App properties. Copy the value of Single Sign-on (ASC) URL from VP Online to Microsoft Azure as the SIGN-ON URL, and then
copy the value of Audience URI (SP Entity ID) from VP Online to Azure as APP ID URL.
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Filling in App properties

8. Click Complete.

9. Click VIEW ENDPOINTS at the bottom of the screen.

Clicking on View Endpoints

10. Copy the URL of FEDERATION METADATA DOCUMENT. Visit the URL and save the XML content to a new file.

To open the URL of metadata

11. Open the CONFIGURE page.

Configure server

12. Choose Yes for the option USER ASSIGNMENT REQUIRED TO ACCESS APP.
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Enable the requirement of user assignment to acces app

13. Click SAVE at the bottom of the screen to save the changes.

Save changes

14. Open the USERS AND GROUPS page.

Opening Users and Groups page

15. Select the person who will use VP Online.

Selecting people to assign

16. Click ASSIGN at the bottom of the screen. Select YES for confirmation. Note that the assignment does not instantly grant this person
accessibility to VP Online . You still have to go through the process of inviting him/her to VP Online, which will be mentioned in the next section.

User assignment

17. Repeat the assignment process on other people who need to access VP Online.

Step 2 - Setting up VP Online
1. Go back to VP Online. You should be opening the Single Sign-On tab of the System Tools page. Now, enter Azure as the Identity Provider

(IDP) Name.

IDP name entered

2. In the IDP metadata field, upload the metadata file saved in the previous section.
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IDP metadata uploaded

3. Click Apply.

4. Click OK when you are prompted for confirmation. If sign-in success, you will be logged out automatically. If failed, please make sure the
VPository application has been assigned to you in Microsoft Azure, and try again.

5. From now on, VP Online is integrated with Microsoft Azure. You, as the manager can access VP Online with your Microsoft Azure account and
perform administration and management tasks. Team members, once being invited and have accepted the invitations, can login VP Online from
Visual Paradigm with their Microsoft Azure account.

Login with Microsoft Azure

Step 3 - Member management
Since the integration with Microsoft Azure, in order for someone to become a VP Online member, he/she has to:

1. Be a person who have been assigned the VPository application in Microsoft Azure and,

2. Have accepted the invitation sent from VP Online manager.

The first point has been covered in step 1 above. In this section we are going to show you how to invite a member.

1. Open a web browser and login VP Online as manager.

2. Click on your logo at the top right of the page and then select Administration from the drop down menu.

3. Select Members from the menu on the left hand side.

4. Under the Members tab, click Invite Member.

Invite member

5. Enter the name and email of the members. Make sure you have already assigned the VPository application to them in Microsoft Azure. If not,
they won't be able to access any projects. Click Send Invitation.
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Send invitation

6. The invitee will receive an invitation shortly. Click on the activation link in the email.

To activate VP Online account

7. He/she will be redirected to a web page where he/she can fill in his name. Enter the name and click Activate with Azure.

Activating VP Online account

If success, he will see the Congratulations screen. From now on, he/she can access VP Online from Visual Paradigm with his/her Microsoft
Azure account.
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Activation success

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• User's Guide: Setting up VP Online with Okta

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Managing groups
A group is a named category of members in an Visual Paradigm Online ("VP Online") account. It groups members who share the same characteristic
and let them share the same project permission.

Adding group
1. Visit the URL of your VP Online cloud entry point through web browser.

2. Log in your account.

3. Click on your profile image at top right and select Administration from the popup menu.

Open Administration page

4. Select Members from the menu on the left hand side.

Open Members menu

5. Under the Group tab, click on New Group.

6. Enter the name of group.

Entering group name

7. Select members to add into the group. Click Add Members and then press + on the members to add into the group. Click Close when ready.

8. You may optionally assign the group to project(s). Open the Projects tab. Click Add Project and press + on the project(s) for assignments.
Click Close.

9. Decide whether the members in group can read and/or commit changes made in the project. Read access enables opening the project from
server and reading its content. Commit enables uploading project changes from client to server. This step is optional and you can assign
member to project in project management page later on.

10. Click Save.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Visual Paradigm Online LDAP Authentication (Group)
Visual Paradigm Online ("VP Online") supports two ways of authentication - built-in authentication and directory server authentication. While the built-
in authentication allows you to easily set up and manage member accounts completely inside VP Online, active server authentication allows users to
login to VP Online with credentials stored in and managed by a directory server.

In order for directory server authentication to work, administrator has to install a utility called DS Connector, and have it configured to connect both VP
Online and the directory server. DS Connector acts as bridge between VP Online and directory server. It's capable to synchronize user listing from
directory server to VP Online, and to manage the authentication from Visual Paradigm to directory server, through VP Online.

In this page, you will learn how to work with LDAP authentication from creating user groups in Apache Directory Studio to installing and configuring DS
Connector. If you are interested in working with user instead of user group, please read VP Online LDAP Authentication. If you are interested in Active
Directory Authentication, please read Visual Paradigm Online Active Directory Authentication (Groups).

There are series of steps you need to take in order to make LDAP authentication works. Please read through all the steps below without skipping any
of them, even if you are familiar with LDAP and Apache Directory Studio.

Step 1 - Creating user account in ApacheDS
In this section you will learn how to create user account in ApacheDS using Apache Directory Studio. It's mainly written for people who are not
familiar with ApacheDS. However, even if you are familiar with ApacheDS, be sure to read through the steps as some of the settings will influence the
authentication process.

1. In LDAP Browser, navigate to the ou=users node under DIT > Root DSE > ou=system.

2. Right click on the ou=groups node in and select New Entry... from the popup menu.

Adding a new entry via LDAP Browser

3. In the New Entry window, keep Create entry from scratch selected and click Next.

4. You are prompted to enter one structural object for creating the new user. Select groupOfUniqueNames as the object class

Selected groupOfUniqueNames

5. Click Add to add groupOfUniqueNames to the list of selected object classes. You will see a list the object classes from the
groupOfUniqueNames object hierarchy are being added automatically.
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groupOfUniqueNames added to the list of selected object classes

6. Click Next.

7. For RDN, enter cn=developer, where developer is the name of group and you should supply your own group name here - developer is just an
example.

RDN entered

8. Click Next.

9. Add users into this group by creating multiple uniqueMember attributes and entering the DN of those users as attribute values. A
uniqueMember attribute is default created. Enter the first user's DN in the Value cell.

Entering the DN of a user

By the way, be sure to set password for users who will use Visual Paradigm. Users without password won't be able to access the VP Online.
To set a password for a user, select the user node under ou=users in LDAP Browser. Click on New Attribute... in the Entry Editor on the
right hand side. In the New Attribute window, select userPassword to be the Attribute type. Click Finish, enter the password and click OK to
confirm.
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10. Add other users by creating more uniqueMember attributes. To do this, right click on any attribute row in the New Entry window and select
New Attribute... from the popup menu. Then enter uniqueMember in the Attribute type field in the New Attribute window and click Finish.
Finally, specify the DN of that user.

Users added to user group

11. Click Finish.

Step 2 - Downloading DS Connector from VP Online
DS Connector acts as a bridge between VP Online and directory server. In this section you will see how to download DS Connector from VP Online.

1. Open a web browser.

2. Visit and login your cloud entry point.

3. Select System Tools from the menu on the left hand side.

4. Open the tab Single Sign-On.

5. Click on Configure under the section Directory Service Connector.

To configure directory service connector

6. Choose the operating system for the machine where ApacheDS is installed.

Choosing the right operating system

7. Click Download. Keep the dialog box opened as you will need to copy the key presented in the dialog box when you configure DS Connector in
the next section.

Step 3 - Installing and configuring DS Connector
In this section you will install DS Connector, and configure it to make it connect to both VP Online and ApacheDS.
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1. Copy the downloaded zip file to the machine where ApacheDS is installed.

2. Extract the zip file to a folder.

DS Connector (zip) extracted

3. Open an elevated command prompt.
For Windows Server 2008 users, click the Start button, type cmd, and then right-click Command Prompt and select Run as administrator
from the popup menu.
For Windows Server 2012 users, search cmd in the Apps screen, and then right-click Command Prompt and select Run as administrator at
the bottom of the screen.

Run elevated command prompt

4. Navigate to DS_Connector_12.1\service where DS_Connector_12.1 is the name of the folder extracted. Please run it as administrator to
avoid any potential issues caused by insufficient write permission.

5. Type the following command to install DS Connector as service:
install_service.bat

Installing DS Connector as system service

6. Run DS_Connector_12.1\DSConnectorUI.exe.

7. When you run DS Connector the first time, you are prompted to configure the connection to VP Online/Teamwork Server. In the Configure
Server window, keep VPository selected.

Configure Server window

8. Fill in the cloud entry point.

9. Enter the key, which is the code you saw in the end of the previous section. If you have accidentally closed that dialog box, or if the key has
expired, don't worry, just click Configure again (step 4 of the previous section) to obtain another key.
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Entering key for server configuration

10. Click Connect. If succeed, you should see the message Server configuration succeed.

11. DS Connector is now connected to VP Online. Now, you need to configure the connection to ApacheDS. On the left hand side of the DS
Connector Console, click Add Directory Server.

To add a directory server

12. Select ApacheDS as Directory Server.

Selecting ApacheDS

13. Enter a name for this configuration.

14. Enter the host name and port of the ApacheDS. As we suggested you to install DS Connector on the machine where ApacheDS is installed,
your host name is pretty likely to be localhost or 127.0.0.1. Regarding the port, while the default port of ApacheDS is 10389, you may need to
confirm it with your administrator in case it has been changed.

15. Enter Bind DN or User. If you use Apache Directory Studio, you can obtain the required value by right clicking on the LDAP connection and
selecting Properties from the popup menu. The Bind DN or user can be found under the Authentication tab.

Obtaining the Bind DN or user from Apache Directory Studio

16. Enter the password for logging into ApacheDS.
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Configuring ApacheDS connection

17. Click Test Connection. If succeed, you should see the message Test connection succeed.

18. Click Save in the Configure Directory Server window.

19. The newly configured directory server is listed on the left hand side of the DS Connector Console. If necessary you can add more directory
servers by repeating from step 11 until this step.

Directory server added

Step 4 - Synchronizing users to VP Online
In this section you will add users into DS Connector Console to let it synchronize the users to VP Online. When you finished this section, the chosen
users can login VP Online from Visual Paradigm, using the login details managed by ApacheDS.

1. Select the directory server in DS Connector Console.

Selecting a directory server

2. On the right hand side, click Add.

3. In the Add users/group window, select the user groups to be made available on VP Online. The users in selected groups will become members
of VP Online, and will have access to Visual Paradigm projects.
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Select user groups to add to DS Connector Console

4. Click Add.

5. That's it. You can see the selected user groups listed on the right hand side of the DS Connector Console.

Users added to DS Connector Console

The user groups, along with the users will be synchronized to VP Online shortly (~1 minute). Once the synchronization has been completed, you
will see the user groups available in the Members > Groups page of VP Online, like this:

User group synchronized to VP Online

The users are available in the Members page of VP Online. Note that the synchronization will synchronize only the user name and login ID. It
will not synchronize nor to process any password of any users in ApacheDS. Whenever a user tries to login VP Online from Visual Paradigm,
VP Online will communicate with ApacheDS for authentication.

Users synchronized from ApacheDS

So now, you assign the user groups to projects so that the users can open the project from Visual Paradigm and start working. If necessary you
can also grant them admin permissions.
To login VP Online from Visual Paradigm, please enter the Email (Login ID) of member as Email (not the display name), and the password
stored in ApacheDS as Password.

Login from Visual Paradigm
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Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Visual Paradigm Online Active Directory Authentication (Group)
Visual Paradigm Online ("VP Online") supports two ways of authentication - built-in authentication and directory server authentication. While the built-
in authentication allows you to easily set up and manage member accounts completely inside VP Online, active server authentication allows users to
login to VP Online with credentials stored in and managed by a directory server.

In order for directory server authentication to work, administrator has to install a utility called DS Connector, and have it configured to connect both VP
Online and the directory server. DS Connector acts as bridge between VP Online and directory server. It's capable to synchronize user listing from
directory server to VP Online, and to manage the authentication from Visual Paradigm to directory server, through VP Online.

In this page, you will learn how to work with Active Directory authentication from creating user groups in Active Directory to installing and configuring
DS Connector. If you are interested in working with user instead of user group, please read Visual Paradigm Online Active Directory Authentication. If
you are interested in LDAP Authentication, please read Visual Paradigm Online LDAP Authentication (Groups).

There are series of steps you need to take in order to make Active Directory authentication works. Please read through all the steps below without
skipping any of them, even if you are familiar with Active Directory.

Step 1 - Creating organization unit, user and group in Active Directory
1. Start the Server Manager in Windows Server.

2. Click on Tools at top right and select Active Directory Administrative Center from the popup menu.

Open Active Directory Administrative Center

3. Select your domain from the list on the left hand side.

Select domain

4. Create an Organizational Unit to house your corporate users. On the right navigation pane under Task > <domain name> click on New and
then select Organizational Unit.
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Create Organizational Unit

5. Organizational unit is like a company. Enter the mandatory details and click OK.

Filling in the Organizational Unit screen

6. This will immediately create the Organizational Unit in the designated location.  Double click on your newly created Organizational Unit.
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Double click on an Organizational Unit to edit it

7. On the right navigation pane, click on New, and then select User from the popup menu.

Create user

8. Enter the mandatory details such as user&rsquo;s name.

Filling in the User screen

9. Enter the password for the user.

10. Change the Password options to Other password options. If you don't do this, you won't be able to login with this user account from Visual
Paradigm products.

Change Password Option to 'Other password options'

11. Click OK. Repeat step 7 to step 10 to create all users in Active Directory.

12. On the right navigation pane, click on New, and then select Group from the popup menu.
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Create group

13. Enter the mandatory fields such as group name.

Filling in the Group screen

14. Scroll down to the Members section. You can add users into the group in the Members section.

15. Click Add....

Adding member into a group

16. Enter the account name of the user you want to add into the group. Click OK.

Enter user's account name

17. Click OK in the Create Group screen to confirm group creation.

Step 2 - Downloading DS Connector from VP Online
DS Connector acts as a bridge between VP Online and directory server. In this section you will see how to download DS Connector from VP Online.

1. Open a web browser.

2. Visit and login your cloud entry point.

3. Select System Tools from the menu on the left hand side.
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4. Open the tab Single Sign-On.

5. Click on Configure under the section Directory Service Connector.

To configure directory service connector

6. Choose the operating system for the machine where Active Directory is installed.

Choosing the right operating system

7. Click Download. Keep the dialog box opened as you will need to copy the key presented in the dialog box when you configure DS Connector in
the next section.

Step 3 - Installing and configuring DS Connector
In this section you will install DS Connector, and configure it to make it connect to both VP Online and Active Directory.

1. Copy the downloaded zip file to the machine where Active Directory is installed.

2. Extract the zip file to a folder.

DS Connector (zip) extracted

3. Open an elevated command prompt.
For Windows Server 2008 users, click the Start button, type cmd, and then right-click Command Prompt and select Run as administrator
from the popup menu.
For Windows Server 2012 users, search cmd in the Apps screen, and then right-click Command Prompt and select Run as administrator at
the bottom of the screen.

Run elevated command prompt
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4. Navigate to DS_Connector_12.1\service where DS_Connector_12.1 is the name of the folder extracted.

5. Type the following command to install DS Connector as service:
install_service.bat

Installing DS Connector as system service

6. Run DS_Connector_12.1\DSConnectorUI.exe. Please run it as administrator to avoid any potential issues caused by insufficient write
permission.

7. When you run DS Connector the first time, you are prompted to configure the connection to VP Online/Teamwork Server. In the Configure
Server window, keep VPository selected.

To configure connection to VP Online

8. Fill in the cloud entry point.

9. Enter the key, which is the code you saw in the end of the previous section. If you have accidentally closed that dialog box, or if the key has
expired, don't worry, just click Configure again (step 4 of the previous section) to obtain another key.

Entering key for server configuration

10. Click Connect. If succeed, you should see the message Server configuration succeed.

11. DS Connector is now connected to VP Online. Now, you need to configure the connection to Active Directory. On the left hand side of the DS
Connector Console, click Add Directory Server.

To add a directory server

12. Select Active Directory as Directory Server.
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Selecting Active Directory

13. Enter a name for this configuration.

14. Enter the host name and port of the Active Directory. As we suggested you to install DS Connector on the machine where Active Directory is
installed, your host name is pretty likely to be localhost or 127.0.0.1. Regarding the port, while the default port of Active Directory is 389, you
may need to confirm it with your administrator in case it has been changed.

15. Enter Bind DN or User. You can check the required value from the Account details page of the administrator user. The value of User
SamAccountName is the value you need to enter now.

Obtaining the Bind DN or user

16. Enter the password for logging into Active Directory.

Configuring Active Directory connection

17. Click Test Connection. If succeed, you should see the message Test connection succeed.

18. Click Save in the Configure Directory Server window.

19. The newly configured directory server is listed on the left hand side of the DS Connector Console. If necessary you can add more directory
servers by repeating from step 11 until this step.
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Directory server added

Step 4 - Synchronizing users to VP Online
In this section you will add users into DS Connector Console to let it synchronize the users to VP Online. When you finished this section, the chosen
users can login VP Online from Visual Paradigm, using the login details managed by Active Directory.

1. Select the directory server in DS Connector Console.

Selecting a directory server

2. On the right hand side, click Add.

3. In the Add users/group window, select the user groups to be made available on VP Online. The users in selected groups will become members
of VP Online, and will have access to Visual Paradigm projects.

Select user groups to add to DS Connector Console

4. Click Add.

5. That's it. You can see the selected user groups listed on the right hand side of the DS Connector Console.

Users added to DS Connector Console

The user groups, along with the users will be synchronized to VP Online shortly (~1 minute). Once the synchronization has been completed, you
will see the user groups available in the Members > Groups page of VP Online, like this:
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User group synchronized to VP Online

The users are available in the Members page of VP Online. Note that the synchronization will synchronize only the user name and login ID.
It will not synchronize nor to process any password of any users in Active Directory. Whenever a user tries to login to VP Online from Visual
Paradigm, VP Online will communicate with Active Directory for authentication.

Users synchronized from Active Directory

So now, you assign the user groups to projects so that the users can open the project from Visual Paradigm and start working. If necessary you
can also grant them admin permissions.
To login VP Online from Visual Paradigm, please enter the Email(Login ID) as shown in the image above as Email, and the password stored in
Active Directory as Password.

Login from Visual Paradigm

 

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Managing projects
A project contains model(s) that describe the target system or application. It is to be edited and completed by members of a team.

Adding project
1. Visit the URL of your VP Online cloud entry point through web browser.

2. Log in your account.

3. Click on your profile image at top right and select Administration from the popup menu.

Open Administration page

4. Select Projects from the menu on the left.

Open Projects menu

5. Click on New Project and select the location, which is a folder that can be created in the previous screen, by clicking New Folder.

6. Press on + next to the members or member groups to assign them to the project. Note that there must be at least one member be assigned to
the project in order to add the project.

Creating a project

7. Click on Create Project.

8. By default, the members who have been assigned to a project will have both the read and commit permissions on the project. If you want to
change their permissions, move your mouse pointer over the row of project and then click Edit.
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To edit a project

9. Open the Members tab. From there you can change the permissions of members. The Read permission means that member can only open
the project in Visual Paradigm and read its content. The Read & Commit permission means that member can both open project and commit
changes to server.

Configuring members' permissions on this project

10. Click Save at top right to save the changes.

Renaming project
Renaming of project has to be done in Visual Paradigm, the client application. Team members who have "Update Project" permission can rename a
project by take the following steps in Visual Paradigm.

1. Select Project > Properties from the toolbar.

2. In the Project Properties window, edit the project name.

3. Click OK.

4. Commit the change.

The other team members are suggested to perform an update to have their local project files renamed.

Deleting project
By deleting a project, team members will no longer be able to commit changes to server nor to open the project. Project deletion cannot be undone.
Think carefully before you delete a project.

To delete a project:

1. Select Projects from the menu on the left.

2. Move your mouse pointer over the row of the project that you want to delete, and then click Edit.

To edit a project

3. Click on [Delete Project] at top right.
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Delete project

4. You are prompted to answer a math question. Enter the answer and click Delete.

Changing project members' read/commit permissions
1. Select Projects from the menu on the left.

2. Move your mouse pointer over the row of the project that you want to change its project members' read/commit permissions, then click Edit.

3. Open the Members tab. From there you can update the permissions of members. The Read permission means that member can only open
the project in Visual Paradigm and read its content. The Read & Commit permission means that member can both open project and commit
changes to server.

Purging a project revision
To purge a revision is to delete the revision permanently. By purging a revision, team members working on the purged revision or before will not be
able to commit nor update changes. Branches created from any purged revisions, if any, will no longer be able to merge back to the trunk. The action
cannot be undone. Think carefully before you purge a revision.

To purge a project revision:

1. Select Projects from the menu on the left.

2. Move your mouse pointer over the row of the project that you want to change its project members' read/commit permissions, then click Edit.

3. Open the Revisions tab.

4. Move your mouse pointer over the row of the revision that you want to purge, then click [Purge].  Note that purging will be performed on the
selected revision along with all the revisions before it. For example, if you have selected to purge revision 3, revisions 1 to 3 will be purged.

Purge a revision

5. You are prompted to answer a math question. Enter the answer and click Purge.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Setting working days and holidays
Tasifier takes working days and holidays into account. The date picker can indicate those non-working days and holidays as colored cells. Tasifier also
skipped those non-working days and holidays in the calculation of task duration. All these ensure tasks to be planned and carried out on schedule.

Date picker with non-working days painted in gray, holidays painted in red

Setting working days
1. Visit the URL of your VP Online cloud entry point through web browser.

2. Log in your account.

3. Click on your profile image at top right and select Administration from the popup menu.

Open Administration page

4. Select System Tools from the menu on the left.

Open System Tools page

5. Under the Working Days section of the System tab, check the working day(s).

Updating working days

6. Click Save at the top right to save the change.

Setting holidays
1. Visit the URL of your VP Online cloud entry point through web browser.

2. Log in your account.

3. Click on your profile image at top right and select Administration from the popup menu.
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4. Select System Tools from the menu on the left.

5. Under the Holiday Profile section of the System tab, specify the source of holiday profile. You can select one from the Pre-defined list, or
select Custom, and then download the template file, edit and upload the file back to apply your changes.

Holiday profile

6. Click Apply to save the changes.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Setting default visibility of various panes
In Visual Paradigm, there are four panes that display the content of a project. They include:

• Diagram Navigator - List and provides navigability to diagrams in project

• Model Explorer - List and provides navigability to model elements in project, as well as to present the model hierarchy of project

• Class Repository - List and provides navigability to classes and class members, as well as to present the hierarchy of classes and packages

• Logical View - Allows you to categorize diagrams logically

Some teams may want to encourage their team members to use these panes, while some teams not. Visual Paradigm Online ("VP Online") supports
setting the default visibility options of these panes. When a team member who are running Visual Paradigm tries to login to the server, he will see the
panes that are set visible in VP Online become visible in Visual Paradigm.

Diagram Navigator in Visual Paradigm

Setting visibility of a pane
1. Visit the URL of your VP Online cloud entry point through web browser.

2. Log in your account.

3. Click on your profile image at top right and select Administration from the popup menu.

Open Administration page

4. Select System Tools from the menu on the left.

Open System Tools page

5. Under the Panes section of the System tab, set the visibility options for the panes.
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Updating the visibility option for Model Explorer

6. Click Save at the top right to save the change.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Introducing Teamwork Server
When several team members need to work on the same project, version control is always a major concern. The time and effort spent on merging the
works of each team member is very expensive, and is very risky that the previous works may be overwritten by the new changes. Visual Paradigm's
Teamwork Server automates these complex development processes.

 

Introducing Teamwork Server

Gain idea of Teamwork Server.
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Introducing Teamwork Server
When several team members need to work on the same project, version control is always a major concern. The time and effort spent on merging the
works of each team member is very expensive, and is very risky that the previous works may be overwritten by the new changes.

Visual Paradigm's Teamwork Server automates these complex development processes, although its concept is very simple:

Server-side

• The administrator creates accounts for team members.

• The administrator creates projects, and assigns selected members to the project. The read/update project permission is granted to members
individually.

Client-side:

• The member logs in to the teamwork server.

• The member checks out (download) a project from the server and opens it on the client side.

• The member modifies the project locally, and then commit the changes to the server.

• The server will compare the local project with the server project, and begin the two-phase checkin process.

• The first phase checks whether conflicts are found. A conflict is the modification of a model/view element that is also modified by other team
members. If no conflict is found, the server proceeds to the second phase. Otherwise the teamwork client will notify the member of the conflicts,
and ask him/her to select the conflict resolve method before proceeding to the second phase.

• In the second phase, a new revision of the project is created by merging the changes made by the member with the latest project copy on the
server. The new project is downloaded from the server to the client, and is reopened so that the member can work on the latest project.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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System requirements

Hardware requirements
• CPU: Dual core 2 GHz or better

• RAM: 4.0 GB or more, 8.0 GB recommended.

• HDD: at least 4 GB of free space (NOT include project space).

Software requirements
• OS: Microsoft Windows (XP/Vista/7/8,10), Microsoft Windows Server (2000/2003/2008/2012/2016/2019), Linux, Mac OS X 10.7.3 or above

Supported databases
• Oracle 8i, 9i, 10g, 11g, 12c

• MySQL 5.6 or above

• Microsoft SQL Server 2000, 2005, 2008, 2012, 2014, 2016, 2017, 2019

• Postgre SQL 7, 8, 9

Directory Server (For users who authenticate via directory server)
• 389 Directory Server

• Active Directory

• Apache DS

• Open LDAP

• Univention

• Any other Directory Server that supports Base DN

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

 

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Installation
Install Teamwork Server on server machine.

 

Installing Teamwork Server

See how to install Teamwork Server.

 

Uninstalling Teamwork Server

Learn how to uninstall VP Server from your system
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Installing Teamwork Server
In order to install Teamwork Server, you need both the server program and a valid license key. If you have purchased Teamwork Server, you can
download both of them from your customer account. If you are going to evaluate Teamwork Server, you can download the product from our official
website and receive the evaluation key through E-mail. Get them ready, and read through this page to install the Teamwork Server. Before you start,
make sure you have a machine ready for the installation of Teamwork Server. The minimum requirement of such machine is that it must be accessible
by client machines through network, either Intranet or Internet.

1. Having downloaded the zipped Visual Paradigm Server to the server machine, extract it to the folder where you want the Teamwork Server to
install to. When finish, you obtain a folder VPServer.

Extracting the zipped VP Server

2. Start up the server by running VPServer\scripts\startup.bat file (startup.sh for Linux and Mac OS X). You may see a command console
appear. Do NOT close it or else the server will be stopped.

3. Open your Web browser and visit: http://127.0.0.1:1999/

4. The server installation page appears. Enter your organization's name and a new administrator password. Enter the same password again for
confirmation.

5. Enter the server base URL. Click Next to proceed.

Organization name and password are entered

6. To install Teamwork Server, keep Install Teamwork Module checked. Then, confirm the repository folder.
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Keep Install Teamwork Module selected

7. Click the Choose File button next to License File to import the Teamwork Server license file.

8. Click Next.

9. There is data that VP Server need to make persistent, such as your login name, password, server repository path, etc. All these have to be
stored in a database. Now, setup a new database for this purpose. Then, fill in the connection information of the database. If you are unable
to setup a database for this purpose, select Embedded as the database. The Embedded database is a ready-to-use database management
system built into the server. In other words, no additional database setup has to be made by choosing Embedded database.

Configuring database

10. Click Next.

11. Wait until the installation is finished. After that, you can click the Go to Login Page button, login and start adding new members and projects.
For detailed instruction, read the next section for server administration.

Installation complete

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Uninstalling Teamwork Server
First of all, if your ultimate goal is to upgrade server, read the server upgrade guide. If you are sure that you want to remove VP Server from your
system, perform the steps below for an uninstallation.

1. Run shutdown.bat (shutdown.sh for Linux and Mac OS X) in the scripts folder under the VP Server directory to stop the server.

2. If you are using Windows and if Teamwork Server was installed as a windows service, don't forget to remove the service as well. To remove the
installed service, run remove_service.bat in the scripts folder under the VP Server installation directory.

3. Finally, you can delete the whole VP Server folder to remove it from the system. Note that this will delete the server repository as well if your
repository folder is placed under the installation folder. Think twice before uninstallation.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Server administration
Manage members and projects of Teamwork Server.

 

Managing members

Learn how to manage team members in Teamwork Server.

 

Visual Paradigm Teamwork Server LDAP Authentication

Learn how to work with LDAP authentication in Visual Paradigm Teamwork Server.

 

Visual Paradigm Teamwork Server Active Directory Authentication

Learn how to work with Active Directory authentication in Visual Paradigm Teamwork Server.

 

Setting up Visual Paradigm Teamwork Server with Okta

Teamwork Server supports Okta for Enterprise clients. In this article we will go into the details of setting up SAML authentication through Okta.

 

Setting up Visual Paradigm Teamwork Server with Microsoft Azure

Teamwork Server supports Microsoft Azure for Enterprise clients. In this article we will go into the details of setting up SAML authentication through
Microsoft Azure.

 

Managing groups

Learn how to manage groups in Teamwork Server.

 

Visual Paradigm Teamwork Server LDAP Authentication (Groups)

Learn how to work with LDAP authentication in Visual Paradigm Teamwork Server, to make it possible to use the user and user groups created in
LDAP Server.

 

Visual Paradigm Teamwork Server Active Directory Authentication  (Groups)

Learn how to work with Active Directory authentication in Visual Paradigm Teamwork Server, to make it possible to use the user and user groups
created in Active Directory Server.

 

Managing projects

Learn how to manage projects in Teamwork Server.

Using the client update service

"Client Update" is a service that facilitates the update of client Visual Paradigm/ArchiMetric installation through the retrieval of updated files from VP
Server. This article shows you how it works.
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Managing members
A member is someone who has sufficient right to be the server administrator and/or be a general team member who works on a project file. A member
can be assigned to one or more projects, and can be granted the permissions to read and/or update them. Moreover, selected members can be
granted permission to administer (add/edit/remove) members or projects, so that the members can have all or part of the powers of a Teamwork Server
administrator.

Adding member
1. Open a web browser.

2. Visit and login VP Server.

Logging into VP Server as administrator

3. At the top right, click on your profile logo image and select Admin Repository from the drop down menu.

4. Select Members from the menu on the left hand side.

5. Under the Members tab, click on New Member.

6. Enter the name, email address and password of the member to add.

Entering member details

Option Description

Name Name of member. It is used for display purpose within the administration tool.

Email (Login ID) Email address of member. It is also the login ID member use to log into the server at client side.

Password The password member need to log into his/her account.

Confirm Password Re-enter the password for confirmation.

Active Set if you want to reject the member from logging into the server. Very often you set it when the member is no
longer with your team and is not expected to modify the project anymore.
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Options available when adding member

7. Switch to the Permissions tab. Grant him/her the administrator rights for creating/updating/deleting member and/or project. If you want to limit
the member to perform certain action in Visual Paradigm, update the settings under the Access of features, Project configuration and Tag/
Branch sections.

Option Description

Repository The administrator right(s) of this member.
Create project - Project refers to a Visual Paradigm project that is available to be checked out by a
member from client side. The create right enables this member to add a new project into the server. He/she
can create project by creating a blank project, by importing an existing .vpp project file or by importing an
opening project when creating project at client side.
Update project - Enables this member to modify the description, member assignments and granted
permissions of projects.
Delete project - Enables this member to remove a project from server.
Create member - Member is someone who has sufficient right to be the server administrator and/or be a
general team member who works on a project file. The create right enables this member to create members
in server.
Update  member - Enables this member to modify the name, login ID, password, administrator permissions
and project assignments for all members in server.
Manage member groups - A group is a named group of members who who share the same read and/or
commit rights of project(s). By enabling this option, the member will have the right to create/edit/remove
group. Note that removing the group does not remove the member from server.

Access of features The functions member can/cannot perform in Visual Paradigm.
Override the locks applied to elements and diagrams  - When allowed, member can unlock a diagram
locked by anyone, even for diagrams with password protected.
Project options - When allowed, member can modify the configurable options set to projects.
Add and remove referenced projects - When allowed, member can add and remove referenced projects.

Project configuration The functions member can/cannot perform in Visual Paradigm.
Stereotypes (Project-based) - When allowed, member can add, edit and remove stereotypes in projects.
D efault tagged values - When allowed, member can define default tagged values for any type of model
elements.
Requirement types - When allowed, member can add, edit and remove requirement types.
Viewpoints - When checked, member can add, edit and remove viewpoints and stakeholders.
User story statuses  -  When allowed, member can add. edit and remove user story statuses. 

Project management lookups  - When allowed, member can modify the lookup values for project
management properties (e.g. phase, iteration, version, etc).
Business rule keywords - When allowed, member can add, edit and remove business rule keywords.
Design pattern - When allowed, member can synchronize with server the local changes made to design
patterns.
Doc. Composer element templates - When allowed, member can duplicate and edit Doc Composer
element templates.
Task pool statuses - When allowed, member can configure task pool statuses in Tasifier.

Tag/Branch The functions member can/cannot perform in Visual Paradigm. 
Create tag  - When allowed, member can produce tags from teamwork project.
Create branch - When allowed, member can produce branches from teamwork project.
Merge branch - When allowed, member can merge changes made in branch to trunk, or the other way
round.
Delete branch - When allowed, member can delete any branch.

Options available when adding member

8. Click Save at the top right of page.

9. If you have already added project, you can assign this member to project(s), too. Open the Projects tab. Click Add Project and press + on the
project(s) that the member will involve. Click Close.

10. Decide whether he can read and/or commit changes made in the project. Read access enables opening the project from server and reading its
content. Commit enables uploading project changes from client to server. This step is optional and you can assign member to project in project
management page later on.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Visual Paradigm Teamwork Server LDAP Authentication
Teamwork Server supports two ways of authentication - built-in authentication and directory server authentication. While the built-in authentication
allows you to easily set up and manage member accounts completely inside Teamwork Server, active server authentication allows users to login to
Teamwork Server and VP Server with credentials stored in and managed by a directory server.

In order for directory server authentication to work, administrator has to install a utility called DS Connector, and have it configured to connect both VP
Server and the directory server. DS Connector acts as bridge between VP Server and directory server. It's capable to synchronize user listing from
directory server to VP Server, and to manage the authentication from Visual Paradigm to directory server, through VP Server.

In this page, you will learn how to work with LDAP authentication from creating users in Apache Directory Studio to installing and configuring DS
Connector. If you are interested in working with user group instead of user, please read Visual Paradigm Teamwork Server LDAP Authentication
(Groups). If you are interested in Active Directory Authentication, please read Visual Paradigm Teamwork Server Active Directory Authentication.

There are series of steps you need to take in order to make LDAP authentication works. Please read through all the steps below without skipping any
of them, even if you are familiar with LDAP and Apache Directory Studio.

Step 1 - Creating user account in ApacheDS
In this section you will learn how to create user account in ApacheDS using Apache Directory Studio. It's mainly written for people who are not
familiar with ApacheDS. However, even if you are familiar with ApacheDS, be sure to read through the steps as some of the settings will influence the
authentication process.

1. In LDAP Browser, navigate to the ou=users node under DIT > Root DSE > ou=system.

2. Right click on the ou=users node in and select New Entry... from the popup menu.

Adding a new entry via LDAP Browser

3. In the New Entry window, keep Create entry from scratch selected and click Next.

4. You are prompted to enter one structural object for creating the new user. Select inetOrgPerson as the object class

Selected inetOrgPerson

5. Click Add to add inetOrgPerson to the list of selected object classes. You will see a list the object classes from the inetOrgPerson object
hierarchy are being added automatically.
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inetOrgPerson added to the list of selected object classes

6. Click Next.

7. For RDN, enter uid=jdoe, where jdoe is a unique shortname of the user you want to add now.

RDN entered

8. Click Next.

9. Fill in the attributes for jdoe. Enter John Doe as cn.

10. Enter Doe as sn.

cn and sn specified

11. You can optionally add more attributes for this user. In particular, you may want to supply an email for this user. Doing so allows this user
to login to Teamwork Server by entering his/her email address. Without supplying an email, he/she will need to login by entering string like
uid=jdoe,ou=users,ou=system as username. If you want to add the mail attribute, click New Attribute... on top of the table, on the right hand
side. Then, add and fill in the mail attribute. (note: Make sure you've selected the mail attribute, not email/ emailAddress)
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12. Create a password for this user. Click on New Attribute... as shown in the image below. By the way, be sure to set password for users who will
use Visual Paradigm. Users without password won't be able to access the Teamwork Server.

Create an attribute

13. In the New Attribute window, select userPassword as Attribute Type.

Selected userPassword as attribute type

14. Click Finish.

15. Enter the password and click OK.

Password entered

16. Click Finish.

Step 2 - Downloading DS Connector from VP Server
DS Connector acts as a bridge between VP Server and directory server. In this section you will see how to download DS Connector from VP Server.

1. Open a web browser.

2. Visit the Teamwork Server URL and login as administrator. Note that the login ID of the default server administrator is Admin.

3. Select System Tools from the menu on the left hand side.

4. Open the tab Single Sign-On.

5. Click on Configure under the section Directory Service Connector.

To configure directory service connector

6. Choose the operating system for the machine where ApacheDS is installed.
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Choosing the right operating system

7. Click Download. Keep the dialog box opened as you will need to copy the key presented in the dialog box when you configure DS Connector in
the next section.

Step 3 - Installing and configuring DS Connector
In this section you will install DS Connector, and configure it to make it connect to both VP Server and ApacheDS.

1. Copy the downloaded zip file to the machine where ApacheDS is installed.

2. Extract the zip file to a folder.

DS Connector (zip) extracted

3. Open an elevated command prompt.
For Windows Server 2008 users, click the Start button, type cmd, and then right-click Command Prompt and select Run as administrator
from the popup menu.
For Windows Server 2012 users, search cmd in the Apps screen, and then right-click Command Prompt and select Run as administrator at
the bottom of the screen.

Run elevated command prompt

4. Navigate to DS_Connector_12.1\service where DS_Connector_12.1 is the name of the folder extracted.

5. Type the following command to install DS Connector as service:
install_service.bat
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Installing DS Connector as system service

6. Run DS_Connector_12.1\DSConnectorUI.exe. Please run it as administrator to avoid any potential issues caused by insufficient write
permission.

7. When you run DS Connector the first time, you are prompted to configure the connection to VPository/Teamwork Server. In the Configure
Server window, click Other and then select VP Server from the popup menu.

To configure connection to VP Server

8. Enter the host name and port of VP Server.

9. Enter the key, which is the code you saw in the end of the previous section. If you have accidentally closed that dialog box, or if the key has
expired, don't worry, just click Configure again (step 5 of the previous section) to obtain another key.

Entering key for server configuration

10. Click Connect. If succeed, you should see the message Server configuration succeed.

11. DS Connector is now connected to VP Server. Now, you need to configure the connection to ApacheDS. On the left hand side of the DS
Connector Console, click Add Directory Server.

To add a directory server

12. Select ApacheDS as Directory Server.

Selecting ApacheDS
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13. Enter a name for this configuration.

14. Enter the host name and port of the ApacheDS. As we suggested you to install DS Connector on the machine where ApacheDS is installed,
your host name is pretty likely to be localhost or 127.0.0.1. Regarding the port, while the default port of ApacheDS is 10389, you may need to
confirm it with your administrator in case it has been changed.

15. Enter Bind DN or User. If you use Apache Directory Studio, you can obtain the required value by right clicking on the LDAP connection and
selecting Properties from the popup menu. The Bind DN or user can be found under the Authentication tab.

Obtaining the Bind DN or user from Apache Directory Studio

16. Enter the password for logging into ApacheDS.

Configuring ApacheDS connection

17. Click Test Connection. If succeed, you should see the message Test connection succeed.

18. Click Save in the Configure Directory Server window.

19. The newly configured directory server is listed on the left hand side of the DS Connector Console. If necessary you can add more directory
servers by repeating from step 11 until this step.

Directory server added

Step 4 - Synchronizing users to VP Server
In this section you will add users into DS Connector Console to let it synchronize the users to VP Server. When you finished this section, the chosen
users can login Teamwork Server from Visual Paradigm, using the login details managed by ApacheDS.

1. Select the directory server in DS Connector Console.
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Selecting a directory server

2. On the right hand side, click Add.

3. In the Add users/group window, select the user(s) to be made available on Teamwork Server. The selected users will become members of
Teamwork server, and will have access to Visual Paradigm projects.

Select users to add to DS Connector Console

4. Click Add.

5. That's it. You can see the selected users listed on the right hand side of the DS Connector Console.

Users added to DS Connector Console

The name and login ID of the selected users will be synchronized to VP Server shortly (~1 minute). Once the synchronization has been
completed, you will see the users available in the Members page of VP Server. Note that the synchronization will synchronize only the user
name and login ID. It will not synchronize nor to process any password of any users in ApacheDS. Whenever a user tries to login to Teamwork
Server from Visual Paradigm, Teamwork Server will communicate with ApacheDS for authentication.

Users synchronized from ApacheDS

So now, you assign the users to projects so that they can open the project from Visual Paradigm and start working. If necessary you can also
grant them admin permissions.
To login Teamwork Server from Visual Paradigm, please enter the Email (Login ID) of member as Email (not the display name), and the
password stored in ApacheDS as Password.
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Login from Visual Paradigm

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Visual Paradigm Teamwork Server Active Directory Authentication
Teamwork Server supports two ways of authentication - built-in authentication and directory server authentication. While the built-in authentication
allows you to easily set up and manage member accounts completely inside Teamwork Server, active server authentication allows users to login to
Teamwork Server and VP Server with credentials stored in and managed by a directory server.

In order for directory server authentication to work, administrator has to install a utility called DS Connector, and have it configured to connect both VP
Server and the directory server. DS Connector acts as bridge between VP Server and directory server. It's capable to synchronize user listing from
directory server to VP Server, and to manage the authentication from Visual Paradigm to directory server, through VP Server.

In this page, you will learn how to work with Active Directory authentication from creating users in Apache Directory Studio to installing and configuring
DS Connector. If you are interested in working with user group instead of user, please read Visual Paradigm Teamwork Server Active Directory
Authentication (Groups). If you are interested in LDAP Authentication, please read Visual Paradigm Teamwork Server LDAP Authentication.

There are series of steps you need to take in order to make Active Directory authentication works. Please read through all the steps below without
skipping any of them, even if you are familiar with Active Directory.

Step 1 - Creating organization unit and user in Active Directory
1. Start the Server Manager in Windows Server.

2. Click on Tools at top right and select Active Directory Administrative Center from the popup menu.

Open Active Directory Administrative Center

3. Select your domain from the list on the left hand side.

Select domain

4. Create an Organizational Unit to house your corporate users. On the right navigation pane under Task > <domain name> click on New and
then select Organizational Unit.
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Create Organizational Unit

5. Organizational unit is like a company. Enter the mandatory details and click OK.

Filling in the Organizational Unit screen

6. This will immediately create the Organizational Unit in the designated location.  Double click on your newly created Organizational Unit.

Double click on an Organization Unit to edit it

7. On the right navigation pane, click on New, and then select User from the popup menu.
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Create user

8. Enter the mandatory details such as user&rsquo;s name.

Filling in the User screen

9. Enter the password for the user.

10. Change the Password options to Other password options. If you don't do this, you won't be able to login with this user account from Visual
Paradigm products.

Change to Other password options

11. Click OK. Repeat step 7 to step 10 to create all users in Active Directory.

Step 2 - Downloading DS Connector from VP Server
DS Connector acts as a bridge between VP Server and directory server. In this section you will see how to download DS Connector from VP Server.

1. Open a web browser.

2. Visit the Teamwork Server URL and login as administrator. Note that the login ID of the default server administrator is Admin.

3. Select System Tools from the menu on the left hand side.

4. Open the tab Single Sign-On.

5. Click on Configure under the section Directory Service Connector.
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To configure directory service connector

6. Choose the operating system for the machine where Active Directory is installed.

Choosing the right operating system

7. Click Download. Keep the dialog box opened as you will need to copy the key presented in the dialog box when you configure DS Connector in
the next section.

Step 3 - Installing and configuring DS Connector
In this section you will install DS Connector, and configure it to make it connect to both VP Server and Active Directory.

1. Copy the downloaded zip file to the machine where Active Directory is installed.

2. Extract the zip file to a folder.

DS Connector (zip) extracted

3. Open an elevated command prompt.
For Windows Server 2008 users, click the Start button, type cmd, and then right-click Command Prompt and select Run as administrator
from the popup menu.
For Windows Server 2012 users, search cmd in the Apps screen, and then right-click Command Prompt and select Run as administrator at
the bottom of the screen.

Run elevated command prompt
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4. Navigate to DS_Connector_12.1\service where DS_Connector_12.1 is the name of the folder extracted.

5. Type the following command to install DS Connector as service:
install_service.bat

Installing DS Connector as system service

6. Run DS_Connector_12.1\DSConnectorUI.exe. Please run it as administrator to avoid any potential issues caused by insufficient write
permission.

7. When you run DS Connector the first time, you are prompted to configure the connection to VPository/Teamwork Server. In the Configure
Server window, click Other and then select VP Server from the popup menu.

To configure connection to VP Server

8. Enter the host name and port of VP Server.

9. Enter the key, which is the code you saw in the end of the previous section. If you have accidentally closed that dialog box, or if the key has
expired, don't worry, just click Configure again (step 5 of the previous section) to obtain another key.

Entering key for server configuration

10. Click Connect. If succeed, you should see the message Server configuration succeed.

11. DS Connector is now connected to VP Server. Now, you need to configure the connection to Active Directory. On the left hand side of the DS
Connector Console, click Add Directory Server.

To add a directory server

12. Select Active Directory as Directory Server.
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Selecting Active Directory

13. Enter a name for this configuration.

14. Enter the host name and port of the Active Directory. As we suggested you to install DS Connector on the machine where Active Directory is
installed, your host name is pretty likely to be localhost or 127.0.0.1. Regarding the port, while the default port of Active Directory is 389, you
may need to confirm it with your administrator in case it has been changed.

15. Enter Bind DN or User. You can check the required value from the Account details page of the administrator user. The value of User
SamAccountName is the value you need to enter now.

Obtaining the Bind DN or user

16. Enter the password for logging into Active Directory.

Configuring Active Directory connection

17. Click Test Connection. If succeed, you should see the message Test connection succeed.

18. Click Save in the Configure Directory Server window.

19. The newly configured directory server is listed on the left hand side of the DS Connector Console. If necessary you can add more directory
servers by repeating from step 11 until this step.
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Directory server added

Step 4 - Synchronizing users to VP Server
In this section you will add users into DS Connector Console to let it synchronize the users to VP Server. When you finished this section, the chosen
users can login Teamwork Server from Visual Paradigm, using the login details managed by Active Directory.

1. Select the directory server in DS Connector Console.

Selecting a directory server

2. On the right hand side, click Add.

3. In the Add users/group window, select the user(s) to be made available on Teamwork Server. The selected users will become members of
Teamwork server, and will have access to Visual Paradigm projects.

Select users to add to DS Connector Console

4. Click Add.

5. That's it. You can see the selected users listed on the right hand side of the DS Connector Console.

Users added to DS Connector Console

The name and login ID of the selected users will be synchronized to VP Server shortly (~1 minute). Once the synchronization has been
completed, you will see the users available in the Members page of VP Server. Note that the synchronization will synchronize only the user
name and login ID. It will not synchronize nor to process any password of any users in Active Directory. Whenever a user tries to login to
Teamwork Server from Visual Paradigm, Teamwork Server will communicate with Active Directory for authentication.

Users synchronized from Active Directory
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So now, you assign the users to projects so that they can open the project from Visual Paradigm and start working. If necessary you can also
grant them admin permissions.
To login Teamwork Server from Visual Paradigm, please enter the Email(Login ID) as shown in the image above as Email, and the password
stored in Active Directory as Password.

Login from Visual Paradigm

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Visual Paradigm Know-How -  How to migrate Teamwork Server from Built-in Authentication to Active Directory Authentication

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
http://knowhow.visual-paradigm.com/technical-support/server-configuration/migrate-vpts-to-ad-auth/
https://www.visual-paradigm.com/support/technicalsupport.jsp?product=vpts
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Setting up Visual Paradigm Teamwork Server with Okta
Teamwork Server supports Okta for Enterprise clients. In this article we will go into the details of setting up SAML authentication through Okta.
Although this is specific to Okta the concepts could be adapted to any other SAML Identity Provider.

Step 1 - Setting up Okta
In this section you will learn how to create a new application integration in Okta.

1. Part of the setup of Okta requires providing details given by Teamwork Server. So now, open a web browser and login VP Server as
administrator.

2. Select System Tools from the menu on the left hand side.

3. Open the Single Sign-On tab and keep it opened. We will come back later.

The Single Sign-On page of Teamwork Server

4. Open another tab/window in the web browser and visit Okta.

5. Create a new application integration in Okta. Select SAML 2.0 as sign-on method.

Creating an application with SAML 2.0 as sign on method

6. Enter VP Teamwork Server as the name of application. Click Next.
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Entering application name

7. Fill-in the SAML settings. Copy the value of Single Sign-on (ASC) URL from Teamwork Server to Okta as the Single sign on URL, and then
copy the value of Audience URI (SP Entity ID) from Teamwork Server to Okta.

Filling in SAML settings

8. Click Next.

9. Select I'm an Okta customer adding an internal app and then click Finish.

Choosing identity

10. Download the Identity Provider metadata under the Sign On tab.
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Download Identity Provider metadata

11. Open the People tab.

12. Click Assign to People and then assign the application to people who will use Teamwork Server. Doing so does not instantly grant those
people the accessibility to Teamwork Server. You still have to go through the process of inviting them to Teamwork Server, which will be
mentioned in the next section.

Assigning VP Teamwork Server (application) to people

13. Click Done when finished.

Step 2 - Setting up Teamwork Server
1. Go back to Teamwork Server. You should be opening the Single Sign-On tab of the System Tools page. Now, enter Okta as the Identity

Provider (IDP) Name.
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IDP name entered

2. In the IDP metadata field, upload the Identity Provider metadata file downloaded in the previous section.

IDP metadata uploaded

3. Click Apply.

4. Click OK when you are prompted for confirmation. If sign-in success, you will be logged out automatically. If failed, please make sure the
Teamwork Server application has been assigned to you in Okta, and try again.

5. From now on, Teamwork Server is integrated with Okta. You, as the administrator can access Teamwork Server with your Okta account and
perform administration and management tasks. Team members, once being invited and have accepted the invitations, can login Teamwork
Server from Visual Paradigm with their Okta account.

Login with Okta

Step 3 - Member management
Since the integration with Okta, in order for someone to become a Teamwork Server member, he/she has to:

1. Be a person who have been assigned the Teamwork Server application in Okta and,

2. Have accepted the invitation sent from Teamwork Server administrator.

The first point has been covered in step 1 above. In this section we are going to show you how to invite a member.

1. Open a web browser and login VP Server as administrator.

2. Select Members from the menu on the left hand side.

3. Under the Members tab, click Invite Member.
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Invite member

4. Enter the name and email of the members. Make sure you have already assigned the VP Teamwork Server application to them in Okta. If not,
they won't be able to access any projects. Click Send Invitation.

Send invitation

5. The invitee will receive an invitation shortly. Click on the activation link in the email.

To activate Teamwork Server account

6. He/she will be redirected to a web page where he/she can fill in his name. Enter the name and click Activate with Okta.
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Activating Teamwork Server account

If success, he will see the Congratulations screen. From now on, he/she can access Teamwork Server from Visual Paradigm with his/her Okta
account.

Activation success

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• User's Guide: Setting up Visual Paradigm Teamwork Server with Microsoft Azure

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Setting up Visual Paradigm Teamwork Server with Microsoft Azure
Teamwork Server supports Microsoft Azure for Enterprise clients. In this article we will go into the details of setting up SAML authentication through
Microsoft Azure. Although this is specific to Microsoft Azure the concepts could be adapted to any other SAML Identity Provider.

Step 1 - Setting up Microsoft Azure
In this section you will learn how to create a new application integration in Microsoft Azure.

1. Part of the setup of Microsoft Azure requires providing details given by Teamwork Server. So now, open a web browser and login VP Server as
administrator.

2. Select System Tools from the menu on the left hand side.

3. Open the Single Sign-On tab and keep it opened. We will come back later.

The Single Sign-On page of Teamwork Server

4. Open another tab/window in the web browser and visit Microsoft Azure.

5. Create a new application in Azure. Name it VP Teamwork Server. Click Next.

Creating application VP Teamwork Server

6. Fill-in the App properties. Copy the value of Single Sign-on (ASC) URL from Teamwork Server to Microsoft Azure as the SIGN-ON URL, and
then copy the value of Audience URI (SP Entity ID) from Teamwork Server to Azure as APP ID URL.
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Filling in App properties

7. Click Complete.

8. Click VIEW ENDPOINTS at the bottom of the screen.

Clicking on View Endpoints

9. Copy the URL of FEDERATION METADATA DOCUMENT. Visit the URL and save the XML content to a new file.

To open the URL of metadata

10. Open the CONFIGURE page.



Setting up Visual Paradigm Teamwork Server with Microsoft Azure P. 105

Configure server

11. Choose Yes for the option USER ASSIGNMENT REQUIRED TO ACCESS APP.

Enable the requirement of user assignment to acces app

12. Click SAVE at the bottom of the screen to save the changes.

Save changes

13. Open the USERS AND GROUPS page.

Opening Users and Groups page

14. Select the person who will use Teamwork Server.

Selecting people to assign

15. Click ASSIGN at the bottom of the screen. Select YES for confirmation. Note that the assignment does not instantly grant this person
accessibility to Teamwork Server. You still have to go through the process of inviting him/her to Teamwork Server, which will be mentioned in
the next section.

User assignment

16. Repeat the assignment process on other people who need to access Teamwork Server.

Step 2 - Setting up Teamwork Server
1. Go back to Teamwork Server. You should be opening the Single Sign-On tab of the System Tools page. Now, enter Azure as the Identity

Provider (IDP) Name.
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IDP name entered

2. In the IDP metadata field, upload the metadata file saved in the previous section.

IDP metadata uploaded

3. Click Apply.

4. Click OK when you are prompted for confirmation. If sign-in success, you will be logged out automatically. If failed, please make sure the
Teamwork Server application has been assigned to you in Microsoft Azure, and try again.

5. From now on, Teamwork Server is integrated with Microsoft Azure. You, as the administrator can access Teamwork Server with your Microsoft
Azure account and perform administration and management tasks. Team members, once being invited and have accepted the invitations, can
login Teamwork Server from Visual Paradigm with their Microsoft Azure account.

Login with Microsoft Azure

Step 3 - Member management
Since the integration with Microsoft Azure, in order for someone to become a Teamwork Server member, he/she has to:

1. Be a person who have been assigned the Teamwork Server application in Microsoft Azure and,

2. Have accepted the invitation sent from Teamwork Server administrator.

The first point has been covered in step 1 above. In this section we are going to show you how to invite a member.
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1. Open a web browser and login VP Server as administrator.

2. Select Members from the menu on the left hand side.

3. Under the Members tab, click Invite Member.

Invite member

4. Enter the name and email of the members. Make sure you have already assigned the VP Teamwork Server application to them in Microsoft
Azure. If not, they won't be able to access any projects. Click Send Invitation.

Send invitation

5. The invitee will receive an invitation shortly. Click on the activation link in the email.

To activate Teamwork Server account

6. He/she will be redirected to a web page where he/she can fill in his name. Enter the name and click Activate with Azure.
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Activating Teamwork Server account

If success, he will see the Congratulations screen. From now on, he/she can access Teamwork Server from Visual Paradigm with his/her
Microsoft Azure account.

Activation success

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• User's Guide: Setting up Visual Paradigm Teamwork Server with Okta

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Managing groups
A group is a named category of members in teamwork server. It groups members who share the same characteristic and let them share the same
project permission.

Adding group
1. Open a web browser.

2. Visit and login VP Server.

Logging into VP Server as administrator

3. At the top right, click on your profile logo image and select Admin Repository from the drop down menu.

4. Select Members from the menu on the left hand side.

5. Under the Group tab, click on New Group.

6. Enter the name of group.

Entering group name

7. Select members to add into the group. Click Add Members and then press + on the members to add into the group. Click Close when ready.

8. You may optionally assign the group to project(s). Open the Projects tab. Click Add Project and press + on the project(s) for assignments.
Click Close.

9. Decide whether the members in group can read and/or commit changes made in the project. Read access enables opening the project from
server and reading its content. Commit enables uploading project changes from client to server. This step is optional and you can assign
member to project in project management page later on.

10. Click Save.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Visual Paradigm Teamwork Server LDAP Authentication (Group)
Teamwork Server supports two ways of authentication - built-in authentication and directory server authentication. While the built-in authentication
allows you to easily set up and manage member accounts completely inside Teamwork Server, active server authentication allows users to login to
Teamwork Server and VP Server with credentials stored in and managed by a directory server.

In order for directory server authentication to work, administrator has to install a utility called DS Connector, and have it configured to connect both VP
Server and the directory server. DS Connector acts as bridge between VP Server and directory server. It's capable to synchronize user listing from
directory server to VP Server, and to manage the authentication from Visual Paradigm to directory server, through VP Server.

In this page, you will learn how to work with LDAP authentication from creating user groups in Apache Directory Studio to installing and configuring DS
Connector. If you are interested in working with user instead of user group, please read Visual Paradigm Teamwork Server LDAP Authentication. If you
are interested in Active Directory Authentication, please read Visual Paradigm Teamwork Server Active Directory Authentication (Groups).

There are series of steps you need to take in order to make LDAP authentication works. Please read through all the steps below without skipping any
of them, even if you are familiar with LDAP and Apache Directory Studio.

Step 1 - Creating user account in ApacheDS
In this section you will learn how to create user account in ApacheDS using Apache Directory Studio. It's mainly written for people who are not
familiar with ApacheDS. However, even if you are familiar with ApacheDS, be sure to read through the steps as some of the settings will influence the
authentication process.

1. In LDAP Browser, navigate to the ou=users node under DIT > Root DSE > ou=system.

2. Right click on the ou=groups node in and select New Entry... from the popup menu.

Adding a new entry via LDAP Browser

3. In the New Entry window, keep Create entry from scratch selected and click Next.

4. You are prompted to enter one structural object for creating the new user. Select groupOfUniqueNames as the object class
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Selected groupOfUniqueNames

5. Click Add to add groupOfUniqueNames to the list of selected object classes. You will see a list the object classes from the
groupOfUniqueNames object hierarchy are being added automatically.

groupOfUniqueNames added to the list of selected object classes

6. Click Next.

7. For RDN, enter cn=developer, where developer is the name of group and you should supply your own group name here - developer is just an
example.

RDN entered

8. Click Next.

9. Add users into this group by creating multiple uniqueMember attributes and entering the DN of those users as attribute values. A
uniqueMember attribute is default created. Enter the first user's DN in the Value cell.

Entering the DN of a user

By the way, be sure to set password for users who will use Visual Paradigm. Users without password won't be able to access the Teamwork
Server. To set a password for a user, select the user node under ou=users in LDAP Browser. Click on New Attribute... in the Entry Editor on
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the right hand side. In the New Attribute window, select userPassword to be the Attribute type. Click Finish, enter the password and click OK
to confirm.

10. Add other users by creating more uniqueMember attributes. To do this, right click on any attribute row in the New Entry window and select
New Attribute... from the popup menu. Then enter uniqueMember in the Attribute type field in the New Attribute window and click Finish.
Finally, specify the DN of that user.

Users added to user group

11. Click Finish.

Step 2 - Downloading DS Connector from VP Server
DS Connector acts as a bridge between VP Server and directory server. In this section you will see how to download DS Connector from VP Server.

1. Open a web browser.

2. Visit the Teamwork Server URL and login as administrator. Note that the login ID of the default server administrator is Admin.

3. Select System Tools from the menu on the left hand side.

4. Open the tab Single Sign-On.

5. Click on Configure under the section Directory Service Connector.

To configure directory service connector

6. Choose the operating system for the machine where ApacheDS is installed.

Choosing the right operating system

7. Click Download. Keep the dialog box opened as you will need to copy the key presented in the dialog box when you configure DS Connector in
the next section.
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Step 3 - Installing and configuring DS Connector
In this section you will install DS Connector, and configure it to make it connect to both VP Server and ApacheDS.

1. Copy the downloaded zip file to the machine where ApacheDS is installed.

2. Extract the zip file to a folder.

DS Connector (zip) extracted

3. Open an elevated command prompt.
For Windows Server 2008 users, click the Start button, type cmd, and then right-click Command Prompt and select Run as administrator
from the popup menu.
For Windows Server 2012 users, search cmd in the Apps screen, and then right-click Command Prompt and select Run as administrator at
the bottom of the screen.

_

Run elevated command prompt

4. Navigate to DS_Connector_12.1\service where DS_Connector_12.1 is the name of the folder extracted. Please run it as administrator to
avoid any potential issues caused by insufficient write permission.

5. Type the following command to install DS Connector as service:
install_service.bat

Installing DS Connector as system service

6. Run DS_Connector_12.1\DSConnectorUI.exe.

7. When you run DS Connector the first time, you are prompted to configure the connection to VPository/Teamwork Server. In the Configure
Server window, click Other and then select VP Server from the popup menu.
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To configure connection to VP Server

8. Enter the host name and port of VP Server.

9. Enter the key, which is the code you saw in the end of the previous section. If you have accidentally closed that dialog box, or if the key has
expired, don't worry, just click Configure again (step 5 of the previous section) to obtain another key.

Entering key for server configuration

10. Click Connect. If succeed, you should see the message Server configuration succeed.

11. DS Connector is now connected to VP Server. Now, you need to configure the connection to ApacheDS. On the left hand side of the DS
Connector Console, click Add Directory Server.

To add a directory server

12. Select ApacheDS as Directory Server.

Selecting ApacheDS

13. Enter a name for this configuration.

14. Enter the host name and port of the ApacheDS. As we suggested you to install DS Connector on the machine where ApacheDS is installed,
your host name is pretty likely to be localhost or 127.0.0.1. Regarding the port, while the default port of ApacheDS is 10389, you may need to
confirm it with your administrator in case it has been changed.

15. Enter Bind DN or User. If you use Apache Directory Studio, you can obtain the required value by right clicking on the LDAP connection and
selecting Properties from the popup menu. The Bind DN or user can be found under the Authentication tab.
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Obtaining the Bind DN or user from Apache Directory Studio

16. Enter the password for logging into ApacheDS.

Configuring ApacheDS connection

17. Click Test Connection. If succeed, you should see the message Test connection succeed.

18. Click Save in the Configure Directory Server window.

19. The newly configured directory server is listed on the left hand side of the DS Connector Console. If necessary you can add more directory
servers by repeating from step 11 until this step.

Directory server added

Step 4 - Synchronizing users to VP Server
In this section you will add users into DS Connector Console to let it synchronize the users to VP Server. When you finished this section, the chosen
users can login Teamwork Server from Visual Paradigm, using the login details managed by ApacheDS.

1. Select the directory server in DS Connector Console.

Selecting a directory server

2. On the right hand side, click Add.

3. In the Add users/group window, select the user groups to be made available on Teamwork Server. The users in selected groups will become
members of Teamwork server, and will have access to Visual Paradigm projects.
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Select user groups to add to DS Connector Console

4. Click Add.

5. That's it. You can see the selected user groups listed on the right hand side of the DS Connector Console.

Users added to DS Connector Console

The user groups, along with the users will be synchronized to VP Server shortly (~1 minute). Once the synchronization has been completed, you
will see the user groups available in the Members > Groups page of VP Server, like this:

User group synchronized to VP Server

The users are available in the Members page of the Teamwork module of VP Server. Note that the synchronization will synchronize only
the user name and login ID. It will not synchronize nor to process any password of any users in ApacheDS. Whenever a user tries to login to
Teamwork Server from Visual Paradigm, Teamwork Server will communicate with ApacheDS for authentication.

Users synchronized from ApacheDS

So now, you assign the user groups to projects so that the users can open the project from Visual Paradigm and start working. If necessary you
can also grant them admin permissions.
To login Teamwork Server from Visual Paradigm, please enter the Email (Login ID) of member as Email (not the display name), and the
password stored in ApacheDS as Password.
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Login from Visual Paradigm

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Visual Paradigm Teamwork Server Active Directory Authentication (Group)
Teamwork Server supports two ways of authentication - built-in authentication and directory server authentication. While the built-in authentication
allows you to easily set up and manage member accounts completely inside Teamwork Server, active server authentication allows users to login to
Teamwork Server and VP Server with credentials stored in and managed by a directory server.

In order for directory server authentication to work, administrator has to install a utility called DS Connector, and have it configured to connect both VP
Server and the directory server. DS Connector acts as bridge between VP Server and directory server. It's capable to synchronize user listing from
directory server to VP Server, and to manage the authentication from Visual Paradigm to directory server, through VP Server.

In this page, you will learn how to work with Active Directory authentication from creating user groups in Active Directory to installing and configuring
DS Connector. If you are interested in working with user instead of user group, please read Visual Paradigm Teamwork Server Active Directory
Authentication (Groups). If you are interested in LDAP Authentication, please read Visual Paradigm Teamwork Server LDAP Authentication (Groups).

There are series of steps you need to take in order to make Active Directory authentication works. Please read through all the steps below without
skipping any of them, even if you are familiar with Active Directory.

Step 1 - Creating organization unit, user and group in Active Directory
1. Start the Server Manager in Windows Server.

2. Click on Tools at top right and select Active Directory Administrative Center from the popup menu.

Open Active Directory Administrative Center

3. Select your domain from the list on the left hand side.

Select domain

4. Create an Organizational Unit to house your corporate users. On the right navigation pane under Task > <domain name> click on New and
then select Organizational Unit.
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Create Organizational Unit

5. Organizational unit is like a company. Enter the mandatory details and click OK.

Filling in the Organizational Unit screen

6. This will immediately create the Organizational Unit in the designated location.  Double click on your newly created Organizational Unit.

Double click on an Organizational Unit to edit it

7. On the right navigation pane, click on New, and then select User from the popup menu.
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Create user

8. Enter the mandatory details such as user&rsquo;s name.

Filling in the User screen

9. Enter the password for the user.

10. Change the Password options to Other password options. If you don't do this, you won't be able to login with this user account from Visual
Paradigm products.

Change Password Option to 'Other password options'

11. Click OK. Repeat step 7 to step 10 to create all users in Active Directory.

12. On the right navigation pane, click on New, and then select Group from the popup menu.

Create group
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13. Enter the mandatory fields such as group name.

Filling in the Group screen

14. Scroll down to the Members section. You can add users into the group in the Members section.

15. Click Add....

Adding member into a group

16. Enter the account name of the user you want to add into the group. Click OK.

Enter user's account name

17. Click OK in the Create Group screen to confirm group creation.

Step 2 - Downloading DS Connector from VP Server
DS Connector acts as a bridge between VP Server and directory server. In this section you will see how to download DS Connector from VP Server.

1. Open a web browser.

2. Visit the Teamwork Server URL and login as administrator. Note that the login ID of the default server administrator is Admin.

3. Select System Tools from the menu on the left hand side.

4. Open the tab Single Sign-On.

5. Click on Configure under the section Directory Service Connector.
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To configure directory service connector

6. Choose the operating system for the machine where Active Directory is installed.

Choosing the right operating system

7. Click Download. Keep the dialog box opened as you will need to copy the key presented in the dialog box when you configure DS Connector in
the next section.

Step 3 - Installing and configuring DS Connector
In this section you will install DS Connector, and configure it to make it connect to both VP Server and Active Directory.

1. Copy the downloaded zip file to the machine where Active Directory is installed.

2. Extract the zip file to a folder.

DS Connector (zip) extracted

3. Open an elevated command prompt.
For Windows Server 2008 users, click the Start button, type cmd, and then right-click Command Prompt and select Run as administrator
from the popup menu.
For Windows Server 2012 users, search cmd in the Apps screen, and then right-click Command Prompt and select Run as administrator at
the bottom of the screen.

Run elevated command prompt

4. Navigate to DS_Connector_12.1\service where DS_Connector_12.1 is the name of the folder extracted.

5. Type the following command to install DS Connector as service:
install_service.bat
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Installing DS Connector as system service

6. Run DS_Connector_12.1\DSConnectorUI.exe. Please run it as administrator to avoid any potential issues caused by insufficient write
permission.

7. When you run DS Connector the first time, you are prompted to configure the connection to VPository/Teamwork Server. In the Configure
Server window, click Other and then select VP Server from the popup menu.

To configure connection to VP Server

8. Enter the host name and port of VP Server.

9. Enter the key, which is the code you saw in the end of the previous section. If you have accidentally closed that dialog box, or if the key has
expired, don't worry, just click Configure again (step 5 of the previous section) to obtain another key.

Entering key for server configuration

10. Click Connect. If succeed, you should see the message Server configuration succeed.

11. DS Connector is now connected to VP Server. Now, you need to configure the connection to Active Directory. On the left hand side of the DS
Connector Console, click Add Directory Server.

To add a directory server

12. Select Active Directory as Directory Server.
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Selecting Active Directory

13. Enter a name for this configuration.

14. Enter the host name and port of the Active Directory. As we suggested you to install DS Connector on the machine where Active Directory is
installed, your host name is pretty likely to be localhost or 127.0.0.1. Regarding the port, while the default port of Active Directory is 389, you
may need to confirm it with your administrator in case it has been changed.

15. Enter Bind DN or User. You can check the required value from the Account details page of the administrator user. The value of User
SamAccountName is the value you need to enter now.

Obtaining the Bind DN or user

16. Enter the password for logging into Active Directory.

Configuring Active Directory connection

17. Click Test Connection. If succeed, you should see the message Test connection succeed.

18. Click Save in the Configure Directory Server window.

19. The newly configured directory server is listed on the left hand side of the DS Connector Console. If necessary you can add more directory
servers by repeating from step 11 until this step.



Managing groups (Active Directory) P. 125

Directory server added

Step 4 - Synchronizing users to VP Server
In this section you will add users into DS Connector Console to let it synchronize the users to VP Server. When you finished this section, the chosen
users can login Teamwork Server from Visual Paradigm, using the login details managed by Active Directory.

1. Select the directory server in DS Connector Console.

Selecting a directory server

2. On the right hand side, click Add.

3. In the Add users/group window, select the user groups to be made available on Teamwork Server. The users in selected groups will become
members of Teamwork server, and will have access to Visual Paradigm projects.

Select user groups to add to DS Connector Console

4. Click Add.

5. That's it. You can see the selected user groups listed on the right hand side of the DS Connector Console.

Users added to DS Connector Console

The user groups, along with the users will be synchronized to VP Server shortly (~1 minute). Once the synchronization has been completed, you
will see the user groups available in the Members > Groups page of VP Server, like this:
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User group synchronized to VP Server

The users are available in the Members page of the Teamwork module of VP Server. Note that the synchronization will synchronize only the
user name and login ID. It will not synchronize nor to process any password of any users in Active Directory. Whenever a user tries to login to
Teamwork Server from Visual Paradigm, Teamwork Server will communicate with Active Directory for authentication.

Users synchronized from Active Directory

So now, you assign the user groups to projects so that the users can open the project from Visual Paradigm and start working. If necessary you
can also grant them admin permissions.
To login Teamwork Server from Visual Paradigm, please enter the Email(Login ID) as shown in the image above as Email, and the password
stored in Active Directory as Password.

Login from Visual Paradigm

Union of permissions among user groups
It is legit and technically possible to have a user placed in mutliple user groups. For example, Mary is both a product manager and tester, and therefore
belong to two different user groups for the two distinct roles. Because different level of permissions can be set to different groups, Teamwork Server
takes the union of all and apply the result to the user. The following table shows you how it works. Let's say all the users in the table are members of
group X, Y and Z. The "A" permission they enjoy is a union of the "A" permission specified in group X, Y and Z.

User Permission "A" of Group "X"

(specified in AD)

Permission "A" of Group "Y"

(specified in AD)

Permission "A" of Group "Z"

(specified in AD)

Result: Permission "A" of user

(in Teamwork Server)

Peter TRUE TRUE TRUE TRUE

Mary TRUE FALSE TRUE TRUE

David FALSE FALSE FALSE FALSE

Example of the union of permissions among user groups

 

Permission overriding
While permissions can be specified for user groups, it is also possible to specify permissions for every user, no matter he/she is inside a group or not.
Permissions specified for user has a higher priority than thay specified for the user group(s) the user belong to. The following table shows you the idea.
If you want to know how to specify permission for user, please read the page Visual Paradigm Teamwork Server Active Directory Authentication.

User Permission "A" of Group "X"

(specified in AD)

Permission "A" of Group "Z"

(specified in AD)

Result: Permission "A" of user

(in Teamwork Server)

Peter TRUE TRUE TRUE

Mary TRUE FALSE TRUE

David FALSE TRUE FALSE
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Betty FALSE FALSE FALSE

Example of the permission overriding

 

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Visual Paradigm Know-How -  How to migrate Teamwork Server from Built-in Authentication to Active Directory Authentication

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
http://knowhow.visual-paradigm.com/technical-support/server-configuration/migrate-vpts-to-ad-auth/
https://www.visual-paradigm.com/support/?product=vpository
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Managing projects
A project contains model(s) that describe the target system or application. It is to be edited and completed by members of a team.

Adding project
1. Open a web browser

2. Visit and login Teamwork Server.

3. At the top right, click on your profile logo image and select Admin Repository from the drop down menu.

4. Select Projects from the menu on the left.

5. Click on New Project and select the location, which is a folder that can be created in the previous screen, by clicking New Folder.

6. Press on + next to the members or member groups to assign them to the project. Note that there must be at least one member be assigned to
the project in order to add the project.

Creating a project

7. Click on Create Project.

8. By default, the members who have been assigned to a project will have both the read and commit permissions on the project. If you want to
change their permissions, move your mouse pointer over the row of project and then click Edit.

To edit a project

9. Open the Members tab. From there you can change the permissions of members. The Read permission means that member can only open
the project in Visual Paradigm and read its content. The Read & Commit permission means that member can both open project and commit
changes to server.
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Configuring members' permissions on this project

10. Click Save at top right to save the changes.

Renaming project
Renaming of project has to be done in Visual Paradigm, the client application. Team members who have "Update Project" permission can rename a
project by take the following steps in Visual Paradigm.

1. Select Project > Properties from the toolbar.

2. In the Project Properties window, edit the project name.

3. Click OK.

4. Commit the change.

The other team members are suggested to perform an update to have their local project files renamed.

Deleting project
By deleting a project, team members will no longer be able to commit changes to server nor to open the project. Project deletion cannot be undone.
Think carefully before you delete a project.

To delete a project:

1. Select Projects from the menu on the left.

2. Move your mouse pointer over the row of the project that you want to delete, and then click Edit.

To edit a project

3. Click on [Delete Project] at top right.

Delete project

4. You are prompted to answer a math question. Enter the answer and click Delete.

Changing project members' read/commit permissions
1. Select Projects from the menu on the left.

2. Move your mouse pointer over the row of the project that you want to change its project members' read/commit permissions, then click Edit.

3. Open the Members tab. From there you can update the permissions of members. The Read permission means that member can only open
the project in Visual Paradigm and read its content. The Read & Commit permission means that member can both open project and commit
changes to server.



Managing projects P. 130

Purging a project revision
To purge a revision is to delete the revision permanently. By purging a revision, team members working on the purged revision or before will not be
able to commit nor update changes. Branches created from any purged revisions, if any, will no longer be able to merge back to the trunk. The action
cannot be undone. Think carefully before you purge a revision.

To purge a project revision:

1. Select Projects from the menu on the left.

2. Move your mouse pointer over the row of the project that you want to change its project members' read/commit permissions, then click Edit.

3. Open the Revisions tab.

4. Move your mouse pointer over the row of the revision that you want to purge, then click [Purge].  Note that purging will be performed on the
selected revision along with all the revisions before it. For example, if you have selected to purge revision 3, revisions 1 to 3 will be purged.

Purge a revision

5. You are prompted to answer a math question. Enter the answer and click Purge.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Setting working days and holidays
Tasifier takes working days and holidays into account. The date picker can indicate those non-working days and holidays as colored cells. Tasifier also
skipped those working days and holidays in the calculation of task duration. All these ensure tasks to be planned and carried out on schedule.

Date picker with non-working days painted in gray, holidays painted in red

Setting working days
1. Open a web browser

2. Visit the VP Server URL and login as administrator. Note that the login ID of the default server administrator is Admin.

3. Select System Tools from the menu on the left.

4. Under the Working Days section of the System tab, check the working day(s).

Updating working days

5. Click Save at the top right to save the change.

Setting holidays
1. Open a web browser

2. Visit the VP Server URL and login as administrator. Note that the login ID of the default server administrator is Admin.

3. Select System Tools from the menu on the left.

4. Under the Holiday Profile section of the System tab, specify the source of holiday profile. You can select one from the Pre-defined list, or
select Custom, and then download the template file, edit and upload the file back to apply your changes.

Holiday profile

5. Click Apply to save the changes.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Setting default visibility of various panes
In Visual Paradigm, there are four panes that display the content of a project. They include:

• Diagram Navigator - List and provides navigability to diagrams in project

• Model Explorer - List and provides navigability to model elements in project, as well as to present the model hierarchy of project

• Class Repository - List and provides navigability to classes and class members, as well as to present the hierarchy of classes and packages

• Logical View - Allows you to categorize diagrams logically

These panes are hidden by default, under Sleek UI theme. Some teams may want to encourage their team members in using these panes. VPository
supports setting the default visibility options of these panes. When a team member who are running Visual Paradigm tries to login to the server, he will
see the panes that are set visible in VPository become visible in Visual Paradigm.

Diagram Navigator in Visual Paradigm

Setting visibility of a pane
1. Open a web browser.

2. Visit the VP Server URL and login as administrator. Note that the login ID of the default server administrator is Admin.

3. Select System Tools from the menu on the left.

4. Under the Panes section of the System tab, set the visibility options for the panes.

Updating the visibility option for Model Explorer

5. Click Save at the top right to save the change.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Using the client update service
"Client Update" is a service that facilitates the update of client Visual Paradigm installation through the retrieval of updated files from VP Server. By
enabling this service, VP Server will downloads product updates from Visual Paradigm's remote server periodically. Team members can then connect
to the VP Server to update their software installation.

Benefits
Taking an organization in which 100 computers have been installed with Visual Paradigm as an example, you have to connect to the Internet 100 times
for getting the same update files; it leads to wasting of resources in terms of bandwidth and time. With the client update service you can save resources
by downloading the update files to a server in your LAN once and sharing the updated files to your local network clients through the local area network.
As the download process is done only once, it will not waste bandwidth and time for downloading the same files many times. On the other hand,
computers that installed Visual Paradigm can update their installation easily and quickly once the updated files are available on the server. Hence, you
can benefit from getting the update files as soon as possible by using the local area network instead of Internet and keeping the working version of your
team in sync.

How does it works?
1. Open a web browser

2. Visit the VP Server URL and login as administrator. Note that the login ID of the default server administrator is Admin.

3. Select Client Update from the menu on the left hand side.

4. Click the button Check for Update.

5. Click on the download button to download a zip of the latest update package.

Download latest installation

6. Upload the downloaded file to VP Server.

7. Click Upload. You should now see the details about the build uploaded. Team members can run VP Update and enter the path http://
<YOUR_VP_SERVER_HOST>/productupdate/vp.jsp as update URL.

Updating Visual Paradigm by retrieving update files from VP Server

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Starting and stopping server
Start server to let clients get product access it.

 

Starting server

Learn how to start server.

 

Stopping server

Learn how to stop server.
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Starting server
In order to let client products connect to the server for performing teamwork operations, the VP Server must be started and be running properly. To
start the server, simply run startup.bat (startup.sh for Linux and Mac OS X) in the scripts folder under the VP Server server program directory. By
starting VP Server, the Teamwork Server module will be started automatically.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Stopping server
When the Teamwork Server is stopped, client products can no longer perform all teamwork operations such as check out project, commit and update
changes. Therefore, stopping of server must be done carefully.

Stopping of server involves two main parts. The first part is to let VP Server check if it is safe to perform a shut down and to shut down for you if alright.
The second part is to stop the server program.

1. Open a web browser.

2. Visit the VP Server URL and login as administrator. Note that the login ID of the default server administrator is Admin.

Logging into VP Server as administrator

3. Select Tools from the menu on the left hand side.

4. Under the Miscellaneous section, click on the button Shutodnw Server.

Shutdown VP Server

5. Click Shutdown when you are prompted for confirmation. This will start the pre-shutdown procedures. It first checks if it is possible to perform a
shut down. If someone is connecting to the server for performing tasks like commiting, shutdown will be rejected. If it is safe to shutdown, it will
shutdown the server for you.

6. Run shutdown.bat (shutdown.sh for Linux and Mac OS X) in the scripts folder under the VP Server server program directory to quit the
process.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

 

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Installing Windows service
Install Teamwork Server as windows service to make it auto run when starting O/S.

 

Installing Windows service

Learn how to install Teamwork Server as service in Windows.

 

Removing service

Learn how to remove Teamwork Server service.

 

Installing Mac OS X Startup Item

Learn how to install Teamwork Server startup item in Mac.

 



Installing Windows service P. 138

Installing Windows service
By installing VP Server as a Windows service, this causes the VP Server to start when starting Windows. By starting VP Server, the Teamwork Server
module will be started automatically. In other words, you do not need to start it up manually. To install Windows service, make sure your computer has
JDK (Java Development Kit) installed. If not, download from  http://www.java.com/en/download/  and install it. After that, run install_service.bat in the
scripts folder under the VP Server program directory.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.java.com/en/download/
http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Removing service
By removing Windows service, the VP Server will no longer start when starting Windows. Therefore, you will need to start it yourself. To remove the
installed service, run remove_service.bat in the scripts folder under the VP Server program directory.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Installing Mac OS X Startup Item
In order to make Teamwork Server run when launching Mac OS X, you need to create a startup item, which cause the VP Server to be executed during
the final phase of the boot process.

To install VP Server startup item:

1. Setup the VP Server. Make sure the name of server folder was named as VPServer, which is the default name you see when extracting the
downloaded and zipped server program.

2. Go to  /Library/StartupItems. If StartupItems does not exist, create it manually.

Go to /Library/StartupItems

3. Create a folder named VPServer under /Library/StartupItems. You must have root permission in advance. To get root permission, execute
command " sudo su". After that, you have to provide root password for proceeding.

4. Create two files: VPServer and StartupParameters.plist respectively under the VPServer folder.

5. Edit VPServer and fill in the content as below. Replace  %path_to_your_server% with a correct value.

#!/bin/sh
. /etc/rc.common
# The start subroutine
StartService() {
/%path_to_your_server%/VPServer/webserver/bin/startup.sh
}
# The stop subroutine
StopService() {
/%path_to_your_server%/VPServer/webserver/bin/shutdown.sh
}
# The restart subroutine
RestartService() {
/%path_to_your_server%/VPServer/webserver/bin/shutdown.sh
/%path_to_your_server%/VPServer/webserver/bin/startup.sh
}
RunService &ldquo;$1&Prime;

6. Edit StartupParameters.plist and fill in the content as below.

<?xml version=&rdquo;1.0&Prime; encoding=&rdquo;UTF-8&Prime;?>
<!DOCTYPE plist PUBLIC &ldquo;-//Apple//DTD PLIST 1.0//EN&rdquo; &ldquo;http://www.apple.com/DTDs/PropertyList-1.0.dtd&rdquo;>
<plist version=&rdquo;1.0&Prime;>
      <dict>
            <key>Description</key>
            <string>VPServer</string>
            <key>Provides</key>
            <array>
                  <string>VPServer</string>
            </array>
      </dict>
</plist>
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7. Set permission for those files.  Set owner as root, change group as wheel and make sure there are execute permission to those files. You can
execute command chmod 755 * on those files to grant the execute permission.

8. Restart your machine to activate Mac OS X system service.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Upgrading to new version
Upgrade Teamwork Server to newer version.

 

Upgrading to new version

Learn the steps needed to upgrade Teamwork Server.
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Upgrading to new version
When Visual Paradigm has released a new version, you may want to upgrade to it. For users of Teamwork Server, do not forget to upgrade also the
VP Server. Otherwise, you will not be able to perform team operations in the upgraded client products due to compatibility issues. In this page, server
administrator will learn how to manage and execute the upgrade process of Teamwork Server.

Upgrading from VP Server 5.3 or Any Higher Version
1. Get ready for the license keys and WebApp of the latest version of Teamwork Server. You can download them from your customer account by

logging into our  Customer Service Center . To download WebApp, make sure Web Application is selected for downloading.

Download WebApp of VP Server

2. Open a Web browser. Login to the VP Server as administrator.

3. Select Server Update from the menu on the left.

4. Click Choose File and select the WebApp package you downloaded.

To select the WebApp package of VP Server

5. Once you selected the file, system will show up the build you use currently as well as the build you are going to update to. Click Yes to proceed.
* *Note that the server will be out of services for 10 to 15 seconds when upgrading.

6. Update completed message will be shown once the update is done. And now the server is back to service. This completes the upgrade process.
All the team members can resume working with the clients after upgrading.

Upgrading from VP Server 5.2 or Any Earlier Version
1. Get ready for the license keys and installers of the latest version of Teamwork Server. You can download them from your customer account by

logging into our  Customer Service Center .

2. Stop VP Server by running %VP_Server_Dir%\scripts\shutdown.bat (shutdown.sh for Linux and Mac OS X). If Teamwork Server was
installed as a Windows service (for Windows users), run %VP_Server_Dir%\scripts\remove_service.bat.

3. Zip the %VP_Server_Dir%. Rename the zip file by appending the current date to filename.

4. Having downloaded the new version of VP Server server program to the server machine, extract it to the folder where you want the new VP
Server to install to. 

5. Run the command console. Change the current directory to the scripts sub-folder of the extracted folder.

6. Run the script migrate.bat with the parameter -path by specifying the old server folder:
migrate.bat -path <old-server-dir>
(E.g.: migrate -path "C:\VPServer 8.2")

7. Answer the math question and press Enter to produce the migration package. Depending on the size of the old VP Server, this process may
take a while to complete. During the process, the existing VP Server will be stopped.

8. When finished, you should see the folder VPServerExport created under the scripts folder of the new VP Server.

9. Move the VPServerExport folder to %New_VP_Server_Dir%\webserver\webapps\ROOT\WEB-INF .

10. Start up the new server by running the scripts\startup.bat (startup.sh for Linux and Mac OS X). You may see a command console appear. Do
NOT close it or else the server will be stopped.

11. Open a Web browser. Visit the server URL (e.g. http://127.0.0.1:1999 ).

12. You should see the message that a file called vpserver.tar.gz is found. Click Next to continue. If you do not see this message, please review the
steps above and try again.

13. Follow the instructions to finish up the configuration of database and installed modules. When everything is done, you will be prompted to restart
the server. After that you can start using the new server.

https://cs.visual-paradigm.com/
https://cs.visual-paradigm.com/
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Upgrading from Teamwork Server 4.2 or Any Earlier Version
1. Get ready for the license keys and installers of the latest version of both Teamwork Server. You can download them from your customer account

by logging into our  Customer Service Center .

2. Stop the Teamwork Server by running %Teamwork_Server_Dir%\bin\ShutdownTeamworkServer.exe (.sh for Linux and Mac OS X). If
Teamwork Server was installed as a Windows service (for Windows users), please remove the service first.

3. Zip the %Teamwork_Server_Dir%. Rename the zip file by appending the current date to filename.

4. Having downloaded the new version of VP Server server program to the server machine, extract it to the folder where you want the new
Teamwork Server to install to. 

5. Run the command console. Change the current directory to the scripts sub-folder of the extracted folder.

6. Run the script migrate.bat with the parameter -path by specifying the old server folder.

Running migrate script

7. Open a Web browser. Visit the server URL (e.g. http://127.0.0.1:1999 ).

8. Once the script is running, the old server will be disabled. The repository, user accounts and license key will be exported from the old server
during the process. So for safety, enter result of summation to confirm the execution. 

9. When finish, a folder VPServerExport will be created in the scripts folder.

Caption Here

10. Move the VPServerExport folder to %SERVER_DIR%\webserver\webapps\ROOT\WEB-INF .

11. Start up the new server by running the scripts\startup.bat (startup.sh for Linux and Mac OS X). You may see a command console appear. Do
NOT close it or else the server will be stopped.

12. Open a Web browser. Login to the VP Server as administrator.

13. Enter your organization name and password. Click Next at bottom right to continue.

Enter organization name and password

14. In the Select Module page, keep Teamwork Module selected and optionally select the other module(s) you need to activate.

Select Teamwork Module

NOTE: You can select more than one module. In this user's guide only the Teamwork Module will be covered. If you want to know the details
about the other supported modules, please check from their user's guides.

https://cs.visual-paradigm.com/
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15. Click Configure Database/Module at bottom right. The Configure Database page appears.

16. There is data that VP Server needs to make persistent, such as your login name, password, server repository path, etc. All these have to
be stored in a database. You need to prepare such database and fill in the connection information in this page. First, select your database
management system from the Database drop down menu.

Database setting

NOTE: If you do not have a database available and if you just want to run Teamwork Server for evaluation, you may select Embedded DB as
database, which is a ready-to-use database management system built into the server. In other words, no additional database setup has
to be made by choosing Embedded DB. However, it is NOT recommended to use Embedded DB for production purpose as it is a bit
limited in database size.

17. Click Configure Module at bottom right. Specify the folder path of repository. Repository is where the project files will be stored. If you are
uncertain, just leave it unchanged.

Enter repository folder

18. Click the Browse button in the License Key section and import the license key of the new Teamwork Server. Click Configure Teamwork
Module at bottom right.

19. The users added and defined in old Teamwork Server is listed here. Enter their Email addresses and new passwords.

Migrate users

20. Click Finish at bottom right to complete the installation.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Client operations
Users of VP client products can connect to Teamwork Server to perform teamwork operations.

 

Checkout

Learn how to get a project from server and start wroking.

 

Commit

Learn how to commit local modifications to server.

 

Update

Learn how to get others changes from server.

 

Branching

Learn how to create a branch.

 

Tagging

Learn how to create a tag.

 

Revert modifications

Roll back local modifications.

 

Roll back past revision changes

Undo changes of previous revision(s).

 

Export revision

Export project from past revision(s).

 

Managing Teamwork Files

Add, commit teamwork files in Teamwork Files pane
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Open project from VP Teamwork Server
Checkout project is a process done by team members, for getting a project from repository to start working with. Team members can login into the
server and then checkout the project(s) to work with, provided that they have the permission to do so, as granted by administrator. After that, open to
start working on it.

1. Select Team > Login from the toolbar

2. Enter the cloud entry points, email and password to login to the VPository. If you are using Teamwork Server, click Login Teamwork Server
and then enter the host, email and password to login.

3. From now on you can open a project from server by selecting Project > Open from the application toolbar. Then, double click on a project
thumbnail to open the project.

Open project

 

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Commit
Commit refers to the process of uploading local modifications to the server. As team members make changes in a project, they can share their works
by committing those changes to the server. By committing, changes are merged from working copy to server copy. During merging, a conflict may be
caused when there is a contradiction between team members. Decision have to be made whether to keep the current modified copy (i.e. overwrite) or
to accept others' copy (i.e. revert). All conflicts have to be solved before proceeding to commit. To commit changes:

1. Select Team > Commit from the toolbar.

2. If the change you made contradicts the change made by another team member, this will result in a conflict. You must resolve all the conflicts in
order to continue. For details, read the Resolving conflicts section below. Clear the conflicts, if any, and continue.

3. The Commit window displays the changes to be committed to the server. Click  Commit to proceed.

Overview of Commit window

The Commit window

No. Name Description

1 Diagrams tab The diagram level changes to be performed when you execute commit.

2 Model Elements tab The model element level changes to be performed when you execute commit.

3 Nicknames tab The changes of nickname to be performed when you execute commit.

4 Files tab The file changes to be performed when you execute commit.

5 Changes tab All the changes to be performed when you execute commit.

6 Filter When you commit, local changes will be merged to the server copy and meanwhile, changes in server copy will
be merged to the local copy, too. The filter allows you to filter the tree on the left hand side to list the commit
changes, which are changes to perform on server copy, and/or update changes, which are changes to perform on
local copy.

7 Expand All Expand the tree nodes in the tree below.

8 Collapse All Collapse the tree nodes in the tree below.

9 Tree List out the changes to be performed when you execute commit.

10 Compare Click this button to compare local and server copy side by side.

11 Preview The preview of the element as selected in the tree on the left hand side.

12 Project name Name of current project.

13 Checkout revision The number of current checkout revision.

14 Checkout time The time for latest checkout.



Commit P. 149

15 Latest server revision The number of latest revision in the server.

16 Commit comment You can give a comment for your current commit by typing here.

17 Commit Proceed committed

18 Cancel Cancel committing and close the window.

The description of  Commit window

Committing multiple projects
Instead of commtting a single project, you can commit multiple project files at the same time, for those listed in the Teamwork Client window as
managed projects.

1. Select Team > Utilities > Open Teamwork Client... from the toolbar.

2. From the list on the left hand side, select the projects to commit.

3. Right click on the selection and select Commit... from the popup menu.

Resolving conflict
If the change you made contradicts with the change made by another team member, this will result in a conflict. For example, your colleague has
renamed a class from School to University and performed a commit, and then you rename the same class to College and perform a commit. This
produces a conflict.

When a conflict occur, you must resolve it in order to continue committing. You have to resolve conflict either by overwriting or reverting the change.
Overwrite means to adopt the server copy's change, while Revert means to adopt the local's change.

Conflicts when committing

No. Name Description

1 List of change (action) List of changes to be performed. Initially only conflicted changes are listed. You can uncheck Show conflicts
only to list all changes.

2 Preview The preview of the element as selected in the tree on the left hand side.

3 Conflicted properties The properties that cause conflicts are listed in this panel.

4 Open Specification Click on this button to open the specification of element selected in the tree on the left hand side.

5 Property name The names of conflicted properties.

6 Local change The value of property in local project copy.

7 Original value The value of property before changed. In other words, it is the value in checkout copy.

8 Server value The value of property in server project copy.
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9 Show conflicts only Check it to list only conflicted changes in the tree on the left hand side. Uncheck it to list all changes.

10 Overwrite by local Click on this button to adopt the source copy.

11 Revert to server Click on this button to adopt the target copy.

12 Preview Click this button to continue committing.

13 Cancel Cancel committing and close the window.

The description of  Commit window when have conflicts
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Update
Update is the process of refreshing your current copy by merging changes that others have made and committed previously to server. Similar to
commit, update is a process of merging differences instead of overwriting. When any of your changes contradicts the changes others have made, you
will be asked to resolve conflict. All conflicts have to be resolved before proceeding with updating. To update:

1. Select Team > Utilities > Open Teamwork Client... from the toolbar.

2. If the change you made contradicts the change made by another team member, this will result in a conflict. You must resolve all the conflicts in
order to continue. For details, read the Resolving conflicts section below. Clear the conflicts, if any, and continue.

3. The Update window displays the changes to be made upon updating. Click  Update to proceed.

Overview of Update window

The Update window

No. Name Description

1 Diagrams tab The diagram level changes to be performed when you execute update.

2 Model Elements tab The model element level changes to be performed when you execute update.

3 Nicknames tab The changes of nickname to be performed when you execute update.

4 Files tab The file changes to be performed when you execute update.

5 Changes tab All the changes to be performed when you execute update.

6 Expand All Expand the tree nodes in the tree below.

7 Collapse All Collapse the tree nodes in the tree below.

8 Tree List out the changes to be performed when you execute update.

9 Preview The preview of the element as selected in the tree on the left hand side.

10 Open Specification Click on this button to open the specification of element selected in the tree on the left hand side.

11 Property name The name of conflicted property.

12 Server update The value of property in server project copy.

13 Original value The current value of property (before updating).

14 Update Proceed updating

15 Cancel Cancel updating and close the window.

The description of  Update window
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Updating multiple projects
Instead of updating a single project, you can update multiple project files at the same time, for those listed in the Teamwork Client window as
managed projects.

1. Select Team > Utilities > Open Teamwork Client... from the toolbar.

2. From the project list on the left hand side, select the projects to update.

3. Right click on the selection and select Update... from the popup menu.

Resolving conflict
If the change you made contradicts the change made by another team member, this will result in a conflict. For example, your colleague has renamed
a class from School to University and performed a commit and then you rename the same class to College and perform an update. This produces a
conflict.

When a conflict occurs, you must resolve it in order to continue updating . You have to resolve conflict by overwriting or reverting the conflicted change.
Overwrite means to adopt the server copy's change, while Revert means to adopt the local's change.

Conflicts when updating

No. Name Description

1 List of change (action) List of changes to be performed. Initially only conflicted changes are listed. You can uncheck Show conflicts
only to list all changes.

2 Preview The preview of the element as selected in the tree on the left hand side.

3 Conflicted properties The properties that cause conflicts are listed in this panel.

4 Open Specification Click on this button to open the specification of element selected in the tree on the left hand side.

5 Property name The name of conflicted property.

6 Local change The value of property in local project copy.

7 Original value The value of property before changed. In other words, it is the value in checkout copy.

8 Server value The value of property in server project copy.

9 Show conflicts only Check it to list only conflicted changes in the tree on the left hand side. Uncheck it to list all changes.

10 Overwrite by local Click on this button to adopt the source copy.

11 Revert to server Click on this button to adopt the target copy.

12 Next Click this button to continue updating.

13 Cancel Cancel updating and close the window.

The description of  Update window when have conflicts
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Reminder of updating
When your teammates have committed their work to server, you will see a notification appear at the bottom right of Visual Paradigm window, reminding
you to perform an update to obtain the changes. By clicking Update, the latest changes will be updated from server to your project. The effect is like
performing a manual update but without the need to go through the menus/toolbars.

Update notification
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Branching
In terms of team collaboration, a trunk refers to the main stream of development.  If you create a new project, you will spend the majority of your time
making changes and committing them to the trunk of your repository.

Branch is defined as a copy of work derived from a certain point in the trunk. It sets up an extra space for users to work on and make modifications
without disturbing the trunk. As soon as the modifications in branch are done, you can merge it back to the trunk.

Creating a branch
1. Select Team  > Utilities > Branch... from the toolbar.

2. When the Create Branch window appears , enter its name in the Branch Name field for your new branch and select whether to start working on
the branch or to stay in trunk. Click OK to confirm.

The Create Branch window

The three options in the drop-down menu are Start working in branch, Checkout branch and Stay in trunk. Select Start working in branch
means you create, checkout and open a new branch and then start working on it. Select Checkout branch means you create and checkout a
new branch but just keep it in repository for working on it later on. Select Stay in trunk means you create a new branch but do not check it out
and do not show it in repository either.

NOTE: For Teamwork Server, you can create branch from a specific revision of trunk by selecting Specific
revision in the repository and entering the revision number. On the other hand, select HEAD revision in the repository
if you want to create a branch from the latest revision in trunk. Finally, click OK button to confirm.

Merging a branch
When the development activity of branch has been completed, you can optionally merge the branch back to trunk. To merge:

1. Work in trunk. Select Team > Utilities > Merge... from the toolbar.

2. When the Merge window appears, select the branch you want to merge to the working trunk. A specified revision of project can be merged both
from/to by selecting From Revision and entering the revision number of from and/or to revision. You can also click on the Show Log... button to
popup a window with revisions listed and then select the revision from the list. Click OK to continue.

The Merge window
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Tagging
Tag refers to a named version of your work at a point of time on the trunk. The best application of a tag is to create it for every major release or
milestone. Note that you cannot merge a tag to the trunk nor commit it to the server.

To create a tag:

1. Select Team > Utilities > Tag... from the toolbar.

2. In the Create Tag window, enter the name of the new tag in the Tag Name field. Click OK to confirm.

The Create Tag window

NOTE: For Teamwork Server user, check HEAD revision in the repository if you want to create a tag from the latest revision of trunk while
check Specific revision in the repository if you want to create a tag from a specific revision.
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Revert local modifications
You can undo all the non-committed modification you made in the local project copy. The operation of giving up non-committed modifications is called
Revert. To revert:

1. Select Team > Utilities >  Revert Local from the toolbar.

2. Click Yes when you are asked for confirmation.
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Roll back past revisions changes
Visual Paradigm maintains the histories of changes team members made. If changes were made by mistake, you can undo it by performing a revert on
the revision where the change was made in.

Select Team > Utilities > Open Teamwork Client... from the toolbar to open the Teamwork Client. In Teamwork Client, all your project's revisions
are shown in Project revisions under Revisions tab. Select the number of project's revisions you want to list from the drop-down menu Show. Select
the revision(s) that contain the unwanted changes and click Revert Revisions.

Revert a revision

 

A new revision will be created for the result of reverting. Therefore, you are asked to commit here. Sometimes, the undo action may cause a conflict
with a more recent revision or revisions. Just like the normal commit process, you must resolve all the conflicts in order to continue committing. You
have to resolve conflict either by overwriting or reverting the change. Overwrite means to adopt the server copy's change, while Revert means to adopt
the local's change.

Related Resources
The following resources may help you to learn more about the topic discussed in this page.

• New to Visual Paradigm? We have a lot of UML tutorials written to help you get started with Visual Paradigm

• Visual Paradigm on YouTube

• Visual Paradigm Know-How - Tips and tricks, Q&A, solutions to users' problems

• Contact us if you need any help or have any suggestion

https://www.visual-paradigm.com/tutorials/
http://www.youtube.com/VisualParadigm
https://knowhow.visual-paradigm.com/
https://www.visual-paradigm.com/support/?product=vp
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Export revision
You can export revision(s) from server to your machine for checking the project content of certain phase of development. You can export specific
revision, or all revisions.

Export the selected revision
1. Select Team > Utilities > Open Teamwork Client... from the toolbar.

2. In the Teamwork Client window, open the Revisions tab.

3. Select the revisions(s) you want to export under Project revisions. Click Export and choose Export selected revisions... from the pop-up
menu.

Export selected revision

4. In Select Directory window, select an existing folder or make a new folder for storing the selected revision(s). Click OK to proceed.

Export all revisions from repository
1. Select Team > Utilities > Open Teamwork Client... from the toolbar.

2. In the Teamwork Client window, open the Revisions tab.

3. Click Export and choose Export all revisions from repository... from the pop-up menu.

4. In Select Directory window, select an existing folder or make a new folder for storing all revisions. Click OK to proceed.

Related Resources
The following resources may help you to learn more about the topic discussed in this page.

• New to Visual Paradigm? We have a lot of UML tutorials written to help you get started with Visual Paradigm

• Visual Paradigm on YouTube

• Visual Paradigm Know-How - Tips and tricks, Q&A, solutions to users' problems

• Contact us if you need any help or have any suggestion

https://www.visual-paradigm.com/tutorials/
http://www.youtube.com/VisualParadigm
https://knowhow.visual-paradigm.com/
https://www.visual-paradigm.com/support/?product=vp
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Managing Teamwork Files
When modeling, there may be external resources you want to attach to a model which help to describe it in detail or include data that cannot be
modeled within the tool, like a text document. For example, you may want to attach a scanned image of a transaction receipt to a diagram that
describes the transaction process so that the analyst can design the new system based on the image. Or maybe an image file showing the user's
expectation of the user interface.

The reference function enables you to add file references to model elements and diagrams. You, as a user who work in a team-based environment
with VPository/Teamwork Server do not need to copy any referenced files for other team members to open. Instead, you can commit your model along
with the referenced files to the server by referencing a teamwork file. Teammates can then get the referenced files from server and open them in their
environment.

In VP, there is a folder under the workspace for storing files that are readily being committed to VPository/Teamwork Server for versioning. Those
files are called teamwork files. The file revision will follow the model, i.e. whenever you open a particular revision of work from server, the file of that
revision will be obtained and thus there is always a consistency between the file and the design.

NOTE: "Teamwork Files" is supported by VPository and Teamwork Server Corporate Edition.

Opening the Project Browser for Teamwork Files management
The Project Browser is where you can browse and manage the Teamwork Files. To open the Project Browser for the management of Teamwork
Files:

1. Select View > Project Browser from the toolbar or press Ctrl-Shift-B.

Opening Project Browser

2. Open the Files page.

Selecting the Files page

The folder structure is listed on the left hand side of the screen, while the files and sub-folders are listed on the right hand side.

Creating a folder
You can create a folder for managing files. To create a folder:

1. Select the parent folder from the folder list on the left hand side. If you want to create a folder at root level, select the project node.

Select project root node

2. Click on the New Folder button on top of the folder list.

Create a folder

3. Enter the name of the new folder and click OK to confirm.

Entering folder name

A new folder is created under the selected node.
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Teamwork folder created

Adding a teamwork file/folder
To add a teamwork file/folder is to copy an external file/folder into your project as a teamwork file (or folder).

1. Select the parent folder from the folder list on the left hand side. If you want to add the teamwork file to root level, select the project node.

Selecting the parent folder

2. Click on the Add File/Folder button on top of the folder list.

To add a teamwork file/folder

3. In the Add window, select the file or folder to add and click Open. You can select multiple files by pressing the Ctrl or Shift key. When finished,
you can see the thumbnails of the selected files and folders listed on the right hand side of the Project Browser.

Files added

Opening a file
To open a file:

1. In the folder list, navigate to the folder where the file is placed in.

2. Select the folder.

3. The thumbnail of the file you want to open is on the right hand side on the Project Browser. Double click to open it.

Opening the containing folder of file
You can open the containing folder of a teamwork file/folder so that you can access it with file explorer provided by the operating system. Right click on
the file/folder and select Show in Folder from the popup menu.

Committing teamwork files
You may make use of the commit function to commit teamwork files to VPository/Teamwork Server. When you perform a commit globally (i.e. commit
the whole project), teamwork files will get committed. If you want to perform commit on specific teamwork file/folder, right click on it and select
Commit... from the popup menu.
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Commit teamwork files to server

Removing teamwork files
To remove a teamwork file from project, select the file/folder to remove and press Delete. Alternatively, right click on the file/folder and select Delete
from the popup menu.

Revert changes
Revert is the process of discarding non-committed modifications. To revert a file/folder, right click on the file/folder and select Revert... from the popup
menu. In the Revert window, select the files to revert.

Revert changes of teamwork files

Copy, Paste and Cut
Copying, pasting and cutting of teamwork file can be done by two ways. One is by hotkey Ctrl-C, Ctrl-V and Ctrl-X. Another one is by right clicking on
the file(s) and selecting Copy, Paste and Cut from the popup menu.

Referencing a teamwork file
When you try to add a file reference to a teamwork file, you may manually navigate through the folders to locate the teamwork file to add. Or to speed
things up, Visual Paradigm allows you to create a shortcut that brings you to the folder where the teamwork files are stored. In order to have such
shortcut, you need to define a user path of project files to create a corresponding shortcut in file chooser. After that, you may add the reference easily.

1. Select Window > Application Options from the toolbar to open the Application Options window.

2. In the Application Options window, select User Path on the left hand side.

3. On the right hand side, click Add... and select Project Files Path from the popup menu.

4. Click OK at the bottom of the Application Options window to close it.

5. From now on, when you try to add file reference to model elements, you can select the shortcut Project Files Folder in file chooser to jump to
the folder where the teamwork files are listed.
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Project files folder

Copying the path of a teamwork file
Sometimes, you may want to save a new file to a teamwork folder. In order to do this, you have to know the filepath of the folder, which is what the
Copy Path feature can help. There are two kinds of path you can copy - full path and short path. Full path is what known as an absolute path. You can
save a file to a specific location by providing its full path. On the contrary, a short path is a relative path, which is relative from the project. A sample
of short path would be MyProject\files\MyTWFile.txt. Compare to full path, short path is short and machine-independent, making it a good method to
express a filepath within a team.

To copy the path of a teamwork file, right click on that file and then select Copy Path, Copy Short Path or Copy URL. The path will then be copied to
the system clipboard automatically. Here is a description of copy features:

Copy Path - The absolute path of the file

Copy Short Path - The relative path of the file, relative to the root folder that stores the teamwork file

Copy URL - The URL of file. Team members who can access the project can visit the URL directly in their web browser for accessing or downloading
the file.

The Copy menus
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Synchronizing Design Patterns
In Visual Paradigm, design pattern is a part of diagram that can be used in many different diagrams, thus form a pattern. Design pattern typically shows
the shapes and more importantly, the relationships between the shapes. You can define and reuse design pattern in your project, across projects or
share with your team members. You can define and apply design patterns on any kinds of diagram.

Once you have  defined a design pattern , you can share it with your teammates through synchronizing it to server. Note that the synchronization
of design pattern is independent from project commit/update, which means that the only way to have your design patterns available in server is by
synchronizing them to server.

To synchronize design patterns:

1. Select Team > Utilities > Open Teamwork Client... from the main menu.

2. In the Teamwork Client window, select Repository > Synchronize Design Pattern with Server from the menu.

NOTE: Only members who are permitted to configure design pattern can synchronize design patterns. Click here for details about configuring
members' permissions.

3. Confirm the changes and click OK in the Pattern Synchronization window.

https://www.visual-paradigm.com/support/documents/vpuserguide/26/36/6246_definingdesi.html
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PostMania Overview and Setup
 

What is PostMania?

PostMania allows system designers to share diagrams drawn by Visual Paradigm with others, letting the viewers view the diagrams and to give
comments.

Member and Viewer

In PostMania, people who can draw and share diagrams are called "member", while people who can view the diagrams are called "viewer". You will
learn more about their differences in this page.

 

Enabling PostMania

By enabling PostMania, members can share diagrams with others and viewers can view and comment on the design shared. This page shows you
how to enable PostMania on an existing project, or when importing a new project.
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What is PostMania?
PostMania is a tool bundled with VPository that lets you share the diagrams that you&rsquo;ve created in Visual Paradigm with others, and to collect
their feedback after they have view your diagrams. Very often, you share diagrams with your partners, clients or colleagues to let them confirm
your design or clarify design issues. They can view your diagrams on the web, without any rights to edit them. Here are some of the use cases of
PostMania:

• Business user reviews and approves business process design

• Business user reads the latest business process design for working guidelines

• Business user request changes to process plan

• Developer views the latest class diagram to gain get up-to-date system specification and design guideline

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Member and Viewer
There is an important concept that you must be clear about when using PostMania. In PostMania, the people who can draw diagrams (in Visual
Paradigm) and share them with someone else are known as "member", while the people who can only view the diagrams with PostMania are known
as "viewer". Members are usually the designers or developers, while viewers are typically the clients, stakeholders and end users. In terms of their
rights, member can edit, share and post comments on diagrams, in Visual Paradigm. Viewers can view and post comments on only diagrams shared
by members, through web browser or PostMania Android apps.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Enabling PostMania
PostMania is a project-based feature, meaning that you can have one project with PostMania enabled, and other with PostMania turned off. By
enabling PostMania, members can share diagrams with others and viewers can view and comment on the design shared. You can enable PostMania
on an existing project, or to enable it at the moment the project is imported into VPository.

To enable PostMania on an existing project:

1. Open a web browser.

2. Visit your VPository cloud entry/Teamwork Server administration page.

3. Login VPository/Teamwork Server. Make sure you have project update right.

4. Select Projects from the menu on the left hand side.

5. Move your mouse pointer over the row of the project that you want to enable PostMania, and then click Edit. Note that trunk, branch and tag are
non-related. In other words, enabling PostMania in trunk project will not enable PostMania for branches, and posts created in trunk project will
not appear in branch.

Edit project

6. Check Enable PostMania under the Project tab.

Enable PostMania

7. Click Save. Team members can access PostMania by visiting the URL on the right.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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PostMania - Member Guide
 

Sharing Diagram

To share a diagram with someone means to let him or her view the shared diagram and to allow him or her to give comments on the diagram, or
shapes in the diagram. This page shows you how to share diagram with others, in PostMania.

 

Getting Notified of New Posts

When someone, either a member or viewer, has created/replied a post in a diagram shared by you or you followed, or if you are selected to be the
person to notify during a post is created, you will be notified. This page provides you with more details.

 

Posting and Replying

If you want to say something about a diagram or its content, no matter for what purpose, can create a post in PostMania. This page shows you how to
create a post and reply a post in PostMania.

Following Post

If you want PostMania to inform you that certain post has been replied, you can follow that post. This page shows you how to follow post in PostMania.

 

Managing Shared Diagram (Viewer Based)

Know if someone has viewed a diagram that you shared and if so, when did he/she last view the diagram. We will show you how to do this in this
article.

 

Managing Diagram Viewers

Know if someone has viewed a diagram that you shared. In this article, we will show you how to do this in a shared diagram.

 

Searching a Post

When you want to read the conversation made earlier but have no idea in which diagram and shape the conversation was posted to, you can search it
out with a keyword. This article shows you how it works.
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Sharing Diagram
To share a diagram with teammate means to let him or her view the shared diagram, either through a web browser or through mobile device, and to
allow him or her to give comments on the diagram, or shapes in the diagram.

Sharing works in diagram based, meaning that when you share a diagram with someone, he/she can only view that diagram, but not the other
diagrams, unless the other diagrams have also been shared.

Sharing a diagram through invitation
To share a diagram:

1. In Visual Paradigm, open the diagram you want to share.

2. Make sure the diagram have been committed to the server. You can only share a diagram that has been committed to server before.

3. Open the action bar by clicking on the tiny button on the right hand side of the diagram, near the scrollbar, if exist.

Open the action bar

4. Open the PostMania Topic Pane button by clicking on its button in the action bar.

Opening PostMania Topic Pane

5. At the top of the PostMania Topic Pane, click Share and then select Invite Viewers... from the drop down menu.

Invite viewers

6. Enter the name and/or the Email address of the people to share with. If a person to invite is an existing viewer/member, you just need to
enter his name and pick him up from the drop down menu. If he is not currently a viewer, please enter his email address. PostMania will send
invitation Emails all people specified, to invite them to join PostMania for viewing and commenting on the diagram to be shared.
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Entered the name and email address of invitees

7. You can optionally include a message, which will be included in the email PostMania send out.

8. Click Send Invitation Email. PostMania will send the invitees invitation Emails in three minutes.

NOTE: If the invitee is an existing viewer, and has opened the notification page/view of PostMania, either in a web browser or in Android apps,
he/she will not receive the email notification.

In three minutes, invitees will receive an Email, with subject " %NAME% has shared a diagram with you" where %NAME% is the person who shared
the diagram. He/she has to:

1. Click on Accept Invitation in the Email to open the New Viewer Form in web browser.

2. Enter the password and click Accept Invitation in the form. Then, he/she will be redirected to the diagram shared.

Sharing a diagram by link
To share a diagram with someone, you can enter his name and email address and send him an invitation, which was described above. Besides,
you can give him a URL to open the sharing diagram in web browser. If he is already a viewer/member, he will be prompted to login to his VPository
account when he visit the given link. Once logged in, he can view the diagram you shared. If he is not a viewer, he will be asked to join PostMania as a
viewer to view the shared diagram.

To share a diagram by link:

1. At the top of the PostMania Topic Pane, click Share and then select Share by Link from the drop down menu.

Share diagram by link

2. In the popup window, click Generate Link.

3. Copy the link by clicking Copy to Clipboard. Now, you can ask others to visit the link to view the diagram.

Copy diagram link

Selecting the layers to share/not share
If your diagram has multiple diagram layers, you can select the layer(s) to share in PostMania, or to exclude the layers that you do not want to share.
Shared layers will be visible when the diagram is being viewed in PostMania. To select the layer to share/not share:
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1. At the top of the PostMania Topic Pane, click Share and then select Share Layers... from the drop down menu.

To select the layer to share/not share

2. In the Share Layers window, select the share layer option. Here is a description of the four options:
Follow diagram: Follow the visibility setting of layers. Layers that are currently visible are shared, whilst hidden layers will not be shared. In
other words, what you can see will be what the viewer can see in PostMania.
All layers: Both visible and hidden layers will be visible in PostMania
Specific layer only: Select the layers to share. Non selected layers and any newly created layers will be invisible when the diagram is being
viewed in PostMania.
Exclude specific layers: Select the layers to not share. Non selected layers and any newly created layers will all be visible when the diagram is
being viewed in PostMania.

Selecting a share layer option

3. Click OK. The change will now be reflected in PostMania.

Disabling a shared link
For security reasons you may want to disable a shared link once it has been visited by the authorized person. To disable a shared link:

1. At the top of the PostMania Topic Pane, click Share and then select Share by Link from the drop down menu.

2. In the popup window, click Disable. Note that by disabling the URL, new attempts to browse the diagram with that URL will be denined. Yet,
viewers who have browserd the diagram before will remain accessible to the diagram.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Getting Notified of New Posts
When a viewer has created/replied a post in a diagram shared by you, you will see a notification in the status bar, like this:

Notification received

The number indicates the number of unread notifications. The number will be decreased once you have checked a notification. To check a notification,
click on the Message icon in the status bar to open PostMania.

The left hand side of PostMania lists the notifications you received, ordered by the receive date and time, with the latest notification appears at the top
and the earliest one comes last. You can click on a notification to have an overview of that notification.

PostMania

The overview is displayed on the right hand side of PostMania. It consists of a thumbnail of diagram, and a chunk of unread conversation. Note that
the content of a notification consists of only the unread portion of the entire conversation. If you want to view the full conversation, click Open at the top
right corner of the PostMania. By opening a post, the related diagram will be opened, with the post opened in the PostMania Topic Pane, on the right
of the diagram. If the post was created around a shape, that shape will be selected.

You can also reply to a post by entering your message below the conversation and then click Post.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Posting and Replying
If you want to say something about a diagram or its content, no matter for what purpose, can create a post in PostMania. You can create a post
to report status ("I have approved."), to ask for action ("Please implement this."), ask whatever questions ("When do you need this?"), seek for
confirmation ("May I remove this from the model?"), request changes ("Fix it please"), etc.

Posting to diagram
1. Open the diagram that you want to create a post in it.

2. Click on the diagram background to make sure no shape has been selected.

3. At the bottom of the PostMania Topic Pane, click New Post.

4. You see a purple mark symbol appear on the diagram. You can add marks to different parts of the diagram for the different areas of concern. To
position a mark, simply drag it to the desired position.

Repositioning a mark

To add a new mark, drag the mark symbol at the bottom right of the diagram, and release it at the desired position.

Create a mark

5. In the PostMania Topic Pane, enter the subject of post.

6. Enter the comments of the marks.

Entering comments

You can optionally attach file reference to each of your post content. To attach file(s), click on the attachment button at the bottom of the post
box.
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To attach a file to a post

7. Specify the member to notify in the To field. Selected members will receive Email notification about your post.

Specifying the team member(s) to notify

8. Click Post. Members selected to notify and members who followed the diagram will receive Email notification about your post.

Posting to shape
1. Open the diagram that contains the desired shape.

2. Select the shape.

3. At the bottom of the PostMania Topic Pane, click New Post.

4. In the PostMania Topic Pane, enter the subject of post.

5. Enter the post content.

Entering post contents

6. Specify the member to notify in the To field. Selected members will receive Email notification about your post.
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Specifying the team member(s) to notify

7. Click Post. Members selected to notify and members who followed the diagram will receive Email notification about your post.

Posting to references of a shape
You can also post comments to references of a shape, via the References tab of the specification window.

1. Open the specification window of shape by right clicking on the shape and selecting Open Specification... from the popup menu.

2. Open the References tab.

3. Create post in the PostManic Topic Pane on the right hand side of the specification window.

Creating a post to shape's references

Posting to use case flow of events
You can also post comments to the flow of events of use case.

1. Open the flow of events editor of use case by right clicking on the use case and selecting Open Use Case Details... from the popup menu.

2. Open the Flow of Events tab.

3. Create post in the PostManic Topic Pane on the right hand side of the procedure editor. You can select the step to comment, on the left hand
side of the working procedure editor. 
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Select steps to comment

Posting to working procedure of BPMN task/sub-process
You can also post comments to working procedure of BPMN task/sub-process.

1. Open the working procedure editor by right clicking on the background of business process diagram and selecting Show Procedure Editor from
the popup menu.

2. Select the desired task/sub-process to browse its working procedure.

3. Create post in the PostManic Topic Pane on the right hand side of the procedure editor. You can select the step to comment, on the left hand
side of the working procedure editor.

Creating a post to working procedure

Replying a post
To reply a post:

1. Open the post to reply. You can open it from the PostMania Topic Pane or from the notification page.

Opening a post

2. Enter the content of reply.
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Entering reply content

3. You may specify the member to notify in the To field. Selected members will receive Email notification about your post. 

4. Click Post.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Following Post
If you want PostMania to inform you when certain post has been replied, you can follow that post. By following a post, you will receive a notification
when reply has been made to that post, like this:

Notification received

The number indicates the number of unread notifications. The number will be decreased once you have checked a notification. To check a notification,
click on the Message icon in the status bar to open PostMania.

 

To follow a post:

1. Open the post to reply. You can open it from the PostMania Topic Pane or from the notification page.

Opening a post

2. At the bottom of the PostMania Topic Pane, click Follow.

Follow diagram

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Managing Shared Diagrams (Viewer Based)
You may want to know if someone has viewed a diagram that you shared and if so, when did he/she last view the diagram. You may also want to
unshare a diagram from someone who no longer take part in the development or discussion of that diagram. All these can be achieved by managing
shared diagrams in PostMania.

Viewing the diagrams shared with a viewer
To know which diagram has been shared with a viewer, take the steps below.

1. Select Team > PostMania from the toolbar to open PostMania.

2. Click on the arrow button next to the word PostMania at the top left corner. of the screen. Select Sharing from the drop down menu.

Selecting Sharing

3. Now, you will see a list of viewers on the right hand side. Those are viewers (or members) who have been shared diagram(s). For each viewer,
the diagram(s) that he/she can view are listed in the table.

Project's Viewers list

For each diagram row listed in the table, the following information is presented:
Last visited: The date and time at which the viewer last viewed the diagram.
Shared on: The date and time at which the viewer has been shared the diagram.
Comments made by user: The number of post the viewer has made for this diagram, or any shape in this diagram.

Unshare a diagram from a viewer
If you don't want to let a viewer to view a shared diagram anymore, unshare that diagram from him/her. To unshare a diagram from a viewer:

1. Locate the viewer in the Project's Viewers List.

2. Select the row of diagram to unshare.

3. Click on the arrow button at the last column and select Unshare from the drop down menu.

Unshare a diagram from a viewer

4. Choose Yes when are are prompted for confirmation. Note that the viewer will not be able to access the diagram anymore once you've chosen
Yes. If you want to let him/her view the diagram again you need to share it again.

Managing the viewers of a diagram
You may also want to know the viewers of a particular diagram, or to unshare multiple viewers from a diagram, or to invite multiple viewers to view a
diagram. All these can be achieved by taking the steps below.

1. Find the row of diagram from any viewers listed in the Project's Viewers List.

2. Select that row.

3. Click on the arrow button at the last column and select More Details... from the drop down menu.
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Selecting More Details

Unsharing diagram from individual viewer
To unshare the diagram from a particular viewer:

1. Move your mouse pointer over that viewer.

2. Click on the tiny cross appear at the top right corner of his/her profile picture.

Unshare diagram from viewer

3. Choose Yes when you are prompted for confirmation.

Unsharing diagram from all viewers
To stop sharing the diagram with anyone, click Unshare All. Choose Yes when you are prompted for confirmation.

Invite viewers
1. Click on Invite others.

2. Enter the name and/or the Email address of the people to share with. If a person to invite is an existing viewer/member, you just need to
enter his name and pick him up from the drop down menu. If he is not currently a viewer, please enter his email address. PostMania will send
invitation Emails all people specified, to invite them to join PostMania for viewing and commenting on the diagram to be shared.

Entered the name and email address of invitees

3. You can optionally include a message, which will be included in the email PostMania send out.

4. Click Send Invitation Email. PostMania will send the invitees invitation Emails in three minutes.

NOTE: If the invitee is an existing viewer, and has opened the notification page/view of PostMania, either in a web browser or in Android apps,
he/she will not receive the email notification.

In three minutes, invitees will receive an Email, with subject " %NAME% has shared a diagram with you" where %NAME% is the person who shared
the diagram. He/she has to:

1. Click on Accept Invitation in the Email to open the New Viewer Form in web browser.

2. Enter the password and click Accept Invitation in the form. Then, he/she will be redirected to the diagram shared.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Managing Diagram Viewers
You may want to know if someone has viewed a diagram that you shared and if so, when did he/she last view the diagram. You may also want to
unshare a diagram from someone who no longer take part in the development or discussion of that diagram. All these can be achieved by managing
shared diagrams in PostMania.

Viewing the viewers of a diagram
To know the viewers of a diagram, take the steps below.

1. Open the diagram you want to check.

2. Open the action bar by clicking on the tiny button on the right hand side of the diagram, near the scrollbar, if exist.

Open the action bar

3. Open the PostMania Topic Pane button by clicking on its button in the action bar.

Opening PostMania Topic Pane

4. At the top of the PostMania Topic Pane, click Share and then select Viewer List from the drop down menu. Now, you will see a list of viewers
who can view this diagram.

Viewer list

For each viewer row listed in the table, the following information is presented:
Last visited: The date and time at which the viewer last viewed the diagram.
Shared on: The date and time at which the viewer has been shared the diagram.
Shared by: The person who shared the diagram.
Comments made by user: The number of post the viewer has made for this diagram, or any shape in this diagram.

Unshare diagram from a viewer
If you don't want to let a viewer to view a shared diagram anymore, unshare that diagram from him/her. To unshare a diagram from a viewer:

1. Locate the viewer in the Viewer List.

2. Select the row of the viewer.

3. Click on the arrow button at the last column and select Unshare from the drop down menu.
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Unshare a diagram from a viewer

4. Choose Yes when are are prompted for confirmation. Note that the viewer will not be able to access the diagram anymore once you've chosen
Yes. If you want to let him/her view the diagram again you need to share it again.

Disabling a shared link
For security reasons you may want to disable a shared link once it has been visited by the authorized person. To disable a shared link:

1. Open the Shared Links tab in the Diagram Viewers window.

2. Select the link to disable.

3. Click on the arrow button at the last column and select Unshare from the drop down menu. . Note that by disabling the URL, new attempts to
browse the diagram with that URL will be denined. Yet, viewers who have browserd the diagram before will remain accessible to the diagram.

Disable diagram link

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Searching a Post
When you want to read the conversation made earlier but have no idea in which diagram and shape the conversation was made, you can search it out
with a keyword.

Searching a post
1. At the top left of the PostMania, enter the keyword in the Search... field.

Searching for the
word 'quotation'

2. Press the Enter key to perform a search. Search results are listed in the page.

Search results

3. You can click on an entry to open it.

Opening a post from search resutls

Accessing search history
The history of your previous searches are listed on the left hand side of the search page. You can search a keyword again by clicking on it.

Search the word 'invoice' again

 

Related Resources
The following resources may help you learn more about the topic discussed in this page.
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• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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PostMania - Viewer Guide
 

Accepting Invitation

In order to view a diagram shared by a team member, viewer has to join PostMania. This page shows you how to accept an invitation sent from team
member.

Vieweing Diagram

In this page, you will see how to browse diagrams in PostMania, and then open a diagram and view it.

 

Posting and Replying

If you want to say something about a diagram or its content, no matter for what purpose, can create a post in PostMania. Team members are supposed
to read your post and take actions accordingly.

 

Searching a Post

When you want to read the conversation made earlier but have no idea in which diagram and shape the conversation was made, you can search it out
with a keyword. This article shows you how it works.
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Accepting Invitation
In order to view a diagram shared by a team member, viewer has to join PostMania. Invitation is issued by team member in the form of Email. When a
team member shares a diagram with a viewer, viewer will receive an Email, with subject %MEMBER_NAME% has shared a diagram with you.

Invitation Email

To accept invitation:

1. At the bottom of the Email, click on Accept Invitation.

Accept invitation

2. This opens the New Viewer Form in the web browser. The display name is filled for you but you may change it.

3. Enter the Password and Confirm Password.

4. You can also upload your profile avatar, which is an image that represents you in PostMania and other teamwork features.
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The New Viewer Form

5. Click Accept Invitation. You are redirected to PostMania, with the shared diagram opened. You can start viewing diagram and posting
comments.

PostMania

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Vieweing Diagram

Opening a diagram
To open and view a diagram in PostMania:

1. At the top left of the PostMania notification page, click on Sort by Topic and select Sort by Diagram from the popup menu.

To browse diagrams

2. The thumbnails of diagrams shared to you are presented on the screen. If the diagram you want to view is in another project, click on the down
arrow next to the name of the current project and then select the desired project from the popup menu.

To switch to another project

3. Click on a thumbnail to open the diagram.

To open a business process diagram

Viewing a Diagram
Once you have opened a diagram, you can view it in PostMania. Here we are going to see some of the functions that help you in viewing a diagram.
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Viewing a business process diagram in PostMania

Zooming
On the top left of screen there are several buttons you can click to zoom the viewing diagram in and out.

Icon Description

Zoom to fit - Click on it to fit the width and/or height of Web browser. Note that if you resize the browser after clicked zoomed, you need to click
again to make the diagram size follow the updated width and height of the Web browser.

Zoom out - Click on it to reduce the size of image, hence causing a larger portion of diagram content visible. This is particular useful when the
diagram being viewed is very large in size.

Actual Size - Click on it to restore the scale to 100%.

 Zoom in - Click on it to magnify the diagram.

Description of zoom functions.

Viewing Different Parts of a Diagram
Usually, diagram is so big that you cannot view everything within the viewing region. Zooming can help but may make the diagram content hard to
read. Therefore, in most cases you can view only part of the complete diagram. If you want to view the other parts of the diagram, simply press on the
diagram and drag it. You can drag to any direction you want.

Reading Description of Model Elements
Besides diagram, you can read the description of model elements, if specified.

1. Click on the shape you want to read its description. If you want to read the description of diagram, click on the background of diagram.

To read the description of a BPMN task

2. At the top of the page, click Details.

3. The description is then presented at bottom left. When you finish reading, click on the back button to go back to the diagram. You can then
select another shape to read its description.
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Description of a task

If the shape has references added, you can see the REFERENCE tab appear next to the DESCRIPTION tab. You may open the tab to review
the list of references.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Posting and Replying
If you want to say something about a diagram or its content, no matter for what purpose, can create a post in PostMania. You can create a post to
request change ("Delete this."), to ask for action ("Please implement this."), ask whatever questions ("When will this be done?"), etc.

Posting to diagram
1. Open the diagram that you want to create a post in it.

2. Click on the diagram background to make sure no shape has been selected.

Clicking on diagram

3. At the bottom right of the diagram, you can see a purple mark symbol. You can add marks to different parts of the diagram for the different areas
of concern. Drag a mark onto the appropriate part of the diagram You can refine the position of mark by dragging it.

Dragging a mark to diagram

4. If necessary, add more marks onto the diagram by repeatedly dragging and dropping the mark onto diagram.
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Multiple marks on a diagram

5. In the PostMania Topic Pane, enter the subject of post.

6. Enter the messages of the marks.

Entering messages

7. Click Post. Members who followed the diagram will receive Email notification about your post.

Posting to shape
1. Open the diagram that contains the desired shape.

2. Select the shape.

3. Click on the + buttom above the shape.

To create a comment on a shape

4. In the PostMania Topic Pane, enter the subject of post.

5. Enter the post message.

Entering post message

6. Click Post. Members who followed the diagram will receive Email notification about your post.

Posting to references of a shape
You can also post comments to references of a shape, when viewing the details of a shape.

1. Open the diagram that contains the desired shape.

2. Select the desired shape.
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Selected System shape

3. At the top right of the page, click DETAILS.

4. The description is then presented at bottom left. Open the REFERENCES tab.

Opening the REFERENCES tab

5. To say something about the references, click New Topic on the right hand side.

6. Enter the subject and message.

Creating a post to shape's references

7. Click Post. Members who followed the diagram will receive Email notification about your post.

Posting to use case flow of events
You can also post comments to the flow of events of use case.

1. Click on the desired use case in a use case diagram.

2. At the top right of the page, click DETAILS.

3. Open the FLOW OF EVENTS tab.

4. Select the steps to comment on.

Selecting some steps in Flow of Events
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5. Click New Topic on the right hand side.

6. Enter the subject and post content.

7. Click Post. Members who followed the diagram will receive Email notification about your post.

Posting to working procedure of BPMN task/sub-process
You can also post comments to working procedure of BPMN task/sub-process.

1. Click on the desired BPMN task/sub-process in a business process diagram.

2. At the top right of the page, click DETAILS.

3. Open the PROCEDURES tab.

4. Select the steps to comment on.

Selecting a step in procedures

5. Click New Topic on the right hand side.

6. Enter the subject and post content.

7. Click Post. Members who followed the diagram will receive Email notification about your post.

Replying a post
To reply a post:

1. Click to open the desired post on the right hand side of PostMania.

Opening a post

2. Enter the content of reply.
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Entering reply content

3. Click Post.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Searching a Post
When you want to read the conversation made earlier but have no idea in which diagram and shape the conversation was made, you can search it out
with a keyword.

Searching a post
1. At the top left of the PostMania notification page, enter the keyword in the Search... field.

Searching for the
word 'quotation'

2. Press the Enter key to perform a search. Search results are listed in the page.

Search results

3. You can click on an entry to open it.

Opening a post from search resutls

Accessing search history
The history of your previous searches are listed on the left hand side of the search page. You can search a keyword again by clicking on it.

Search the word 'invoice' again

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

http://www.youtube.com/VisualParadigm
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• Contact us if you need any help or have any suggestion

https://www.visual-paradigm.com/support/?product=vpository
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Introducing Tasifier
 

What is Tasifier?

Tasifier is a task management tool designed for software development teams to manage software development activities. Read this page to learn more
about Tasifier.

 

Interface overview

Tasifier is divided into three panes - Left Pane, Main Pane and Task Pane. This page details the purposes of these three panes.

 

Terminologies

You will encounter the terms listed in this page when you use Tasifier, or when you read the related user's guide pages of Tasifier. Let's check.
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What is Tasifier?
Tasifier is a task management tool designed for software development teams to manage software development activities. Like PostMania, Tasifier
is also a tool of  VPository  and  Visual Paradigm Teamwork Server . Tasifier provides a place for team members of VPository and Visual Paradigm
Teamwork Server to plan, store, manage and keep track of development activities. Tasifier is regarded as a task management solution "developed
for software development team", mainly because its capability to run inside  Visual Paradigm , a software design and development product of Visual
Paradigm. When Tasifier is run inside Visual Paradigm, team members can perform design and task management within a unified environment - the
modeling environment.

The task management software features the following:

• Task planning and assignment

• Task grouping (through Task Pool)

• Task categorizing (through tags)

• Task prioritizing

• Task monitoring

• Comment tracking

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.vpository.com/
https://www.visual-paradigm.com/product/vpts/
https://www.visual-paradigm.com/product/vp/
http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository


Interface overview P. 200

Interface overview
Tasifier is divided into three panes - Left Pane, Main Pane and Task Pane. While the Left Pane and Main Pane appear all the time, the Task Pane is
visible only when viewing the details of a task.

The three panes in Tasifier

No. Name Description

1 Left Pane Provides different ways to browse tasks in Tasifier.

2 Main
Pane

List tasks base on the selection on Left Pane.

3 Task
Pane

Task details and comments.

Description of the three Tasifier panes

Left Pane
The Left Pane provides you with different ways to browse tasks and access to some key features. You can browse tasks assigned to you (i.e. My
Tasks), check inbox, browse overdue tasks, tagged tasks, tasks in a task pool and tasks assigned to a specific member.
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The Left Pane

No. Name Description

1 Profile Photo Your profile photo and name. You can edit your profile by clicking on it, or by clicking on the arrow button next to your name
and selecting Edit Profile from the popup menu.

2 My Tasks Click on it to list out the tasks that are assigned to you.

3 Inbox Click on it to check the new or old messages Tasifier has sent you.

4 Overdue Click on it to list out the tasks that are overdue, due tomorrow, due this week or due next week.

5 Tags You can create a tag by clicking on the add button, or to list tasks by tag by clicking on TAGS and then selecting a tag to list
task.

6 Active Project The name of the active project is shown here. You can switch to another project by clicking on the project name and
selecting the project. The list of task pools and members will be updated based on your selection.

7 Task Pools A Task Pool is a logical collection of tasks. The Task Pools available in the active project are listed here. You can click on a
Task Pool to list out the tasks in the Main Pane.

8 Members The profile photo of members who are added into the project are listed here. You can click on a profile photo to see the tasks
that are assigned to that member.

Description of Left Pane

Main Pane
By selecting in Left Pane a way to browse tasks, you will see the relevant tasks listed in the Main Pane, with one row per task.

Depending on your selection made in the Left Pane, you may be allowed to create new task, sort task and filter task by clicking on the related button on
top of the task list.

Task Pane
Task Pane appears only when a task is selected in Main Pane. You can see all the details of a task in the Task Pane, including the task description,
attachments, sub-tasks, comments, followers, etc. Task Pane is also the place where you can add comments to and follow a task.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Terminologies
You will encounter the following terms when you use Tasifier, or when you read the related user's guide pages.

• Attachment
• File that you can include as part of your task, or comment. It can be a Word document, a PDF file, an image, a video, or virtually any

other type of file. An attachment can be a piece of work expected to be delivered (e.g. an image of screen design), or for detailing a task
when text content is not enough.

• Comment
• Message that can be posted to a task in response to the task submitter's initial message, or as a reply to comment(s) posted by other

members.

• Due date
• The date by which member should complete a task. For example, setting 15, August to be the due date of a task means that the task is

expected to be completed on or before 15, August 23:59:59.

• Follow
• The action to make a member become a follower of a task. Follower will receive notifications when the task is updated. Notifications are

sent as inbox messages.

• Member
• A person who can access Tasifier for its task management features.

• Overdue
• A status of task that means that the due date of the task has elapsed and the task hasn't been completed by that moment.

• Profile
• A set of member settings such as his/her photo, display name and password.

• Project
• A primary unit of work that you can break down into tasks. A project is goal oriented so it may be the system to be built (e.g. Library

management system), a feature (e.g. Mobile-phone based book searching) or a group of related resources (e.g. User Manual).

• Subtask
• A unit of work that is a breakdown of a bigger piece of work.

• Tag
• A label that helps you identify tasks. Tags are used to categorize tasks so you can find them effectively via searching.

• Task
• A unit of work that is managed by Tasifier.

• Task Pool
• A collection of similar or inter-related tasks.

 

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Account and Profile
Setting up member account

Members are people who can access Tasifier for task management. In this page, you will learn how to invite team members to VPository, and how to
add members in Visual Paradigm Teamwork Server.

 

Editing profile

Team members figure out each other by reading their names and seeing their photos in task details, comments added to tasks and in Members list.
This page shows you how to edit your profile in Tasifier.
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Setting up member account
Members are people who can access Tasifier for task management. As Tasifier is a part of  VPository  and  Visual Paradigm Teamwork Server , what
you have to do to create a member is to invite or add him/her through VPository/Teamwork Server. Then, grant project access right to the member, to
allow him or her to use Tasifier for that project.

For VPository users
1. Open a web browser

2. Visit and login your cloud entry point.

3. Click on your logo at the top right of the page and then select Manage VPository from the drop down menu.

4. Select Members from the menu on the left hand side.

5. Under the Members tab, click on Invite Member.

Invite member

6. In the Invite Teammate screen, enter the name(s) and email address(es) of your teammates and click Send Invitation. Your teammates will
receive an invitation email that invites them to join VPository. If they accept the invitation (by clicking the confirmation link in the email), they will
become the members of VPository.

Invite teammate

7. After that, you can edit the members in VPository to grant them access right to projects. Assuming that your teammates have accepted the
invitation, refresh the Members page of VPository to have them listed.

8. Move your mouse pointer over the row of member to edit and then click Edit.

Edit a member

9. You may now edit the name, email and password of the member.

https://www.vpository.com/
https://www.visual-paradigm.com/features/team-collaboration-toolset/
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10. Switch to the Permissions tab. You may adjust the various permissions granted to this member. This includes the administrator rights for
creating/updating/deleting member and/or project, and the right to perform certain action in Visual Paradigm/ArchiMetric. The following table lists
permissions you can set. Click here if you want to know more about the details of each permission setting.

11. Open the Projects tab. Click Add Project and press + on the project(s) that the member will involve. Click Close.

12. Decide whether he can read and/or commit changes made in the project. Read access enables opening the project from server and reading its
content. Commit enables uploading project changes from client to server. This step is optional and you can assign member to project in project
management page later on.

13. Click Save. The member can now manage tasks for the projects selected in step 11, provided that the projects have Tasifier enabled.

For Visual Paradigm Teamwork Server users
1. Open a web browser.

2. Visit and login VP Server.

Logging into VP Server as administrator

3. At the top right, click on your profile logo image and select Admin Repository from the drop down menu.

4. Select Members from the menu on the left hand side.

5. Under the Members tab, click on New Member.

6. Enter the name, email address and password of the member to add.

Entering member details

Option Description

Name Name of member. It is used for display purpose within the administration tool.

Email (Login ID) Email address of member. It is also the login ID member use to log into the server at client side.
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Password The password member need to log into his/her account.

Confirm Password Re-enter the password for confirmation.

Active Set if you want to reject the member from logging into the server. Very often you set it when the member is no
longer with your team and is not expected to modify the project anymore.

Options available when adding member

7. Switch to the Permissions tab. Grant him/her the administrator rights for creating/updating/deleting member and/or project. If you want to limit
the member to perform certain action in Visual Paradigm/ArchiMetric, update the settings under the Access of features, Project configuration
and Tag/Branch sections. Click here if you want to know more about the details of each permission setting.

8. Click Save at the top right of page if you've modified the permission settings.

9. Open the Projects tab. Click Add Project and press + on the project(s) that the member will involve. Click Close.

10. Decide whether he can read and/or commit changes made in the project. Read access enables opening the project from server and reading its
content. Commit enables uploading project changes from client to server. This step is optional and you can assign member to project in project
management page later on.

11. Click Save. The member can now manage tasks for the projects selected in step 9, provided that the projects have Tasifier enabled.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Editing profile
Your member profile consists of your login Email, password, display name and photo, if any. Team members figure out each other by reading their
names and seeing their photos in task details, comments added to tasks and in Members list, so be sure to provide a correct name and upload an
appropriate profile photo.

Editing basic member details
1. At the top of the left pane, you can see your profile photo, near your name. Click on it. If you haven't specified any profile photo, you will see a

box in black, with the first letter of your name shown.

Click on profile image to edit profile

2. In the Profile Setting screen, you can edit your display name, upload a profile photo by clicking Edit Profile Photo and change your password
by clicking Change Password. Note that your profile is shared with other features of  VPository  or  Teamwork Server . This means that if you
change the password here, you will need to use the new password for team collaboration, using PostMania, etc.

Profile Setting

3. Click Update Profile to save the changes.

Enabling email notification
As a team member, you might want to or need to be informed about the activities that happen under certain tasks. In Tasifier there is an Inbox to serve
this purpose. And if you want to be informed via email, you can enable the Enable email notification option in the Profile Setting screen. By enabling
the option, Tasifier will send you notification email for activities (e.g. posting reply, modified task description, etc) that happen on tasks you submitted,
followed or tasks assigned to you.

To enable email notification

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.vpository.com/
https://www.visual-paradigm.com/product/vpts/
http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Project
 

What is a project?

In Tasifier, a project is a primary unit of work that you can break down into tasks. In this page you will learn more about projects in Tasifier.

 

Creating project

In this page, you will learn how to create project in VPository and Visual Paradigm Teamwork Server, with the Tasifier option enabled.

 

Enabling Tasifier for existing project

If you want to manage the development activities for a project previously created in VPository or Visual Paradigm Teamwork Server, enable Tasifier for
that project. This page shows you how to do this.
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What is a project?
In Tasifier, a project is a primary unit of work that you can break down into tasks. A project is goal oriented so it may be the system to be built (e.g.
Library management system), a feature (e.g. Mobile-phone based book searching) or a group of related resources (e.g. User Manual).

Since Tasifier is a part of VPository and Visual Paradigm Teamwork Server, project in Tasifier is shared with other features of  VPository  and  Visual
Paradigm Teamwork Server , such as collaborative modeling and PostMania. In other words, a project in VPository and Visual Paradigm Teamwork
Server may contain the following data:

• Diagrams and model elements

• Revision histories

• Comments added via PostMania

• Tasks created via Tasifier

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.vpository.com/
https://www.visual-paradigm.com/product/vpts/
https://www.visual-paradigm.com/product/vpts/
http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Creating project
In this page, you will learn how to create project in VPository and Visual Paradigm Teamwork Server, with the Tasifier option enabled.

1. Open a web browser.

2. Visit your VPository cloud entry/Teamwork Server administration page.

3. Login VPository/Teamwork Server. Make sure you have project create and update rights.

4. Select Projects from the menu on the left hand side.

5. Click on New Project and select the location, which is a folder that can be created in the previous screen, by clicking New Folder.

6. Press on + next to the members or member groups to assign them to the project. Note that there must be at least one member be assigned to
the project in order to add the project.

Creating a project

7. Click on Create Project.

8. By default, the members who have been assigned to a project will have both the read and commit permissions on the project. If you want to
change their permissions, move your mouse pointer over the row of project and then click Edit.

To edit a project

9. Open the Members tab. From there you can change the permissions of members. The Read permission means that member can only open
the project in Visual Paradigm and read its content. The Read & Commit permission means that member can both open project and commit
changes to server. These two permissions only affect collaboration features like open project in Visual Paradigm and commit project. They have
NO effect on task management with Tasifier. In other words, all members, regardless of their Read and/or Commit rights, share the same level
of permissions when using Tasifier.
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Configuring members' permissions on this project

10. Open the Project tab.

11. Make sure Enable Tasifier is checked. If not, check it.

Tasifier enabled

12. Click Save at top right to save the changes. Team members can start using Tasifier by visiting the URL on the right.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Enabling Tasifier for existing project
If you want to manage the development activities for a project previously created in  VPository  or  Visual Paradigm Teamwork Server , enable Tasifier
for that project.

1. Open a web browser.

2. Visit your VPository cloud entry/Teamwork Server administration page.

3. Login VPository/Teamwork Server. Make sure you have project update right.

4. Select Projects from the menu on the left hand side.

5. Move your mouse pointer over the row of the project that you want to enable Tasifier, and then click Edit.

Edit project

6. Check Enable Tasifier under the Project tab.

Tasifier enabled

7. Click Save. Team members can start using Tasifier by visiting the URL on the right.

 

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.vpository.com/
https://www.visual-paradigm.com/product/vpts/
http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Task Pool
 

What is a Task Pool?

A Task Pool is simply a 'pool of tasks'. It stores a collection of similar or inter-related tasks. In this page, you will learn what a Task Pool is.

 

Creating and editing Task Pool

Task Pool can be created from the left pane of Tasifier. In this page, you will learn how to create and edit a Task Pool in Tasifier.

 

Closing Task Pool

When all the tasks in a Task Pool are completed and closed, and if there won't be any new tasks, you can close the Task Pool. This page details the
steps needed to close a Task Pool.

 

Viewing tasks in Task Pool

You can list out the tasks stored in a Task Pool by selecting the Task Pool frmo the Left Pane. This page details the steps you need to view tasks in a
Task Pool.

 

Abnormal Task Pool

Knowing that a Task Pool is a 'pool of tasks', a Task Pool without any task is not reasonable. Tasifier treats this as an abnormal case and indicate it as
a warning next to name of the Task Pool.

 

Creating and configuring Task Pools' Statuses

Aside from the three default statuses of Task Pool, you can define your own statuses. In this article you will learn how to do this.
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What is a Task Pool?
A Task Pool is simply a 'pool of tasks'. It stores a collection of similar or inter-related tasks. Here are some sample uses of Task Pool:

• Create a Task Pool "Meeting 2014-05-01" to store all the tasks related to the meeting, such as to book meeting room, contact attendances,
prepare agenda, etc.

• Create a Task Pool "Version 3.0" to store all the development activities related to version 3.0 of your product.

• Create a Task Pool "Screen Designs" to store all the tasks about creating wireframes or any kind of screen mock-up related to your system.

• Create a Task Pool "Analysis and Design" to store all the tasks that are created within the Analysis and Design phase.

One Task Pool can store unlimited number of tasks, while one task can only be stored in one Task Pool.

As a good practice, we recommend our users create Task Pool to manage their tasks, although it is allowed to create tasks without being contained by
any Task Pool.

Project and Task Pool
You can have multiple projects and each project can have multiple Task Pools. Task Pool is project-wide. If you want to have the "same" Task Pool
available in different projects, please create them individually. "Same" here means the same name. Task Pools cannot be shared among projects.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Creating and editing Task Pool
Task Pool can be created from the left pane of Tasifier. To create a Task Pool:

1. Click on the add button next to the Task Pools caption.

Create a Task Pool

2. Enter the name of the Task Pool in the Main Pane and press Enter to confirm.

Name the Task Pool

Describe the Task Pool
You can describe the goal of the Task Pool by adding a description. To add a description:

1. Click on the down arrow next to the name of the Task Pool, from the Main Pane.

2. Select Add Description from the drop-down menu.

Add a description to Task Pool

3. Enter the description. You can add a new line by pressing Enter. To confirm editing, press Ctrl-Enter, or click on the region outside the
description field.
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Enter Task Pool description

Edit Task Pool description
To edit the description of a Task Pool:

1. Open the Task Pool from the Left Pane.

2. Click on the down arrow next to the name of the Task Pool.

3. Select Edit Description from the drop-down menu.

Edit Task Pool description

4. Modify the description.

5. Press Ctrl-Enter to confirm editing.

Set a default due date for new tasks in a Task Pool
You can set a default due date for tasks to be created in a Task Pool.

To set a default due date for new tasks in a Task Pool:

1. Open the Task Pool from the Left Pane.

2. Click on the down arrow next to the name of the Task Pool.

3. Select Settings from the drop-down menu.

Edit Task Pool settings

4. Choose an option:
Unspecified - Not to apply a default due date.
Duration - If you want to give team members a specific number of days to finish a task in this Task Pool, choose this option and enter the
number of days in the text box. The due date of new tasks will be calculated based on their create date and the number of days specified here.
Date - A specific date.

The various default due date options

5. Click Update to confirm the setting.

Kick-off the Task Pool
When you create a Task Pool, the Task Pool is in the Planning state. Assignees will not see the task in their My Tasks page, nor receive any
notification about the new tasks, until the Task Pool is "kicked off".
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When you have finished planning tasks, click the Kick off button next to the name of the Task Pool. Once you have done that, assignee will see the
tasks appear on their My Tasks page. They can then begin working on the tasks.

Kick-off Task Pool

Task Pool is changed to Working state once kicked off. You can find the Task Pool from the Left Pane by selecting Working, next to the Tasks Pools
caption.

"Working" Task Pools listed under Left Pane

 

NOTE: Once a Task Pool has been kicked off, it cannot be changed back to the Planning state. Yet, you can always add new tasks to a Task
Pool kicked off.

Quick way to opening a Task Pool
If your project has many Task Pool, here is a quick way to open the Task Pool you want. Press the hot-key Shift-T. Then, choose the project from the
popup list, and then the Task Pool to open.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Closing Task Pool
When all the tasks in a Task Pool are completed and closed, and if there won't be any new tasks, you can close the Task Pool. Note that you can only
close a Task Pool when there is no task in it. Closed Task Pool cannot be re-opened. If you really want to re-open a closed Task Pool, the only thing
you can do is to create a new Task Pool with same name.

To close a Task Pool:

1. Select the Task Pool to close, from the Left Pane. Note that you need to open the right project in order to find your Task Pool. Besides, make
sure you are viewing Task Pools in Working state.

Open a Task Pool

2. On the Main Pane, click on the down arrow button next to the name of the Task Pool.

3. Select Close from the drop down menu.

Close a Task Pool

4. Select Yes when you are prompted for confirmation. Task Pool is then changed to Closed state. You can find the Task Pool from the Left Pane
by selecting Closed, next to the Task Pools caption. You can also view the details of tasks (but not to edit them).

Closed Task Pool

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Viewing tasks in Task Pool
You can list out the tasks stored in a Task Pool by selecting the Task Pool from the Left Pane. Tasks are listed row by row. The final row is empty, and
allows you to create new task in the Task Pool.

Viewing tasks in Task Pool

Sort tasks by priority
This is the default way of how tasks are sorted. When tasks are sorted by priority, they are listed by following the order they were created in the Task
Pool, or later reordered by team members.

The numbers in front of a task (row) indicate its order. Next to it your have a thumbnail of the assignee, and the subject of task.

Sort tasks by priority

Sort tasks by assignee
By sorting tasks by assignee, tasks are sorted and grouped by the name of the team members to whom they are assigned. Tasks that have no
assignee, if any, are grouped and put at the final group, named Non assigned.
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Sort tasks by assignee

Sort tasks by due date
Tasks with due date set are put at a grouped named Active, and are sorted base by their due dates. Tasks without due date set are put in a group
named No due date.

Sort tasks by due date

Filter
If you want to list only tasks that are in a specific tag, use Filter. By clicking on the Filter menu, you will see a list of defined tags. By choosing a tag, the
task lists in the Main Pane will be updated to list only tasks that are in the tag selected.

To remove a filter, click on the Filter menu again and select Show All from the drop down menu.

Search
Search enables you to quickly locate a task, or a set of tasks by entering part of the tasks' names. For example, you can enter "login" to find out all the
tasks that contains the word "login" in their subjects, such as "develop the login function", "prepare login screen design", "write login guides", etc.
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By clicking on the Search field, you can start typing the keyword of task. Press Enter to start searching. The task lists in the Main Pane will be updated
to list only tasks that have their subjects containing the keyword you entered.

Search in Task Pool

 

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Abnormal Task Pool
Knowing that a Task Pool is a 'pool of tasks', a Task Pool without any task is not reasonable. Tasifier treats this as an abnormal case and indicate it as
a warning next to name of the Task Pool, like this:

Abnormal Task Pool

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Creating and configuring Task Pools' Statuses
A Task Pool can be in one of the three statuses by default, namely Planning, Working and Closed. These statuses not only indicate the current state of
the Task Pools and the tasks within, but also add different effects to them. The following table lists the three statuses and their effects:

Status Description Effect

Planning Task Pool is not yet started. Yet, team members can start planning the tasks to be accomplished under this Task Pool. The
assignee
of
tasks
will
not
see
the
tasks
in
their
task
lists
until
the
Task
Pool
has
actually
been
started.

Working Team members are working on the tasks in the Task Pools actively. <N/
A>

Closed All tasks are cleared and no more new tasks will be created. The task pool has finished its mission and hence closed. Both
the
Task
Pool
and
the
tasks
within
are
read-
only,
which
means
that
members
cannot
add
and
remove
tasks
in
the
Task
Pool,
nor
to
edit
tasks
and
add
comments
to
them.

Description of statuses and their effect

Aside from the three statuses, you can define your own statuses. In this article you will learn how to do this.

Enabling the configuration permission of Task Pool statuses
The configuration of Task Pool is not everyone's permission. One must be granted such a permission in order to configure Task Pool statuses. To grant
such a permission to a member:

1. Open a web browser.

2. If your team uses VPository, visit and login your cloud entry point. If your team uses Teamwork Server, visit the VP Server URL and login as
administrator. Note that the login ID of the default server administrator is Admin.

3. If your team uses VPository, open the Members page. If your team uses Teamwork Server, click on Members for Teamwork Module.
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4. On the member list, select the member to grant him/her the configuration permission.

Selecting a member

5. On the right hand side, under the Edit Member page, check Task pool status.

Grant a member the permission to configure Task Pool statuses

6. Click Save.

Configuring Task Pool statuses
Team members who are granted the permission to configure statuses (read the section above for steps) can create and edit the statuses in Tasifier. To
configure status:

1. In Tasifier, move your mouse pointer over the Task Pools caption.

2. You should see the gear button. Click on it. If you do not see such a button, make sure you are granted the configuration permission.
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To configure Task Pool statuses

3. You are presented the Task Pool Status Setting window. You can now define a new status by clicking New Status, entering its name and
setting its entry condition and attributes. Entry condition is the condition required to fulfill in order for a Task Pool to enter this status. Attributes
are the effects of setting a Task Pool to be in this status. Please read the next section for details. Note that the order of statuses in the list is
important because it determines the next status a Task Pool will be in by proceeding from the current one. You can change the order of statuses
by dragging them.

Task Pool Status Setting window

4. Click Save. Note that the configuration of statuses is shared among all projects.

Effect of attributes

Attribute Description

Kicked off Tasks will appear on assignee's task list.
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Read only tasks Tasks will not be non-editable, which means that members cannot edit the description, any properties and add comments
to the tasks.

Read only task list Not allowed to add new tasks nor to delete tasks.

Description of the effects of attributes

Proceeding to the next status
To move a Task Pool to the next status, proceed it. To proceed:

1. Click on the down arrow next to the name of the Task Pool, from the Main Pane.

2. Select Proceed to "Closed" status from the drop-down menu where " Closed" is the name of the next status.

Proceed to next status

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Task
 

What is a task?

A task is a unit of work that is managed by Tasifier. You use Tasifier to plan tasks, manage tasks and keep track of the progress of tasks. This page
shows you how to do.

 

Creating and editing task

You create a task when you want someone, including you, to do something. This pages details the steps you need to take to create and edit tasks in
Tasifier.

 

Deleting task

If a task is created by mistake, or if you decide it's no longer needed, you can delete it. This page shows you how to delete task in Tasifier.

 

Searching task

When you want to locate a task with its subject, either part of or the entire subject, use the search function. This page details the steps you need to
take to search and refine search result.

 

Following task

Follow is the action to make a member become a follower of a task. Follower will receive notifications when the task is updated. Notifications are sent
as inbox messages. This page details the steps you need to take to follow and unfollow a task.

 

Adding comment

Comment is a message that can be posted to a task in response to the task submitter's initial message, or as a reply to comment(s) posted by other
members. This page details the steps you need to take to post a comment.

 

Using attachment

Attachment is a file that you can include as part of your task, or comment. It can be a Word document, a PDF file, an image, a video, or virtually any
other type of file. This page details the steps you need to take to attach file to a task in Tasifier.

 

Subtasks

A Subtask is a unit of work that is a breakdown of a bigger piece of work. You add subtask when you want to break a task into smaller parts to achieve
better management and better use of resources. This page details the steps you need to take to view and add subtasks.

 

Viewing other member's tasks

You can review the workload of teammates by opening their My Tasks page and read the tasks listed there. This page details the steps to view other
member's tasks.
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What is a task?
A task is a unit of work that is managed by Tasifier.

You use Tasifier to plan tasks, manage tasks and keep track of the progress of tasks.

Team members can comment on task, assign a task to someone and to follow tasks to receive notifications.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Creating and editing task
You create a task when you want someone, including you, to do something. In Tasifier, you can create tasks in two places - in My Tasks pane or in
Task Pool.

Creating task in My Tasks page
Usually, you create tasks in My Tasks page when you want to add a note to yourself, to remind yourself to do something.

Tasks created in My Tasks page do not belong to any Task Pool, although you can move them to a Task Pool later on.

To create task in My Tasks page:

1. Select My Tasks from the Left Pane.

Open My Tasks

2. There are three lists in the Main Pane. The To do list is for listing tasks that should be tackled within a short period of time. The New list is for
listing tasks you recently received. The Pending list is for listing tasks that will be tackled later on. Choose the list that best suit the status of the
task you want to create. Click inside the last and empty row under the list.

To create a task

3. Enter the subject of your task, which is a summary of the things you need to do, under this particular task. (You will fill in the task details later on)

Enter the subject of task

4. Press Enter to confirm. You are now on a new row and you can start entering the subject of another new task, if any. If you have finished
entering all tasks, just leave the last row empty.

Task created

5. Now, you can optionally enter the task description. If the subject is clear enough, this step can be skipped. If you want to enter the details of
task, click on a task you created. This shows the Task Pane.



Creating and editing task P. 230

Select a task to edit its task description

6. Click below the subject of task to enter the edit mode of task description.

To enter task description

7. Enter the task details. You can add a new line by pressing Enter. To confirm editing, press Ctrl-Enter, or click on the region outside the
description field.

Task description entered

8. You may optionally change the Due Date at the top right corner in the Task Pane. Due date is the date by which you should complete the task.
Click here to learn more about setting due date.

Pick up a due date
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9. Next to Due Date, you may set a team member to verify your work. When you complete the task, that member will see the task listed in his/her
My Tasks page, pending for his verification. If you do not specify a team member here, once you complete the task it will be closed immediately.

Select a team member to verify your work

Creating task in Task Pool
You create tasks in a Task Pool when the tasks are related to the goal of the Task Pool. For example, you create a task "Prepare screen design for
registration page" under the task pool "Screen Design".

To create task in a Task Pool:

1. Select the Task Pool from the Left Pane. Note that you need to open the right project in order to find your Task Pool. Besides, make sure you
are viewing Task Pools in either Planning or Working state. You cannot create task in closed Task Pools.

Select a Task Pool

2. Tasks of the Task Pool, if any, are listed in the Main Pane, row by row. Click on the last and empty row.
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To create a task

3. Enter the subject of your task, which is a summary of the things you need to do, under this particular task. (You will fill in the task details later on)

Enter the subject of task

4. Press Enter to confirm. You are now on a new row and you can start entering the subject of another new task, if any. If you have finished
entering all tasks, just leave the last row empty.

Task created

5. Now, you can optionally enter the task description. If the subject is clear enough, this step can be skipped. If you want to enter the details of
task, click on a task you created. This shows the Task Pane.

Select a task to edit its task description

6. Click below the subject of task to enter the edit mode of task description.
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To enter task description

7. Enter the task details. You can add a new line by pressing Enter. To confirm editing, press Ctrl-Enter, or click on the region outside the
description field.

Task description entered

8. Set the assignee at the top left of the Task Pane. Assignee is the team member who is responsible to perform the task. Click on the assignee
icon and select the assignee from the drop down menu. You can enter his/her name to locate him/her in quick.

Select an assignee

9. Optionally change the Due Date at the top right corner in the Task Pane. Due date is the date by which you should complete the task. Although
due date is optionally, setting a due date enables the assignee to manage their time more effectively by determining which task to do first, and
which task to do next. Click here to learn more about setting due date.

Pick up a due date

10. Next to Due Date, you may set a team member to verify the work. Although in most cases, you, as the submitter of task, is the one who verify
the completeness of the task, it's not always the case. If someone else is responsible to verify the task, set him/her to the person to verify this
task. When the assignee has completed the task, the one who responsible to verify it will see the task listed in the My Tasks page, pending for
verification. If you do not specify a team member here, once the task is completed it will be closed automatically.
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Select a team member to verify work

Quick task assignment
If you want to assign a task to another team member, choose any of the methods below.

Method 1 - Via the Task Pane
1. Open the details of the task in Task Pane. If the task is inside a Task Pool, open the Task Pool from the Left Pane and select the task from the

tasks list. You can also find from tag, based on their due status, etc.

2. At the top of the Task Pane, click on the profile photo of the current assignee.

3. Select the new assignee.

Changing the assignee of a task

Method 2 - Via drag-and-drop
This method allows you to re-assign one or mutliple tasks to another assignee. Select the task(s) to move in the Main Pane. You can press the Shift or
Ctrl key to perform a multiple selection. Then, drag the selection to the profile photo of the desired member at the bottom of the Left Pane.
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Re-assign a task to another member

Moving a task to another Task Pool
If you want to move a task from one Task Pool to another, choose any of the methods below.

Method 1 - Via the Task Pane
1. Open the details of the task in Task Pane. If the task is inside a Task Pool, open the Task Pool from the Left Pane and select the task from the

tasks list. You can also find from tag, based on their due status, etc.

2. At the top of the Task Pane, click on the arrow that appear next to the name of the Task Pool.

3. Select the Task Pool to move the task to. If you want to move the task to a Task Pool in another project, choose Change project.

Moving a task to another Task Pool

Method 2 - Via drag-and-drop
This method allows you to move one or mutliple tasks to another Task Pool. Select the task(s) to move in the Main Pane. You can press the Shift or
Ctrl key to perform a multiple selection. Then, drag the selection to the desired Task Pool on the Left Pane.
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Moving task to another Task Pool

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Duplicating task
You can use the duplicate feature to quickly create new task(s) from an existing one to save time in creating similar tasks again and again. This is
particularly useful when you need to create tasks with similar nature, or simple let multiple people perform the same task which requires the creation of
same time again and again.

Duplicate does not carry all properties. Here are the properties that will be duplicated:

• Task subject

• Task details

• Assignee

• Verify person

To duplicate a task:

1. Open the details of the task in Task Pane. If the task is inside a Task Pool, open the Task Pool from the Left Pane and select the task from the
tasks list. If the task is one of a task assigned to you, find it in the My Tasks page. You can also find from tag, based on their due status, etc.

Selected a task

2. On top of the task subject, click on the More button on the right hand side.

3. Select Duplicate this Task from the drop down menu.

Duplicating a task

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Deleting task
If a task is created by mistake, or if you decide it's no longer needed, you can delete it.

To delete a task:

1. Open the details of the task in Task Pane. If the task is inside a Task Pool, open the Task Pool from the Left Pane and select the task from the
tasks list. If the task is one of a task assigned to you, find it in the My Tasks page. You can also find from tag, based on their due status, etc.

Selected a task

2. On top of the task subject, click on the More button on the right hand side.

3. Select Delete this Task from the drop down menu.

Deleting a task

4. Click Yes to confirm deletion. Note that deletion is irreversible. Think twice before you confirm deletion.

Delete task vs close task
Delete task is different from close task.

In terms of definition, delete task means to remove a task from Tasifier due to it is wrongly created and its existence may cause problem say, assignee
may read the task and perform the task as requested, while the task is supposed to be invalid. Close task is the action to close a completed task. It is
the very end of the lifecycle of a task - from created, to performed, to completed, to closed.

Deleted task will not exist in Tasifier anymore once it has been deleted. No way can retrieve it in any way. Closed task can, for sure, be retrieved in
Task Pool, by searching, by visiting its URL, etc.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Searching task
When you want to locate a task with its subject, either part of or the entire subject, use the search function. The search function in Tasifier is context
sensitive. You can search tasks from your own tasks listed in the My Tasks page, from tasks to be due, from tasks with specific tag(s) assigned, from a
Task Pool, or from the entire project, depending on the way tasks are currently listed in the Main Pane. For example, you can search task from a Task
Pool by first selecting the Task Pool from the Left Pane, then enter the word in the task's subject in the Search box, at the top right of the page, then
press Enter.

Searching with keyword

Tasks that have their subject match with the text you entered are listed in the Main Pane. You can click on a task to read its details in Task Pane.

Search result listed

As said above, other than searching Task Pool you can search from other pages. Here are the pages that support the search function:

• My Tasks (and the My Tasks page of other members)

• Overdue/Due Tomorrow/Due This Week/Due Next Week

• Tag

• Task Pool

• Project

If you are unclear about the location of a task, try to search from the project. By selecting the project from Left Pane, all the tasks in the project are
listed in the Main Pane. Then, you can find your task by searching there.

Refining search result
If you failed to find the task you want by searching, you may want to refine the search result by adjusting the search criteria. At the top of the search
result you can configure the search criteria. The layout of search criteria may look differently when searching from different pages, but you can always
add and remove an item by moving your mouse cursor over the related criteria.

In projects
If you want to search tasks from more than one project, move your mouse pointer over the In projects section and click + at the end of the project
list. Select the project(s) to be included in the popup menu, then click Apply to re-list the tasks base on the new search criteria. You may also remove
project selection by unchecking it from the menu.
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Search projects

In Task Pool
If you want to search tasks from more than one Task Pool, move your mouse pointer over the project where the Task Pool is stored. Click the down
arrow button and select the Task Pool(s) to be included from the drop down menu, then click Apply to re-list the tasks base on the new search criteria.
You may also remove Task Pool selection by unchecking it from the menu.

Search Task Pools

Assigned to
If you want to search tasks that have been assigned to specific team member, or members, click on the down arrow button next to Assigned to. Then,
select the team member(s) to be included from the drop down menu, then click Apply to re-list the tasks base on the new search criteria.

Select members
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Tag
If you want to search tasks that have been assigned with specific tag, or tags, click on the down arrow button next to Tag. Then, select the tag(s) to be
included from the drop down menu, then click Apply to re-list the tasks base on the new search criteria.

Select tags

Within Due Days
If you want to search tasks base on their due status, click on the down arrow button next to Within Due Days. Then, select the option that best
matches your search need, and then click Apply to re-list the tasks base on the new search criteria.

Here are the available search options:

• Due within the next N days - Tasks that will become overdue in the coming N days

• Due within the last N days - Tasks that have been overdue in the previous N days. Completed tasks are also listed.

• Due within the period Date X to Date Y - Tasks that have been or will become overdue within the selected range of days.

Search by due days

Closed Task
If you want to search tasks from BOTH opened and closed tasks, click Closed Task.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Following task
Follow is the action to make a member become a follower of a task. Follower will receive notifications when the task is updated. Notifications are sent
as inbox messages.

To follow a task:

1. Open the details of the task in Task Pane. If the task is inside a Task Pool, open the Task Pool from the Left Pane and select the task from the
tasks list. You can also find from tag, based on their due status, etc.

2. Click Follow at the bottom of the Task Pane.

Follow a task

The profile photo of followers are listed next to the Follow button. Followers will be informed on comments and changes.

The Followers

Make Your Teammates Follow a Task
You can add your teammates as followers of a task. You do this when you think that they should be informed when there is an update of the task. To
add your teammate as a follower, click on the add button next to the Follow button or next to the list of followers, then select the member to add as a
follower.

Add teammate as follower

Unfollow task
To unfollow a task, just click the Follow button again in the Task Pane of the task that you want to unfollow.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Adding comment
Comment is a message that can be posted to a task in response to the task submitter's initial message, or as a reply to comment(s) posted by other
members.

Comments are posted to ask questions, to describe status or progress, or to provide information about a topic.

Adding a comment
To add a comment to a task:

1. Open the details of the task in Task Pane. If the task is inside a Task Pool, open the Task Pool from the Left Pane and select the task from the
tasks list. If the task is one of a task assigned to you, find it in the My Tasks page. You can also find from tag, based on their due status, etc.

2. Click on the comment area at the bottom of the Task Pane.

To post comment

3. Type your comment. If necessary, add supplementary file attachment to your comment by clicking Attach file next to the Post button, and
selecting the file to attach. You may attach multiple files to your comment.

Post a comment

4. Click Post to send out your comment. Followers and assignees of the task will receive a message in their inboxes.
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Comment posted

Replying a comment
To reply someone's comment, type your comment in the comment area, click on the up arrow next to the Post button, and then send out your reply by
selecting Post and Assign to %MEMBER% where %MEMBER% is the person who sent you the his comment previously. By doing so, your comment
will be be sent out and %MEMBER% will be set as the assignee of the task.

Post and assign to

Replying with attachment
You can attach file(s) when replying a comment. The file(s) can be what you are requested to deliver, or to help you explain a request, etc. To attach a
file, perform any of the following steps:

• Click on Attach file below the comment area and choose the files to attach. Note that you can select multiple files in the file chooser.

• Drag the files directly from your system to the comment area.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Using attachment
Attachment is a file that you can include as part of your task, or comment. It can be a Word document, a PDF file, an image, a video, or virtually any
other type of file. An attachment can be the a piece of work expected to be delivered (e.g. an image of screen design), or for detailing a task when text
content is not enough.

To add an attachment to a task:

1. Open the details of the task in Task Pane. If the task is inside a Task Pool, open the Task Pool from the Left Pane and select the task from the
tasks list. If the task is one of a task assigned to you, find it in the My Tasks page. You can also find from tag, based on their due status, etc.

2. On top of the task subject, click on the More button on the right hand side.

3. Select Attach from Local Drive from the drop down menu.

Upload an attachment

4. Select the file in the file chooser. From now on, team members can access the attachment in the Attachment section of this task.

Attachment uploaded

Downloading all attachments
To download attachments to your local drive:

1. Open the details of the task in Task Pane. If the task is inside a Task Pool, open the Task Pool from the Left Pane and select the task from the
tasks list. If the task is one of a task assigned to you, find it in the My Tasks page. You can also find from tag, based on their due status, etc.

2. On top of the task subject, click on the More button on the right hand side.

3. Select Download All Attachments (zip) from the drop down menu. This begins downloading and will find a zip of attachment in your download
folder when finished.
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Download attachments as zip

Deleting attachment
If an attachment was added to a task by mistake, you can delete it from the task by following the steps below.

1. Open the details of the task in Task Pane. If the task is inside a Task Pool, open the Task Pool from the Left Pane and select the task from the
tasks list. If the task is one of a task assigned to you, find it in the My Tasks page. You can also find from tag, based on their due status, etc.

2. On top of the task subject, click on the More button on the right hand side.

3. Select Delete Attachment... from the drop down menu.

Delete attachments

4. This lists the files attached to this task. Click on the delete button next to the file(s) that you want to delete.
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Delete a file

5. Choose Yes when you are prompted to confirm deletion.

6. Click Done when finish.

Viewing an attachment
To view an attachment, simply click on the filename or the preview image (for image file type). For image and video attachment, the file will be opened
in a popup browser, allowing you to view the file content directly without having to download the file to your computer. If you want to download the file,
click on the download link at the bottom of browser.

Clicking on the file link in attachment browser to download the attachment

 

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Including Teamwork File/Folder in task description/comment
When modeling, there may be external resources you want to attach to a model which help to describe it in detail or include data that cannot be
modeled within the tool, like a text document. For example, you may want to attach a scanned image of a transaction receipt to a diagram that
describes the transaction process so that the analyst can design the new system based on the image. Or maybe an image file showing the user's
expectation of the user interface.

Visual Paradigm features a project-based file repository for storing and managing these files, known as teamwork files. When creating a task in
Tasifier, or when adding a comment, you can include such a teamwork file as part of the content by adding its URL into the content.

To include a teamwork file in task description/comment:

1. In Visual Paradigm, select View > Project Browser from the toolbar to open the Project Browser or press Ctrl-Shift-B.

Opening Project Browser

2. Open the Files page.

Selecting the Files page

3. Look for the file or folder that you want to include in Tasifier. Right click on it and select Copy URL from the popup menu.

Copy URL

4. In Tasifier, paste the copied URL into task description or in a new comment.

URL pasted

5. Confirm the change in task description or post the comment. If the file is an image, you can see it directly in the task description or in the
comment posted. If the file content cannot be rendered, the file will appear as a link. You can click on it to view it in a popup browser.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

http://www.youtube.com/VisualParadigm
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• Contact us if you need any help or have any suggestion

https://www.visual-paradigm.com/support/?product=vpository
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Subtasks
A Subtask is a unit of work that is a breakdown of a bigger piece of work. You add subtask when you want to break a task into smaller parts to achieve
better management and better use of resources.

Adding a subtask
To add a subtask:

1. Open in Task Pane the details of the task that you want to create subtask from. If the task is inside a Task Pool, open the Task Pool from the
Left Pane and select the task from the tasks list. If the task is one of a task assigned to you, find it in the My Tasks page. You can also find from
tag, based on their due status, etc.

Viewing task's details

2. On top of the the subject of task, click on the Subtasks button.

To add subtasks

3. This popup the subtask list, with an empty row in it. The list is where you can view and add subtasks. Click on the empty row and enter the
subject of the subtask. (You will fill in the task details later on)

Add subtask

4. Press Enter to confirm. You are now on a new row and you can start entering the subject of another subtask, if any. If you have finished
entering all tasks, just leave the last row empty.
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Subtasks created

5. Now, you can optionally enter the task description. If the subject is clear enough, this step can be skipped. If you want to enter the details of
task, move your mouse pointer over the subtask you created and click Details> to open the Task Pane.

Edit subtask's details

6. Now, you can enter task description. You can also edit the task by tagging, setting assignee, due date, etc. Note that you can navigate back to
the parent task by clicking on the link above the task subject in Task Pane.

Subtask opened in Task Pane

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Viewing other member's tasks
You can review the workload of teammates by opening their My Tasks page and read the tasks listed there. To open a team member's My Tasks page,
click on Members at the bottom of the Left Pane. Then, click on his/her profile photo.

Open another team member's My Tasks page

You will then see his/her My Tasks page in the Main Pane.

You can also create task directly in his/her My Tasks page, or prioritize his/her tasks via drag-and-drop. Here is a situation where this is especially
useful. Suppose you have invited several team members to come to your seat to have a short discussion. When the discussion is about to end, you
want to plan tasks for each member. By navigating to individual member's My Tasks page, you can easily plan tasks for them and prioritize their
workload.

Another team member's My Tasks page

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Breaking down a task into stages
Software development is a team work. In most cases, a piece of work is done not by a single person but by a number of team members who possess
different skills such as graphics design, system analysis, project management, programming, testing, database administration, etc. In Tasifier, when
you want to manage a development activity that involves the participation of multiple team members, you can create a task with multiple 'stages'.

A stage is a turn of work within a task. Each stage represents a unique piece of work to be done by a specific team member. When all stages are
completed, the task is done. Let's say for example you want to create a task for supporting a system login function, you might create a task with three
stages: (1) Design login page, (2) Implement login page, (3) Test login page. Of course this is just an example. In practice, any stage can be created
as an independent task. It's all about your team's preferences. Usually, if a piece of work is complex, or will involve a lot of communications, it will be
created as an independent task, instead of a stage. A stage is, usually a relatively smaller piece of work.

Creating task with stages
To create task that has multiple stages:

1. Create a task and give it a subject first. Here we assume that you are clear about how to create tasks (including subtasks). If not, click here for
details about task creation or click here for details about subtasks.

2. If you decided to finish this task with multiple stages, it's time to enter the description of the first stage, which is likely the requirements of the first
stage or information that assists a team member to execute the work. Click below the subject of task to enter the edit mode of description.

To enter stage description

3. Enter the description. Note that you are entering the description of the first stage, not the description of the entire task. Tasks with stages do
not have their own description. You will learn how to add stages in coming steps. Once a stage is added, the description you entered now will
become the description of the first stage.

Stage description entered

4. Set the assignee at the top left of the Task Pane. Again, the assignee set here is the assignee of the first stage, not the assignee of the entire
task.

Setting assignee

5. You may optionally change the Due Date at the top right corner in the Task Pane. Similar to stage description and assignee, the due date set
here is the due date of the first stage, not the due date of the entire task.
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Pick up a due date

6. Next to Due Date, you may set a team member to verify the whole task when all stages are completed . When all stages are completed, that
member will see the task listed in his/her My Tasks page, pending for his verification. If you do not specify a team member here, once you
complete the task it will be closed immediately.

Select a team member to verify the task

7. On top of the task subject, click on the More button on the right hand side.

Clicking on the More button

8. Select New Stage from the drop down menu.

9. Now, you can enter and set the description, subject, assignee and due date of the second stage. Assignee can be set by clicking on the empty
box next to the subject of stage.
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Editing stage description

10. To create the next stage, click on Stage View on the right hand side of the stage subject.

Opening Stage View

11. Click on the + button in the box of Next Stage.

Creating a stage

12. You can then edit the details of the stage.

Editing stage

13. Repeatedly create all stages. When finished, click Back.
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Back to the task

The task will be assigned to the assignee set to the first stage. He/she can start working on the first stage.

Stages created

Effect of completing a stage
When you have finished your work required in a stage, click on the Complete Stage button at the bottom right of the Task Pane. This will activate the
next stage, and the stage you just completed will become inactive. The task will be assigned to the team member set to the assignee of the next stage.
He/she can start working on it.

Completing a stage

The completion of all stages will trigger the completion of the entire task. Same as a general task being marked completed, the team member who was
set to verify the task will see the task listed in his/her My Tasks page, pending for his verification.

Browsing stages
You may want to view the details of one of stages of a task. If that's not the active stage, you can browse for it by taking the steps below.

1. Open the task.

2. Click on the Stage View button at the top of the task. Note that this button only appear when the task contain stages.

Opening Stage View

3. Click Previous Stage or Next Stages to navigate to the task you want to view.
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Navigating to the previous stage

4. Click on the stage to open it.

Viewing previous stage's details

Restarting a stage
If a completed stage was not perfectly done and a rework is needed, you can restart it to let the assignee of that stage work again on that stage. To
restart a completed stage, browse for it first (read the previous seciton for steps). Then, click on the More button and select Restart Stage from the
drop-down menu.

Restarting a stage

Re-ordering stages
You can also re-order stages in case their placesment are wrong. To move a stage, browse for it first (read the previous seciton for steps). Then, click
on the More button and select Move Before/Move After from the drop-down menu.
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Moving a stage

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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My Tasks
 

What is My Tasks?

My Tasks is the page where you can find all the tasks that are currently assigned to you. This page details the usage of My Tasks page in Tasifier.

Prioritizing My Tasks

To focus on a small and manageable amount of related works at a given time and devote to them with more attention will help save your time without
sacrificing the quality of work. This page details the steps you need to take to prioritize your own tasks, in the My Tasks page of Tasifier.
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What is My Tasks?
My Tasks is the page where you can find all the tasks that are currently assigned to you. You can open My Tasks page from the Left Pane.

My Tasks

We recommend users check the My Tasks page every morning, review the active tasks and plan the tasks to be performed within the day. Three lists
are set up for the categorizing of tasks, base on their status. The lists are namely To do, New and Pending. The To do list is for listing tasks that
should be tackled within a short period of time. The New list is for listing tasks you recently received. The Pending list is for listing tasks that will be
tackled later on.

Besides viewing tasks, the My Tasks page also serves the purpose of creating tasks for yourself. Usually, you create tasks in My Tasks page when you
want to add a note to yourself, to remind yourself to do something. You are the sole responsible person for the task, not anyone else. Note that tasks
created in My Tasks page do not belong to any Task Pool, although you can move them to a Task Pool later on.

Because the task list is automatically updated, some users like keeping My Tasks page opened throughout the day so that they can see the tasks
assigned to them lately.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Prioritizing My Tasks
Tasks are streaming in endlessly, but your time is limited. To focus on a small and manageable amount of related works at a given time and devote to
them with more attention will help save your time without sacrificing the quality of work. In Tasifier, tasks that have been assigned to you are by priority
listed in the To do, New and Pending lists of the My Tasks page. Tasks that have been assigned to you lately are automatically put under the New list.
By evaluating your own schedule and the complexity of task, you can move the task to the Pending list for future processing, or to the To do list if you
managed to tackle it soon. With this good practice, both the tasks and your time are well-managed.

We recommend users review the tasks you have every morning, prioritize them and follow the prioritized task list to work throughout the day. In
Tasifier, prioritizing of tasks can be done easily by drag-and-drop, or via the popup menu.

Prioritizing one task
To prioritize a task in My Task page:

1. Move your mouse pointer to the task that you want to prioritize.

Move mouse pointer over a task

2. Press on it and hold your mouse button.

Drag task

3. Drag it to the desired list.

Dragging a task to another list
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4. Release your mouse button to move the task to the place and position desired. You should see a pink line that indicates the position of task that
will appear upon releasing mouse button.

Task re-ordered

Prioritizing task using the drop down menu
Instead of using drag-and-drop, you can prioritize a task via the drop down menu. To do so, click on the down arrow button in front of the desired task.
Then, select Move to To do to Move to Pending to move it instantly to the desired list,

Move a task from New to To do

Prioritizing mutliple tasks
To prioritize multiple tasks:

1. Click on a task row.

2. Press and hold the Shift or Ctrl key.

3. Click on another task to perform a multiple selection. If you are pressing the Shift key, tasks within the first and second selected tasks are
selected. If you are pressing the Ctrl key, only the first and second task are selected.

4. Press on your selection and hold your mouse button.
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Tasks selected

5. Drag it to the desired list.

Dragging tasks to another list

6. Release your mouse button to move the task to the place and position desired. You should see a pink line that indicates the position of task that
will appear upon releasing mouse button.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Inbox
 

What is inbox?

Inbox is the place where you can access all the notifications. You can open the inbox from the Left Pane. In this page, you will see the situations when
you will receive a notification in inbox.

 

Working with inbox

When you see a number appear next to Inbox, in Left Pane, this means that you have unread notifications. This page shows you how to work with the
inbox.
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What is inbox?
Inbox is the place where you can access all the notifications. You can open the inbox from the Left Pane.

You receive a notification when:

• Someone has posted a comment to a task when you are the assignee of that task, and the task is not complete yet.

• Someone has posted a comment to a task when you are the verifier of that task, and the task is marked complete.

• Someone has posted a comment to a task when you are the follower of that task.

• Someone has modified a task when you are the assignee of that task, and the task is not complete yet. Modifications include changing the
subject, task and due date of task.

• Someone has modified a task when you are the verifier of that task, and the task is marked complete. Modifications include changing the
subject, task and due date of task.

• Someone has modified a task when you are a follower of that task. Modifications include changing the subject, task and due date of task, as well
as to mark the task complete.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Working with inbox
When you see a number appear next to Inbox, in Left Pane, this means that you have unread notifications. The number stands for the number of
unread notifications. It will dismiss when all notifications are read.

Notification received

To read a notification, click Inbox from the Left Pane.

The unread notification(s) will all be listed in the Main pane. Read through them and take appropriate actions. You can read the task's details by
clicking on its subject. You can follow the task. Finally, click Mark as Read to tell Tasifier that you have read the notification. If you want to mark all the
unread notification as read, click Mark All as Read at the top of the inbox.

Inbox opened

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Due date and overdue
 

What is due and overdue?

All tasks have a deadline. In Tasifier, task submitter can set a deadline to a task by setting its due date. This page talks about due and overdue in
detail.

 

Editing due date of task

Tasifier enables you to set due date to task, define repeated task and add reminder. This page details all the steps required.

 

Viewing soon-to-due tasks

You can list out the tasks that are assigned to you, and are currently overdue or will become overdue after certain period of time. This pages shows
you the steps in detail.
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What is due and overdue?
All tasks have a deadline. In Tasifier, task submitter can set a deadline to a task by setting its due date. Assignees are expected to complete the task
on or before the deadline.

Due date is the date by which member should complete a task. For example, setting 15, August to be the due date of a task means that the task is
expected to be completed on or before 15, August 23:59:59.

Overdue is a status of task that means that the due date of the task has elapsed and the task hasn't been completed by that moment.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Editing due date of task
You can set edit due date of task in the Task Pane. To edit due date for a task:

1. Open the task in Task Pane. If the task is inside a Task Pool, open the Task Pool from the Left Pane and select the task from the tasks list. If the
task is one of a task assigned to you, find it in the My Tasks page. You can also find from tag, based on their due status, etc.

Selected a task

2. If the task has no due date specified, click Due Date at the top right, next to the profile photo of the verifier. If the task already has a due date
specified and you want to change it, click directly on the due date.

To edit due date

3. This shows the due date selection pane. Click on the Due Date field or the calendar button next to the field.

4. Select the due date from the calendar.

Selecting the due date from calendar

Alternatively, you can specify the due date by adjusting the duration. This is particularly useful when you have an approximation about the
number of days required to complete the task. For example, if you think that a feature can be implemented in 4 days, specify 4 to be the duration
of the implementation task. The due date will then be calculated automatically.
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Adjust duration

Repeated task
Your team may have tasks that need to be performed on regular basis. Here are some examples:

• Produce a beta release daily.

• Pay the monthly salary on the 25th of every month.

• Meet with the stakeholders every three days after the previous meeting.

In Tasifier, you can set a task to be "repeated" so that a new task will automatically be created based that task, on a specified interval. For example,
setting a task "Task X" to "repeat daily" will result in having a new task created one day after "Task X" is completed.

To set repeated task:

1. Open the task in Task Pane. If the task is inside a Task Pool, open the Task Pool from the Left Pane and select the task from the tasks list. If the
task is one of a task assigned to you, find it in the My Tasks page. You can also find from tag, based on their due status, etc.

Selected a task

2. If the task has no due date specified, click Due Date at the top right, next to the profile photo of the verifier. If the task already has a due date
specified and you want to change it, click directly on the due date.

To edit due date

3. Click on the drop down menu next to Repeat, and select the appropriate option. If you select Daily, a new task will be automatically created one
day after the completion of this task, with details of task will be copied from this task.
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Select the Repeat option

Here is a description of options available.

Option Description

None No new tasks will be created based on this task. You can set None to cancel the effect of Repeat.

Daily A new task will be created based on this task, one day after the completion of this task.

Weekly A new task will be created based on this task, on a specific day (Sun - Sat) within a week, after the completion of this
task.

Monthly A new task will be created based on this task, on a specific day within a month, after the completion of this task.

Yearly A new task will be created based on this task, on a specific date within a year.

Periodically A new task will be created after a specific number of days since the completion of this task.

Repeat options

4. Click on the drop down menu next to Repeat, and select the appropriate option.

Reminding me of due date
Tasifier allows you to lists out the tasks that will be overdue in a certain period of time. This is a useful feature but it requires yourself to manually
review the tasks. If you want Tasifier to notify you when a task is about to overdue, you can use the remind feature. Remind works like an alarm. By
setting a reminder, you will receive an inbox notification when a task is about overdue.

To add a reminder:

1. Open the task in Task Pane. If the task is inside a Task Pool, open the Task Pool from the Left Pane and select the task from the tasks list. If the
task is one of a task assigned to you, find it in the My Tasks page. You can also find from tag, based on their due status, etc.

Selected a task

2. Move your mouse pointer to the due date at the top right of the Task Pane.



Editing due date of task P. 272

To edit due date

3. Click on the alarm clock.

Click on the alarm clock

4. Set the time you want to receive the notification message. If you want to receive a notification one week before the due date, set 7. When finish,
the task will be moved to the Pending list in your My Tasks page.

Editing the reminder

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Viewing soon-to-due tasks
You can list out the tasks that are assigned to you, and are currently overdue or will become overdue after certain period of time, by walking through
the steps below:

1. From the Left Pane, click on Overdue, then select the due option. If you want to know the incomplete tasks that have already past the deadline,
select Overdue. If you want to know the incomplete tasks that will become overdue tomorrow, select Due Tomorrow.

View tasks that will due next week

2. Tasks are listed in the Main Pane row by row. If you've selected to view the tasks Due This Week or Due Next Week, tasks are grouped by
days.

Tasks that will become overdue next week

If you've selected Due Tomorrow, Due This Week or Due Next Week, you will see an empty line in each day group. The empty line allows you
to create new tasks that have the chosen date set to be the tasks' due date.

Creating a new task that will become overdue on 13, Thursday
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Filter
If you want to list only tasks that are in a specific tag, use Filter. By clicking on the Filter menu, you will see a list of defined tags. By choosing a tag, the
task lists in the Main Pane will be updated to list only tasks that are in the tag selected.

To remove a filter, click on the Filter menu again and select Show All from the drop down menu.

Search
Search enables you to quickly locate a task, or a set of tasks by entering part of the tasks' names. For example, you can enter "login" to find out all the
tasks that contains the word "login" in their subjects, such as "develop the login function", "prepare login screen design", "write login guides", etc.

By clicking on the Search field, you can start typing the keyword of task. Press Enter to start searching. The task lists in the Main Pane will be updated
to list only tasks that have their subjects containing the keyword you entered.

Search from tasks that will become overdue next week

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Tag
 

What is tag?

A tag is a label that helps you identify tasks. Tags are used to categorize tasks so you can view them easier and find them effectively via searching.
This page tells you what a tag is and provides some typical usage of tags.

Creating tag

Tags can be created both independent from a task or from a task. This page explains how to create tag from Left Pane and from a task.

 

Adding tag to task

Add tag to a task to indicate that the task belong to a category, as represented by the tag. This page details the steps involved in adding tag to task.

Viewing tagged tasks

You can list out the tasks that have a specific tag by selecting the tag from the Left Pane. This page details the various way of listing tasks that have a
tag added.
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What is tag?
A tag is a label that helps you identify tasks. Tags are used to categorize tasks so you can view them easier and find them effectively via searching.

Here are some typical usage of tags:

• Categorize tasks by their urgency - critical, important, not important

• Categorize tasks by their source - internal, from user

• Categorize tasks by their state - pending, approved

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Creating tag
Tags can be created both independent from a task or from a task. When you create a tag independent from task, you create it from the Left Pane.
When you create a tag from task, you create it from Task Pane.

Creating tag from Left Pane
To create a tag readily available to be used by tasks:

1. Click on the add button next to the TAGS caption.

Create a tag

2. Enter the name of the tag in the Main Pane and press Enter to confirm.

Naming a tag

3. Give the tag a color to make it more visually unique. Colored tags will appear in Task Pane when viewing a task. Giving an appropriate color to a
tag will help team members realize the nature or state of the task easier. Click on the down arrow next to the tag name to popup the Tag Color
pane.

To change the color of a tag

4. Select a color.

Select a tag color
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Creating tag from task
Tag can also be created when needed, that is, at the moment you edit a task. Creating a tag from a task will both create that tag and add the tag to the
task.

To create tag from task:

1. Open the Task Pane of a task.

2. In between the task description and the comment logs there are few menus. Click on the button with the tag icon on it.

To edit the tag selection of a task

3. This shows a drop down menu for tag selection. Enter the name of the tag in the text field.

4. Click <Create new> or press Enter.

Create a tag

Tag is created and is added to the task. You can view the tag under the task name.
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Tag is created and added to task

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Adding tag to task
Add tag to a task to indicate that the task belong to a category, as represented by the tag.

To add a tag to a task:

1. Open the Task Pane of the task to edit.

2. In between the task description and the comment logs there are few menus. Click on the button with the tag icon on it.

To edit the tag selection of a task

3. This shows a drop down menu for tag selection. Click inside the check-box(es) of the tags to add to the task. If necessary, you can add multiple
tags to the task.

Selecting the tag to add to the task

4. Click Apply. Tag is added to the task and you can view it under the task name.
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Tag is added to task

Adding tag to multiple tasks
Instead of adding tag to tasks one by one, you can also assign tags to multiple tasks at once.

To add a tag to multiple tasks:

1. Select the tasks to add tag. You can perform multi-selection by pressing the Ctrl key.

Select tasks

2. Drag the selected tasks to the target tag on the Left Pane.

Drag tasks to tag

3. Release the mouse button. The tag is now added to the chosen tasks.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Viewing tagged tasks
You can list out the tasks that have a specific tag by selecting the tag from the Left Pane.

Viewing tasks that have tag Critical added

Sort tasks by assignee
By sorting tasks by assignee, tasks are sorted and grouped by the name of the team members to whom they are assigned. Tasks that have no
assignee, if any, are grouped and put at the final group, named Non assigned.

Sort tasks by assignee

Sort tasks by due date
Tasks with due date set are put at a grouped named Active, and are sorted base by their due dates. Tasks without due date set are put in a group
named No due date.
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Sort tasks by due date

Filter
If you want to list only tasks that are in a specific tag, use Filter. By clicking on the Filter menu, you will see a list of defined tags. By choosing a tag, the
task lists in the Main Pane will be updated to list only tasks that are in the tag selected.

To remove a filter, click on the Filter menu again and select Show All from the drop down menu.

Search
Search enables you to quickly locate a task, or a set of tasks by entering part of the tasks' names. For example, you can enter "login" to find out all the
tasks that contains the word "login" in their subjects, such as "develop the login function", "prepare login screen design", "write login guides", etc.

By clicking on the Search field, you can start typing the keyword of task. Press Enter to start searching. The task lists in the Main Pane will be updated
to list only tasks that have their subjects containing the keyword you entered.

Search tasks
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Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Tools of Visual Paradigm Tasifier
 

Reporting support

Measure the workload and capability of your team by producing a report that lists out the not-yet-performed, executing and completed task(s) of each
team member.
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Reporting support
Measure the workload and capability of your team by producing a report that lists out the not-yet-performed, executing and completed task(s) of each
team member. With this report, you can distribute new task(s) or re-assign task(s) to them based on their individual workload and capability, making the
team more efficient and productive.

To produce a report:

1. Click on the project from the Left Pane.

Click on a project

2. In the Main Pane, click on the down arrow next to the project name. Then, select Report from the popup menu.

Select Report

3. Enter the criteria and click Generate. Here is a description of criteria:

Field Description

Day range The range of date to report.

Scope The project and Task Pool to include in reporting.

Member involved The member to inpsect workload.

Data The type of data interested.
New - Tasks newly assigned to the chosen member within the selected day range.
Processed - Tasks ever replied by the chosen member within the selected day range.
Completed - Tasks completed by the chosen member within the selected day range.
Closed - Tasks closed by the chosen member within the selected day range.
Outstanding - Overdue tasks that are remain opened within the selected day range.

Description of properties in reporting

4. The Report page is opened with tasks categorized. You can click on a task to open it and read its detail. If you are interested in the statistic
instead of the actual tasks involved, when you generate a report, choose Generate (Statistic) instead.

Related Resources
The following resources may help you learn more about the topic discussed in this page.
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• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Tasifier in Visual Paradigm
 

Using Tasifier in Visual Paradigm

Besides accessing Tasifier via a web browser, you can also access Tasifier from within Visual Paradigm, the modeling environment. This page details
the steps you need to take to open Tasifier in Visual Paradigm.

 

Use Case and Task Pool

When Tasifier is run inside Visual Paradigm, you can plan development tasks base on a use case and monitor the progress of supporting the use case.
This page shows you how.

 

Attaching diagram when adding comment

When Tasifier is run inside Visual Paradigm, you can attach diagrams when you post a comment. This page shows you how it works.
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Using Tasifier in Visual Paradigm
Tasifier is a task management tool made for software development team.

Besides accessing Tasifier via a web browser, you can also access Tasifier from within Visual Paradigm, the modeling environment. The seamless
integration between Visual Paradigm and Tasifier allows software developers to manage software development activities as well as the design works
within a single, unified environment - the visual modeling environment.

Tasifier running in Visual Paradigm

Opening Tasifier in Visual Paradigm
To open Tasifier in Visual Paradigm, select Team > Tasifier from the toolbar. Tasifier will then be opened as a new tab within Visual Paradigm. If you
find the Tasifier menu disabled, or failed to have Tasifier opened properly, check the points below:

• You have an active connection with either the  VPository  or the corporate edition of  Visual Paradigm Teamwork Server .

• You are working in a project that has Tasifier enabled. If not, click here to learn how to enable Tasifier.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.vpository.com/
https://www.visual-paradigm.com/product/vpts/
http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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User Story and Task Pool
Tasifier is a  task management tool  provided for free under VPository.com. In Tasifier, development activities are planned as tasks, and these tasks
are put under a smartly built container, called Task Pool.

When Tasifier is run inside  Visual Paradigm , you can take advantage of the mapping between  user story  and Task Pool, to plan development tasks
base on a user story and monitor the progress of supporting the user story. Developers can always trace the source of a task, which is the user story,
ensuring that the design, the implementation and testing are all conducted with user's needs in mind. Project manager won't miss any task because the
user stories are seamlessly integrated with the development tasks. The result is a software that is both functional and user friendly.

Creating a Task Pool from a user story
To create task pool from user story:

1. In UeXceler, double click to open the user story where you want to manage its development activities.

Open user story

2. Open the Tasks tab.

3. Click on the button Create New Task Pool.

Create task pool

4. In the popup window, enter a name for the Task Pool. If you want to re-use the name of the user story as the name of the Task Pool, just leave it
as-is. You can optionally enter the description of Task Pool, too. We suggest to use a short name here to make it easier to identify the task pool
in Tasifier.

Confirming the creating of Task Pool

5. Click Create. This creates a Task Pool in Tasifier. Newly created Task Pool is in Planning state and you can start planning and creating task
in the Task Pool. Assignees will not see the task in their My Tasks page, nor receive any notification about the new tasks, until the Task Pool
is "kicked off". When you have finished planning tasks, click the Kick off button next to the name of the Task Pool. Once you have done that,
assignee will see the tasks appear on their My Tasks page. They can then begin working on the tasks. Click here if you want to know more
about Task Pool. Click here if you want to know more about creating task.

https://www.visual-paradigm.com/solution/task-management-software/
https://www.visual-paradigm.com/
https://www.visual-paradigm.com/support/documents/vpuserguide/2607/2825/84426_writinggener.html
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Task Pool created

Linking a user story to an existing Task Pool
If there is a Task Pool and you want it to be connected with a user story, you can link the user story to the Task Pool. Note that a Task Pool can be
linked by multiple user stories. When a Task Pool is linked by multiple user stories, this means that the tasks created in the Task Pool are to support/
fulfill multiple user stories.

To link a user story to an existing Task Pool:

1. In UeXceler, double click to open the user story where you want to manage its development activities.

2. Open the Tasks tab.

3. Click on the button Link toxisting Task Pool.

To link to existing Task Pool

4. In the popup window, click on the drop down menu of Task Pool and select the Task Pool to link to.

Select a Task Pool to link to

5. Click Link to.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Attaching diagram when adding comment
Comment is a message that can be posted to a task in response to the task submitter's initial message, or as a reply to comment(s) posted by other
members. When Tasifier is run inside Visual Paradigm, you can attach diagrams when you post a comment. Typically, you post with a diagram when
you are asked to provide the diagram, or when the diagram helps explain your comment.

Attaching diagram when adding comment
To post comment with a diagram:

1. Open the details of the task in Task Pane. If the task is inside a Task Pool, open the Task Pool from the Left Pane and select the task from the
tasks list. If the task is one of a task assigned to you, find it in the My Tasks page. You can also find from tag, based on their due status, etc.

2. Click on the comment area at the bottom of the Task Pane.

To post comment

3. Type your comment. If necessary, add supplementary file attachment to your comment by clicking Attach file next to the Post button, and
selecting the file to attach. You may attach multiple files to your comment.

Post a comment

4. Click Attach diagram.

Attach a diagram to comment

5. In the Attach Diagram window, select the diagram to attach to the comment and click OK. You can attach multiple diagrams by repeating this
and the previous step.
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Select a Teamwork File

If you want people to focus on a specific part of a diagram, after selecting a diagram, click Crop below the diagram preview. Then, select the
region to focus on and then click OK to return.

6. Click Post or Complete to send out your comment. Followers and assignees of the task will receive a message in their inboxes.

Complete a task

Now, readers who opened the task in Visual Paradigm can click on the image attached to your comment to open it directly, provided the
diagram exists in their project. If they click on the filename (e.g. ABC.png), they can save the diagram as image file.

Open a diagram in comment

Related Resources
The following resources may help you learn more about the topic discussed in this page.

• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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Attaching Teamwork Files when adding comment
In Visual Paradigm, you can share project-related artifacts with teammates in the form of Teamwork Files. Teamwork Files are files that are stored
along with Visual Paradigm projects. You can make your design reference to these files. You can also keep revisions for these files, and share them
within your team. When Tasifier is run inside Visual Paradigm, you can attach Teamwork File(s) when you post a comment. Typically, you post with a
Teamwork File when you are asked to provide that file, or when that file helps explains your comment.

Attaching Teamwork Files when adding comment
To post comment with a Teamwork File:

1. Open the details of the task in Task Pane. If the task is inside a Task Pool, open the Task Pool from the Left Pane and select the task from the
tasks list. If the task is one of a task assigned to you, find it in the My Tasks page. You can also find from tag, based on their due status, etc.

2. Click on the comment area at the bottom of the Task Pane.

To post comment

3. Type your comment.

Type a comment

4. Click Attach teamwork file.

Attach a Teamwork File

5. In the Attach Teamwork File window, select the Teamwork File to attach to the comment and click OK. You can attach multiple files by
repeating this and the previous step.
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Select a Teamwork File

6. Click Post or Complete to send out your comment. Followers and assignees of the task will receive a message in their inboxes.

Post a comment

Now, readers who opened the task in Visual Paradigm can click on the file link in your comment to download the latest revision of that
Teamwork File, provided that the file exists in their project.

Download a Teamwork File

Related Resources
The following resources may help you learn more about the topic discussed in this page.
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• Visual Paradigm on YouTube

• Contact us if you need any help or have any suggestion

http://www.youtube.com/VisualParadigm
https://www.visual-paradigm.com/support/?product=vpository
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